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ABSTRACT 

This document is the result of a two weeks tailor made advanced training course project, conducted in the 
framework of the DevCoCast at the Faculty ITC of the University of Twente, in Enschede, The Netherlands in 
February 2011.  
Over 30 participants from various African, Latin American and European Universities, (Space) Research and 
Training Centres and European – African International Collaboration Projects have participated in this course. Most 
participants have been attending previous workshops and other short training courses which have been conducted in 
the framework of the DevCoCast project in Africa, some in conjunction with AMESD, and Latin America. After 
having acquired a sound subject working knowledge by the participants, the main objective of this advanced course 
was to develop applications, demonstrating the use of the data disseminated via GEONETCast, a dissemination 
system using telecommunication satellites (broadcast), and more specifically those from the DevCoCast channel, 
within this system. 

After an introductory chapter, describing the GEONETCast system and the role of the DevCoCast project, various 
chapters highlight applications developed by the participants during the course, using where possible in situ 
observations and linking these to the processing and analysis of various remote sensing images and derived products. 
Application fields covered range from vegetation, biomass and different types of agricultural assessments, natural 
habitat conservation, insect and pest monitoring, rainfall and evapotranspiration estimation, hot spot and fire 
detection, drought monitoring and even some marine applications are included. Study areas selected are from South 
America, Eastern and Southern Africa. 
The overall objective of this manual is not only to demonstrate the advantage of using freely available data, 
disseminated via the low cost and highly reliable GEONETCast system, but also to make available a set of exercises 
that can be used within the curricula of Institutes for Higher Education within various disciplines or by interested 
individuals.  
The chapters describe the various (pre-) processing and analysis steps in a structured manner following a clearly 
described methodology for different application domains and their order has been randomly prepared. Powerpoint 
presentations are available to further underpin the described methodology and to illustrate the exercise outcome. To 
conduct the exercises, ILWIS372 needs to be installed as well as the so-called “GEONETCast toolbox” plug-in. 

Both utilities can be freely obtained and downloaded from http://52north.org, together with a user manual for 
installation and first time use.  
All related materials – the full manual, supporting powerpoint presentations, but also the sample data sets for all 
exercises, ensuring minimum compressed file size have been prepared and can be downloaded from 
ftp://ftp.itc.nl/pub/52n/gnc_devcocast_applications/. 
It is hoped that this document and the exercises it contains helps to further integrate the data delivered via 
GEONETCast and DevCoCast into the user community day-to-day practice. If you are interested in submitting a 
new exercise on your own application domain, feel free to contact the editors of this application manual. 
 
 
 
 
 
Ben Maathuis and Chris Mannaerts 
Department of Water Resources 
Faculty ITC – University of Twente 
Enschede, The Netherlands 
January 2012 
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1.  INTRODUCTION TO GEONETCAST AND THE 
DEVCOCAST PROJECT 

By: Cesar de Mello1, Matthew Medland and Mike Grant2, Tim Jacobs3 

1.1. GEO and GEONETCast 

The Group on Earth Observations (GEO), an intergovernmental organization, was established in May 2005. It calls 
for coordination of the Earth Observation systems of various countries, promotes the concept of establishing a 
Global Earth Observation System of Systems (GEOSS) that will yield a broad range of societal benefits, such as: 
  

 reducing loss of life and property from natural and human-induced disasters;  
 understanding environmental factors affecting human health and well-being;  
 improving the management of energy resources;  
 understanding, assessing, predicting, mitigating, and adapting to climate variability and change;  
 improving water resource management through better understanding of the water cycle;  
 improving weather information, forecasting and warning;  
 improving the management and protection of terrestrial, coastal and marine ecosystems;  
 supporting sustainable agriculture and combating desertification;  
 and understanding, monitoring and conserving biodiversity.  

 
As of 2011, GEO’s Members include 86 Governments and the European Commission. In addition, 61 
intergovernmental, international, and regional organizations with a mandate in Earth Observation or related issues 
have been recognized as Participating Organizations. Now, GEO has become the largest international organization 
in the field of Earth Observation. For further information on GEO consult: http://www.earthobservations.org. 

Figure 1.1 Opening ceremony of GEO at UN Headquarters in Washington DC 

                                                      
1 CPTEC-INPE, cesar.mello@cptec.inpe.br (Corresponding Author) 

2 Plymouth Marine Laboratory (PML)  
3 Flemish Institute for Technological Research NV (VITO) 
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One of the important GEO tasks is to promote sharing of Earth Observation (EO) data and remarkable 
developments have been achieved in this regard. One of these achievements is the development of GEONETCast, a 
global network of data dissemination systems based on satellite broadcast that shares environmental data and derived 

information products to a world-wide user community in near real-time. This unique GEONETCast network, part 
of the core GEOSS infrastructure, currently provides reliable, worldwide and low cost access to over 100 different 
Earth Observation (EO) images and products, from 35 providers around the world. The network consists of three 
regional broadcasts, and a fourth component, the Russian Mitra, is being added: 

 EUMETCast: operated by the European Organization for the Exploitation of Meteorological Satellites 
(EUMETSAT), covering Europe, Africa, parts of Asia and the Americas; 

 CMACast:  operated by the China Meteorological Administration (CMA), covering Asia and parts of the 
Pacific (a considerable upgrade of the formerly called FengYunCast); 

 GEONETCast-Americas: operated by the US National Oceanic and Atmospheric Administration 
(NOAA), covering North, Central, and South America and the Caribbean.  

The three main operators, NOAA, EUMETSAT and CMA, are referred to as GEONETCast Networking Centres 
(GNC). The coverage of GEONETCast is illustrated in Figure 1.2. The main providers of satellite data and derived 
products on GEONETCast are listed in the table 1.1. 
 

Figure 1.2 GEONETCast Coverage 
 

EUMETSAT and its network of Satellite 
Application Facilities (SAFs) 

Meteosat (every 15 minutes), Jason and MetOp (per local satellite pass) satellite data 
Meteorological products for atmospheric, land and marine applications 

NOAA 
GOES and POES satellite data and NOAA-NESDIS products for atmospheric and marine 
applications 

CMA FengYun satellite data (FY 1/2/3) 

VITO Various products derived from SPOT-Vegetation for land applications. 

ECMWF/ U.K. Met Office, Deutscher 
Wetterdienst, Météo-France 

Observational and forecast products for atmospheric, marine and land applications 

Table 1.1 GEONETCast – main providers of satellite data and derived products 
 

An up to date listing of available products and data can be obtained by accessing the “Product Navigator” 
maintained by EUMETSAT, and is available directly from their home page (http://www.eumetsat.int). 
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1.2. The DevCoCast Project 

1.2.1. Introduction 

Many developing countries and emerging economies (China, Brazil) face serious environmental risks and need 
reliable access to accurate EO data and derived environmental information for their sustainable development. The 
GEONETCast for and by Developing Countries Project (DevCoCast), funded by the European Community’s 
7th Framework Programme for Research and Technological Development (FP7), involves developing countries 
more closely in the GEONETCast initiative. DevCoCast uses GEONETCast to disseminate existing environmental 

added-value data (both in-situ and satellite-based) from various sources in Africa, South and Central America, Asia 
and Europe to a broad range of end-users in developing countries. To help organize (prioritize, schedule) the flow of 
products, DevCoCast establishes central hubs for marine and land data that seamlessly integrate into the 
GEONETCast network. At the same time, the network of satellite receivers is expanded in South America, as well as 
for marine research and desert locust control services in Africa and for a pilot GEONETCast data-exchange with 
China supporting marine information services. 

Figure 1.3 DevCoCast overview map 
 
More importantly, the actual use of the products by the growing user community is supported through training, 
building on and maintaining the existing networks and capacities. This is done across continents and for various 
application themes such as vegetation and agriculture, fires, floods, water resources, marine, weather and climate. 
The goal is to introduce and integrate GEONETCast and the EO products it offers into educational curricula, 
research, environmental monitoring and decision making processes, in support of sustainable development. 

1.2.2. Advantages of using the GEONETCast broadcasting system 

Though the majority of receivers are currently found in Europe and China, the broadcasting system is particularly 
useful in Developing Countries, where it can help to avoid the high cost of maintaining a reliable internet 
connections that are sufficient in capacity to carry large volume of Earth Observation products (e.g. outside of major 
cities). Other advantages are:  

 The availability of low cost, off-the-shelf receiver equipment; 
 The high reliability and data transfer rate;  
 The wide variety of freely available images and products; 
 The long-term commitment to maintain the infrastructure, in particular by EUMETSAT towards Africa;  
 The constantly growing receiver network, the growing number of products and (Third Party) data 

providers. 
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With GEONETCast the users do not need to repeatedly build ground receiving stations for different satellites. The 
convenient one-stop solution allows the data from different providers to be broadcast through telecommunication 

satellites. Access to the data needs a reception terminal similar to a satellite TV or satellite internet receiver. 

1.2.3. DevCoCast Partnership and the open network established 

The DevCoCast project is coordinated by the Flemish Institute for Technological Research NV (VITO), Belgium. In 
addition to VITO, 14 other organizations from Africa (4), South America (4) and Europe (6) team up to make 
DevCoCast a success. To lead the project, VITO heads a Steering Group of nine partners, three from each involved 
continent. The collaborating organizations within DevCoCast are: 

 Flemish Institute for Technological Research NV (VITO), Belgium 
 African Centre of Meteorological Application for Development (ACMAD), Niger 
 Regional Centre for Training and Operational Applications in Agro-meteorology and Hydrology 

(AGRHYMET), Niger 
 Food Supply Agency of the Ministry of Agriculture (CONAB), Brazil 
 Centre for Surveying and Assessment of Agriculture and Natural Resources (CREAN), Argentina 
 Council for Scientific and Industrial Research – Meraka Institute (CSIR), South Africa 
 Danish Meteorological Institute (DMI), Denmark 
 European Organisation for the Exploitation of Meteorological Satellites (EUMETSAT), Germany 
 National Institute for Space Research (INPE), Brazil 
 National Institute of Agriculture Technology (INTA), Argentina 
 University of Twente - Faculty of Geo-Information Science and Earth Observation (ITC), The Netherlands 
 European Commission - DG Joint Research Centre - Institute for Environment and Sustainability (JRC), 

Italy 
 Natural Environment Research Council - National Oceanography Centre Southampton (NOCS), United 

Kingdom 

 Marine Research Institute - University of Cape Town (MRSU, UCT), South Africa 
 Plymouth Marine Laboratory (PML), United Kingdom 

 
Besides these full partners, 10 more organizations received a DevCoCast-funded satellite receiver, installed by (or 
with help from) the partners, and are in turn asked to show the impact of GEONETCast on their day-to-day work. 
These Associated Organizations include: 

 Brazilian Agricultural Research Corporation (EMBRAPA), Centre for Satellite Monitoring (CNPM), Brazil  
 State University of Campinas, Faculty of Agricultural Engineering (FEAGRI), Brazil  
 Four marine research institutes  

o University Cheikh Anta Diop, Laboratory for Training and Research in Geo-matics (LERG), 
Senegal  

o University of Dar es Salaam, Institute of Marine Sciences (IMS), Tanzania  
o Ministry of Fisheries and Marine Resources, National Marine Information and Research Centre 

(NatMIRC), Namibia  
o University of Ghana (UG) 

 National locust control centres and offices of Mali (CNLCP), Sudan and Eritrea  
 Jiangyin Marine Technology Co. Ltd. (JYMT), China  

 
Even with this large partnership, the real network of organizations involved with or related to DevCoCast is much 
larger. It connects for instance to and helps to strengthen the EUMETCast network in Brazil (around 50 
organizations), the AMESD network in Africa (all sub-Sahara National Meteorological Services and various other 
national environmental and agriculture ministeries), the South Africa Fire Network (SAFNET) of fire fighters and 
managers, international organizations such as UN-FAO and many more existing networks of GEONETCast satellite 
receivers and users (e.g. FP7-Geoland2/FP6-VGT4Africa, ChloroGIN, FP6-YEOS), and training networks 
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(EUMETSAT, ITC). This means the user community now encompasses hundreds of EO experts. As an example, 
the network of users of the provided SPOT-VEGETATION data has grown from around 100 by the end of 2007 in 
Africa only (VGT4Africa final report, 2008) to over 300 now (in Africa and South America). 

To make this possible, DevCoCast, from the start, built on existing networks and remains very open to support any 
organization willing to use GEONETCast, either as a provider of products or as a receiver/user. 

1.2.4. Methodology and project outcome 

The DevCoCast project has four core activities: 
1. Sharing many EO products (some produced in Africa and South America) across the continents and even 

worldwide, using EUMETCast and a pilot GEONETCast data-exchange. This includes a review and 
harmonization of the products, aiming to simplify their use. For a product listing see also Appendix 1. 

2. Extending the existing infrastructure with central land and ocean add-on nodes to the GEONETCast 
Networking Centre operated by EUMETSAT, set up to prioritize and schedule incoming EO products 
prior to sending them to EUMETSAT for broadcast. In addition, several satellite receiving stations are 
newly established or upgraded in Africa (7), South America (6) and China (1).  

3. Capacity building by supporting and training users through various (international) workshops, help desks, 
stand-alone training packages, building on existing training networks. 

4. Finally, building on and maintaining existing capacities and networks to integrate GEONETCast and the 
products it offers into everyday education, research, environmental monitoring and decision making 
applications. 

 
With products being broadcasted from almost each of the ten product providers in DevCoCast (see Appendix 1), the 
land and marine hubs fully operational and nearly all receiving stations installed and functioning, the first two core 
activities are very near to completion. Several successful workshops, with more than 300 participants, have been 
organized using Open Source and freely available software to manage and process the data disseminated by 
GEONETCast. Training material is partially available and more is under development. This material, including this 

document, will be made freely available in various languages. The project has now reached the last and most 
important stage: to demonstrate the benefit and actual use of GEONETCast to the user community, across 
continents and for various application themes, hopefully ensuring more sustained use of GEONETCast in Africa, 
South America and South East Asia. 
The start-up of the follow-on Europe-Africa Marine Network (EAMNET, FP7) ensures continuity, further capacity 
building and shows the successful uptake of GEONETCast for marine applications in Africa. The new (also FP7-
funded) AGRICAB project, to start back-to-back with DevCoCast, further ensures continuation of use of 
GEONETCast data for land (agriculture, forestry) applications in Africa in the near future. 

1.3. EUMETCast 

1.3.1. Introduction 

For the broadcast of the wide variety of DevCoCast products, from ten different sources to hundreds of 
receivers/users in particular in Africa, South America and China, the project builds on and extends the EUMETCast 
broadcast, operated by EUMETSAT and as such is one of the main components of GEONETCast. This includes: 

 hiring dedicated broadcast bandwidth (the so-called DEVCOCAST-1 channel);  
 updating the configuration of EUMETSAT’s EUMETCast dissemination systems;  
 adding data to the EUMETCast-CMACast data exchange for (demonstration) broadcast over China; 
 and supporting the installation of new GEONETCast stations by providing advice and remote support to 

users when necessary. 
 
EUMETCast system is a multicast system that uses standard Digital Video Broadcast (DVB) technology to transport 
data packets (IP datagrams) over a set of geostationary telecommunication satellites that are also used for satellite 
internet and satellite TV. This is done in a client/server system with the server side implemented at the EUMETCast 
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uplink site and the client side installed on the many individual EUMETCast reception stations. The components 
involved include: 

 Data providers  

 Service management 
 Uplink service provider 
 Turn around service provider 
 Satellites 
 Reception stations 

Figure 1.4 EUMETCast Architecture 
 
On the transmission side, EUMETSAT’s own and externally provided products are transferred as files via a 
dedicated communications line from EUMETSAT to the uplink facility. The facility then encodes and transmits 
them to the communications satellite for broadcast (using a set of forward channels, not (yet) the return channels) to 
targeted user receiving stations. Each receiver decodes the signal and recreates the data/products. A single reception 

station thus can receive any combination of the data services provided on EUMETCast, in accordance with the 
relevant data policy and after registration to get the (usually free-of-charge) license to access the data/products. 

1.3.2. Technical features of EUMETCast 

In addition to the generic advantages of GEONETCast (see section 1.3), EUMETCast has the following features: 
 Secure delivery allows multicasts to be targeted to a specific user or group of users thus supporting any 

required data policy; 
 Handling of any file format, allowing the dissemination of a broad range of products;  
 Use of DVB turnarounds allows easy extension of geographical coverage;  
 Users are able to receive many data streams via one reception station using off-the-shelf (DVB) equipment 
 An installed User base of over 1700 User stations;  
 Highly scalable system architecture. 

1.3.2.1. Uplink, Turnaround and Data Providers 

The Uplink service provider performs the following tasks:  
 Receives all the data to be disseminated from all the data providers;  
 Co-ordinates all the transmissions according to the service configuration;  
 Encrypts the data according to the user dissemination configuration;  
 Applies Forward Error Correction (FEC) to multicast data (FEC techniques transmit additional redundant 

information to enable the receivers to correct a certain amount of lost data, without requiring 
retransmission);  

 Converts the files into Digital Video Broadcast (DVB);  
 Broadcasts the signal using a commercial satellite;  
 Receives the multicast data into a local reference reception station for service monitoring.  
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For EUMETCast, the multicast system provided by T-Systems GmbH, is based on a client/server system developed 
by Tellitec with the server side implemented at the EUMETCast uplink site in Usingen (Germany). The client side is 
installed on all the EUMETCast reception stations. There are a number of data providers, including EUMETSAT 

themselves, who deliver files to the uplink site via FTP over various communication lines.  
The turnaround service provider receives the DVB signal from one satellite and retransmits it, without unpacking the 
DVB packets, to another satellite. Telespazio S.p.a. provides the C-band turnaround service for EUMETCast Africa 
from its uplink site in Fucino (Italy) and Globecast provides the C-band turnaround service for EUMETCast-
Americas from its uplink facility in Paris (France).  

1.3.2.2. Multicast to specific user(s) via Data File Encryption/Decryption 

The EUMETCast system allows files to be independently targeted towards a single user, or group of users, thus 
enabling secure control of access to the data at individual file and individual user level. The encryption of the data is 
performed by the EUMETCast uplink and decryption by the EUMETCast Client Software installed on the reception 
station. Most of the provided data or products are encrypted with user key (password) of the target user(s), making 
them only available after the user has registered to receive them and has been granted access (license, usually free-of-
charge) in accordance with the Data Policy in play (e.g. EUMETSAT Data Policy for the EUMETSAT data and 
products). This requirement to register also gives the providers a clear view of the number of EUMETCast receiving 
stations registered for their products, thus promoting the sustained delivery. Registration can be done online using 
EUMETSATs “Earth Observation” Portal (available at: http://www.eumetsat.int/Home/Main/DataAccess/ 
EOPortal/index.htm?l=en. 
To enable the corresponding decryption by the EUMETCast Client Software on the receiver side, the user’s station 
will need to be equipped with a EUMETCast Key Unit (EKU). The EKU is connected simply via USB and 
EUMETSAT manages the distribution of the EKU devices to registered users. 

1.3.2.3. Service Management and Service Directories 

The service configuration management is done by EUMETSAT, who provides the service configuration (bandwidth, 
users, dissemination parameters, etc.) to the DVB uplink provider. Management of the satellite transponder 
bandwidth capacity available to EUMETCast is achieved with channels and by the use of a priority scheme.  
The DVB multicast management software adapts the uplink stream according to the relative priorities of the data 
waiting to be transmitted on a particular channel.  
The EUMETCast interface is based on a concept called 'Service Directories', entry points into which the data to be 
multicast are transferred. To organize the flow, each service directory is associated with a distribution list, which 
identifies all the EUMETCast users entitled to receive the data transferred to the directory. The service directory 

structure is also used to allocate bandwidth characteristics to a particular set of products or directories. 

1.3.2.4. Telecommunication Satellites  

The satellites used by the uplink providers to relay the EUMETCast multicast form part of the Eutelsat and New 
Skies satellite fleet:  

 EUROBIRD™ 9 (located at 9º East) delivers 20 fully operational Ku-band transponders supplying 
coverage across Europe, North Africa and the Middle East. Under the current arrangements provided by 
the uplink provider, EUMETCast is available via one of the Ku-band transponders;  

 ATLANTIC BIRD™ 3 (located at 5º West) carries a Ku/C-band payload of 45 transponders (35 Ku-band, 
10 C-band) with European, African and western Asia coverage. Under the current arrangements provided 
by the Africa turnaround provider, EUMETCast is available via one of the C-band transponders;  

 NSS-806 (located at 40.5º West) is providing an optimum view of South America while also reaching the 
Iberian peninsula, the Canary Islands, Western Europe and much of Eastern Europe. Its tailored, high-

powered hemispheric beam provides simultaneous coverage of both Europe and the Americas, with 
virtually complete coverage of North, Central and South America. EUMETCast is available via one of the 
C-band transponders.  
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The agreements with the satellite and turnaround providers are renewed through a fixed procurement procedure, 
which may cause changes to the satellite being used. But this is not frequent, as the agreements span multiple years 
typically. 

1.3.2.5. High reliability through Network supervision 

Reference reception stations are used to monitor the status of the system. There are reference reception stations at 
each data provider, the uplink service provider and on every turnaround service provider. Each data provider is 
responsible for the end-to-end monitoring of its own data. EUMETSAT monitors the end-to-end service relative to 
the data provided by EUMETSAT. 

1.3.3. EUMETCast user station 

A single reception station can potentially receive all the data being transmitted from one communication satellite 
(one broadcast beam), independent of the data provider(s). 

1.3.3.1. Reception Station components 

Based on EUMETSAT’s substantial tests and user experiences, a typical EUMETCast reception station comprises: 
 a standard PC with either DVB card inserted or a DVB router connected (e.g. via USB) 
 a satellite prime focus or off-set antenna fitted with 

o a digital universal V/H LNB for Ku-band (EUMETCast-Europe),  
o a circular polarization feed horn, band pass filter (in areas with radar interference) and special 

LNB for C-band (EUMETCast-Africa or –Americas). 
 EUMETCast Client Software and in most instances the EUMETCast Key Unit (EKU) are also required to 

decode and decrypt the DVB signal. 
 
It is recommended to set up two PCs – one for DVB reception (and FTP/file serving to the network) and the other 
for processing. As peaks in hard disk and bus usage could interrupt DVB data reception, it is recommended that no 
processing or visualization of the data, not even unpacking of compressed files, is performed on the dedicated 
reception PC. The second PC can accommodate those. 
 
Minimum PC requirements are listed as: 2.0 GHz Pentium™ IV; 1Gb RAM, 36Gb internal disk (or more, depending 
on storage required); USB port for EKU; 5 volt PCI bus (compatible with recommended DVB PCI card); 100/10 

base Ethernet card (if required). Microsoft Internet Explorer (web browser) version 5.5, or later version, or Mozilla, 
or similar, Web browser, including JAVA RTE, (required for display of the TELLICAST monitoring information).  
Furthermore EUMETSAT provides a step-by-step guide provided in the EUMETCast Technical Description (EUM 
TD 15, 2004 and 2010). Also consult this document for an up-to-date list of tested PC and DVB card configurations. 
 
The cost of EUMETCast reception stations is kept to a minimum by utilizing industry open standards to the 
maximum extent possible, thus allowing the use of off-the-shelf equipment, available from satellite TV and/or 
satellite internet providers. In addition to the above front-end equipment, EUMETCast Client Software and EKU, 
data processing/visualization software is often required depending on the actual application and user’s needs, making 
it a flexible solution. Unless the user already has suitable processing software, DevCoCast recommends the use of 
freely available software such as ILWIS and the GEONETCast Toolbox (see section 1.5). 

1.3.3.2. EUMETCast Key Unit and Client Software 

EUMETSAT provides the EUMETCast Client Software (TELLICAST) and the EUMETCast Key Unit (EKU) 
required to decrypt the DVB signal, in the case of the Client Software, and to facilitate access to the licensed or 
restricted services in the case of the EKU. They are provided together as a USB dongle and a CDROM, which 
together form the EUMETCast Package. This EUMETCast Package is available to all registered users and includes: 
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 The latest version of the EUMETCast Client Software (TELLICAST);  
 EKU Run-Time-Environment, available for both MS Windows and Linux systems;  
 A selection of DVB card driver software;  

 Documentation, trouble shooting notes, readme files, Tellicast license notes, etc. 
 
The EUMETCast Client Software is available for both MS Windows and Linux systems and performs the following 
processes:  

 Decryption of data based on a key code;  
 Error correction and management of received files.  

 
As the current EUMETCast operates a TELLICAST server, the TELLICAST client software is mandatory. Per 
computer on which the software is installed, a license fee is charged. A single license fee is included in the price of 
the software CDROM (currently 60 EUR). The software installation procedure can be performed and when 
prompted the username and password have to be entered which are provided by EUMETSAT. 

Figure 1.5 Tellicast client software window 
The EUMETCast Key Unit (EKU) is the USB device used in conjunction with the EUMETCast Client Software to 
provide reception of services that require separate registration, licensing and/or have restricted access. The current 
cost of a single EKU is 40 EUR. EUMETSAT is the sole supplier of the EKU’s and included in the delivery package 
is the EKU Run-Time-Environment software, for both MS Windows and Linux systems. 

Figure 1.6 The EUMETSAT Key Unit 

1.3.3.3. Antenna size, pointing and satellite parameters 

Antenna size depends on the location where the ground receiving station is installed and the frequency band (Ku, C) 
used. Further information is provided in table 1.2, followed by the satellite footprints and reception parameters. For 
pointing the antenna use can be made of the dish pointing utility available at: http://www.dishpointer.com/. 
Websites like http://www.satsig.net/africa/vsat-installers-africa.htm and EUMETSAT manufacturer list can help 
locate local installers. 
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Table 1.2 Antenna dimensions for various regions 
 
 
 

 
 
 
 
 
 

 
 

Figure 1.7 Eurobird 9 coverage and satellite transponder settings 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 

Figure 1.8 Atlantic Bird 3 coverage and satellite transponder setting 

Band Location Antenna Size 

Europe (Ku-band) within the "core" geographical footprint of the spacecraft, 
the area bounded by the 50 dBW contour depicted in the 
EUROBIRD™ 9.  Footprint, see figure 1.7 

120cm or smaller (non-
professional users 85 cm) 

Europe (Ku-band) within the "extended" geographical coverage (remote 
European islands, Turkey East of Ankara and Eastern 
European countries) 

1.8m or larger 

Africa (C-band) within the "core" geographical footprint , the area bounded 
by the inner contour depicted in the Atlantic™ Bird 3 
Footprint, see figure 1.8 

2.4m or larger 

Africa (C-band) within the "extended" geographical coverage (e.g. 
Madagascar, La Reunion, Mauritius and parts of North 
America) 

3.7m or larger 

South America       
(C-band) 

within the area bounded by the 39 dBW contour depicted 
in the NSS806 graphic Footprint, see figure 1.9 

2.4m or larger 

South America       
(C-band) 

smaller antennas may be sufficient, depending upon 
individual location, for details for your location, contact the 
EUMETSAT User Service (ops@eumetsat.int) 

1.8m or larger 

Ku-band Transponder EUROBIRD™ 9 

Parameter Value 

Name EUROBIRD™ 9

Transponder TP63 

Down Link Frequency 11976.82 MHz 

Symbol Rate 27500 kS/s 

FEC 3/4 

Polarization Horizontal 

C-band Transponder Atlantic Bird™ 

Parameter Value 

Name Atlantic Bird™ 3 

Transponder C02 

Down Link Frequency 3731.7570 MHz 

Symbol Rate 11.963 MS/s 

FEC 2/3 

Polarization Circular Left 
Hand 
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Figure 1.9 NSS-806 South America coverage and satellite transponder settings 
 

The plots assume that antennas are correctly pointed, the LNB and reception equipment is state of the art and the 
cables are not too long or low loss ones are used. Smaller antennas (e.g. used for TV reception) will still provide good 
reception at fair weather conditions, but will increasingly suffer under rain and snow. For widely used 60 cm 
antennas, subtract 2.5 dB from the link margin for 80 cm antennas, and check if it still provides a positive margin. 

1.3.4. EUMETCast configuration for DevCoCast flow 

Normally, the files from data providers like those in DevCoCast are transferred via FTP/INTERNET to the 
EUMETSAT Operations Internet Server (OIS), an FTP server located at EUMETSAT in Darmstadt. EUMETSAT 
then further processes and/or transfers the uploaded products either to the uplink site in Usingen (Germany), where 
they are converted into a DVB (Digital Video Broadcast) Multicast data stream and transmitted via EUMETCast, or 
via RMDCN/internet networks for data-exchanges with other GEONETCast components (e.g. to CMA for the 
China broadcast). 
 
In the context of DevCoCast, only the products from DMI (Denmark) are sent to CMA in China for a pilot 
broadcast. All other products are added to EUMETCast, on a channel that is available in the entire EUMETCast 
footprint (EUMETCast-Europe, EUMETCast-Africa and EUMETCast-Americas). 

 
The products from INPE (Brazil) are thus disseminated via EUMETCast, as part of the DevCoCast service, by first 
pushing them via FTP from INPE to EUMETSAT, who in turn pushes them to the DVB uplink server for 
EUMETCast dissemination on Ku-band, C-band Americas (main users for these data) and C-band Africa. 
 
For the remaining eight Product Providers in Africa, South America and Europe, including VITO and PML 
themselves, the operation interfaces are between EUMETSAT on one side and the land hub at Flemish Institute of 
Technological Research NV (VITO) and marine hub at Plymouth Marine Laboratory (PML) on the other. These 
hubs are explained in the next section. 
 
 

South America - C-band  NSS806  

Parameter Value 

Name NSS806 

Transponder 22A 

Down Link Frequency 3.803 GHz 

Symbol Rate 27.500 MS/s 

FEC 3/4 

Polarization Circular Left 
Hand 
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Figure 1.10 DevCoCast data provision and dissemination overview 

1.4. Extending the broadcast infrastructure: the DevCoCast hubs 

The land and marine hub systems are intermediary data gathering nodes, servers running bespoke software for the 
controlled dissemination of satellite imagery and derived information. Though designed and developed within 
DevCoCast, they integrate nicely with the rest of the GEONETCast (in particular EUMETCast) infrastructure, 
acting as (optional) add-ons to EUMETSAT as the main GEONETCast Networking Centre. Hence, they can easily 
be re-used and extended for handling the flow of additional products. 
 
The DevCoCast hub systems help to gather the flow of diverse "land" and "ocean" thematic products from various 
providers, including some originating in Africa and South America. They then pass these products on to 
EUMETSAT for the EUMETCast broadcast, scheduling them according to priorities and available bandwidth. The 
hubs’ main purposes are thus: 

 To channel the products via the Land and Marine hubs (running at VITO and PML respectively), 
simplifying the steps in the transport of products from the providers to the broadcast systems at 

EUMETSAT; 
 To extend GEONETCast with additional providers and products, covering additional application themes 

(notably beyond meteorology) and relevant with respect to the GEO Societal Benefit Areas. 
 
From a data provider's point of view, they have a single point of contact in the relevant hub that has domain-specific 
knowledge of the products, that has extensive experience in interacting with EUMETSAT’s GNC operations and 
can assist with product format adjustments, product flow monitoring and queries. 
From EUMETSAT's perspective, they have a single "DevCoCast" interface with each of the hubs, who have specific 
knowledge of the products, expected frequency and of EUMETSAT's procedures, rather than many interfaces with 
many providers.  
From the hub's own point of view, they can assure appropriate flow control for DevCoCast through a simple but 
robust system, with routine monitoring, prioritisation, flow smoothing/ordering and with fail-over redundancy. In 
fact, the hubs are designed to be able to take over from one another, e.g. in case of downtime. Though this take over 
does not occur often, the hubs do share the same configuration and logging and can thus be seen (from 
EUMETSAT and product provider perspectives) as mirror copies, with VITO hub dealing nominally with land, and 

rarely with ocean and vice-versa for PML hub. 
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Figure 1.11 Overview of DevCoCast data providers, hubs and EUMETCAST transmission 

1.4.1. Features of the hubs 

The core purpose of the DevCoCast hub is to collect data from multiple providers and send it to EUMETSAT in a 
controlled and effective manner. The main features of the hub are as follows:  
 

 Bandwidth control: in total, per provider and per product priority  

 Prioritisation 
 High resilience 

o Redundancy (hubs back up one another) 
o Retransmission prevention 

 Extensive monitoring 
o Detailed transmission logging  
o Integration with Nagios (an open source computer and network monitoring solution)  
o Transmission graphing via external scripts  

 
 Flexible and extensible system 

o Per product destination selection, allowing products to be dispatched to alternative systems during 
testing/trial phases 

o Possibility of multiple hubs on a single server 
o Generic processing trigger, allowing customised processing on individual products (e.g. additional 

compression or filename standardisation) 

1.4.1.1. Bandwidth control 

A key role of the hub is to limit the amount of data transmitted in a given time. This is vital; the DevCoCast project 
have a certain amount of bandwidth through EUMETCast and cannot exceed it. It is also important to ensure that 
the EUMETSAT servers are not flooded with large bursts of data - another role of the hubs is to spread the 
transmissions out over time.  
The first goal is achieved by setting, managing and keeping to constraints (potentially per provider, per product type 
and per priority level). The second goal, smoothing, is achieved by spreading available bandwidth linearly throughout 
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set periods (typically 3 hour or 1 day) and accumulating it in a pool such that a product is only transmitted when 
sufficient unused bandwidth has accumulated.  
The hubs also perform some tests on filenames and data contents (checksum) to ensure that data files are not 
transmitted multiple times due to errors in the systems of a data provider or hub. 

1.4.1.2. Prioritisation 

Not all of the data travelling through the hub are equally urgent. Products with high timeliness (for example event-
driven imagery, such as imagery covering a fire) needs to be broadcast more urgently than monthly or weekly 
summary products. Another role of the hub is to ensure that the highest priority data are sent first.  
There are 5 different priority levels:  

 Very Low (e.g. less than monthly data) 
 Low (e.g. monthly summaries) 
 Medium (e.g. weekly products) 
 High (e.g. near-real time ocean products / daily land products) 
 Very High (e.g. event driven, like near-real time fire products) 

These priority levels are assigned depending on the project objectives and the characteristics of the data.  

1.4.1.3. Seamless integration 

As described above, the hubs integrate into the main GEONETCast system. The hub operators (PML and VITO) 
ensure that the relevant EUMETSAT procedures are followed, assisting EO product providers in meeting 
operational broadcast requirements (metadata, test and trial broadcasts, user announcements, etc) more easily and 
flexibly, and assisting EUMETSAT in dealing with a growing number of product providers, particularly in thematic 
areas they are less familiar with. 

1.4.1.4. Redundancy 

In the event of a problem (scheduled maintenance or unscheduled outage), each hub can operate as a backup for the 
other. So, if the PML Marine hub is affected by a local outage then the ocean data providers can switch (potentially 
automatically) to the VITO Land hub. As both hubs run the same configuration, the outage and changeover can be 
transparent to the data provider, to EUMETSAT and to end users. The hubs routinely share information on 
transmitted products every 15 minutes, so retransmissions are unlikely and limited to a small window of time. 

1.4.1.5. Basic hub operation 

Providers upload EO data and information products via FTP to the relevant hub, using filenames according to a pre-
defined format.  Once a file arrives at a DevCoCast hub, it is recognised by the filename, prioritised, potentially 
reformatted (renaming, compression, etc) and, once sufficient bandwidth is available and all the constraints released, 
transmitted on to EUMETSAT.  
 
The files are prioritised primarily according to the time sensitivity of the data. At a set interval (≈5 mins) the hub tries 
to send all of the files in priority order, starting with the highest priority.  The hub also balances the reservation of 
bandwidth for expected high-priority products against gradually redistributing unused bandwidth from higher to 
lower priority products over the accounting period. 
 
Different amounts of bandwidth can be set aside for each priority, enabling to finely tune how much data for each 
priority will be sent at a given time. The hubs can also set available bandwidth differently per provider to ensure that 

no one provider monopolises the DevCoCast bandwidth.  
 

Some files may require extra processing or standardisation. This can be done simply on the hub, which is capable of 
running arbitrary processing on any file as it arrives. All that is needed on the hub is a copy of the Linux compatible 
script/executable file to run.  
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The operation of the hub is simple, yet robust; a high level description of the routines implemented can be seen in 
the flowchart in figure 1.12. 
 

 
 

Figure 1.12 High level description of the hub's operation 
 
Once it has been determined that the file will fit within the bandwidth allocation, it is transmitted to EUMETSAT 
via FTP. EUMETSAT has multiple service directories, each with a specific use. This is not apparent to the end user, 
as EUMETSAT is grouping data together into channels for onward broadcast. 

1.4.1.6. Hub monitoring 

The hubs provide detailed logging of transmitted products and actions taken. This allows for detailed debugging or 
tracing of a product through the system. These logs are also summarised in graphs showing overall flow rates for 
monitoring of the DevCoCast system (see Figure 1.13 for an example).  
Finally, scripts exist to integrate the hubs with Nagios, an open source monitoring solution, such that alerts can be 
sent to operators when problems (such as the hub losing network connectivity) or potential problems (such as 
unexpectedly low numbers of products for a particular provider) occur. 
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Figure 1.13 Plot of DevCoCast Marine Hub transmissions over several days 

1.5. Free and open source software 

To keep the barriers to using GEONETCast and the shared data as low as possible, the DevCoCast team further 
develops and promotes (e.g. in demonstrations at forums and conferences) the use of free and/or open source 
software for processing and visualizing of the provided data. This includes provider-specific software, such as 
VITO’s “VGTExtract” (available at: http://www.devcocast.eu) for integrating SPOT-VEGETATION data into the 
users’ commonly used GIS or Remote Sensing (RS) software. In addition, a comprehensive set of tools – the 
GEONETCast toolbox - was developed as extension to the open version of “ILWIS” (available at: 
http://www.52north.org/communities/earth-observation). This software can import and manage the wide variety of 
GEONETCast data and at the same time links to a free, generic GIS and RS package (ILWIS, available at: 
http://www.52north.org/communities/ilwis). For this reason, it has also been used (and improved) extensively for 
DevCoCast and related training activities (workshops, training material development).  
Of course, the DevCoCast team remains open and also supports users who prefer the software they are used to, as 
long as it meets their needs. But recent evidence has shown an increasing adoption of free software by key users, 
such as the African National Meteo Services (UFA9 Report, 2010). 

1.5.1. Data Manager Software 

Once a local ground receiving station has been installed and configured the satellite and environmental data that is 
(re-) broadcasted via communication satellites can be received and stored on a storage device. Since the data is 
continuously received through GEONETCast (24h each day, 7 days per week), the “GEONETCast Data Manager" 
data management system has been developed to manage the data streams more automatically. This utility can be 
easily configured using a simple ascii text file. No programming experience is required to update the configuration 
file to cope with the changing data stream. The Data Manager Software can be used as a standalone and can be 
downloaded from: http://52north.org/communities/earth-observation/data-manager-software. 
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1.5.2. ILWIS Open  

ILWIS OPEN 3.7 (or a more recent version) integrates image, vector and thematic data in one unique and powerful 
desktop package. It delivers a wide range of features including import/export, digitizing, editing, analysis and display 
of data, as well as production of quality maps. Key features are: 

 Integrated raster and vector design 
 Import and export of widely used data formats 
 On-screen and tablet digitizing 
 Comprehensive set of image processing tools 
 Orthophoto, image georeferencing, transformation and mosaicing 
 Advanced modeling and spatial data analysis 

 3D visualization with interactive editing for optimal view findings 
 Rich projection and coordinate system library 
 Geo-statisitical analyses, with Kriging for improved interpolation 
 Production and visualization of stereo image pairs 
 Spatial Multiple Criteria Evaluation 
 Web Mapping Services 
 Surface Energy Balances  

ILWIS can be used as a standalone package and can be downloaded from: http://52north.org/communities/ilwis/ 
download. From here also various other training materials are available. Latin American users can also consult 
http://www.ilwis.org/ for additional information.  

1.5.3. GEONETCast Toolbox Software   

The GEONETCast Toolbox is an ILWIS 3.7 Open (or a more recent version) plug-in. It enables easy access to and 

management of GEONETCast data (various satellite and environmental data and/or resulting products) and 
supports their subsequent, efficient geospatial processing with ILWIS 3.7 Open or other Geographic Information 
Systems. The GEONETCast Toolbox ZIP can be used as an ILWIS plug-in and downloaded from: 
http://52north.org/downloads/earth-observation/ GEONETCast/toolbox. An installation, configuration and user 
guide is also available, including exercises based on a variety of sample data disseminated through GEONETCast. 
Further information is also provided on the ITC-GEONETCast pages (http://www.itc.nl/Pub/WRS/WRS-
GEONETCast). 

1.6. Scope of this manual 

With the regular sharing of Earth Observation products in place, project focus has shifted to the use and added value 
of the shared products. In this chapter of the manual, the EUMETCast broadcast, DevCoCast hub and satellite 
reception infrastructure, as well as the used free and open source software are briefly introduced. More information 
on those can be found in separate documents posted on various web sites, the links to these sites are provided in the 

References section.  
The next chapters of this manual describe various applications using data from the GEONETCast data stream, in 
conjunction with collected local information from Africa and Latin America. The application examples presented are 
developed in collaboration with local thematic experts during (among others) a two weeks advanced DevCoCast 
training workshop and demonstrate the potentials of using the information provided for environmental assessment. 
The applications described are based on real world examples and can be used as standalone study and exercise cases 
that demonstrate the added value of GEONETCast for environmental assessment. All exercises are based on ILWIS 
Open, version 3.7.2, which is freely available. Sample data for the exercises can be obtained on DVD and 
downloaded (http://www.itc.nl/Pub/WRS/WRS-GEONETCast/Application-manual.html and http://www. 
devcocast.eu/). Users are encouraged to submit their comments, feedback and/or additional exercises to ITC via the 
Earth Observation Community at 52North.org (http://52north.org/communities/earth-observation/community-
contact). 
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Appendix 1 Products Listing from VITO Land and PML Marine hubs 

 
Land hub products for dissemination through EUMETCast. 

Product 
acronym 

Full product 
name 

Filename OIS In Filename EXGate Out 

For
mat 
Out 

Compre
ssed Size 
and type 

Produc
ts 
Freque
ncy 

Generat
ion 
Time 
(UTC) 

VITO 

NDVI 

Normalised 
Difference 
Vegetation 
Index - South 
America 

V2KRNS10__YYYYMMDD_NDVI__
S-America.ZIP 

V2KRNS10__YYYYMMDD_NDVI__
S-America.ZIP 

Zip 
archi
ve 

~25Mb 

1st, 
11th 
and 
21st of 
each 
month 

~1-5 
days 
later 

NDWI 

Normalised 
Difference 
Water Index 
– South 
America 

g2_BIOPAR_NDWI_YYYYMMDD00
00_S-America_VGT_V0.2.zip 

g2_BIOPAR_NDWI_YYYYMMDD00
00_S-America_VGT_V0.2.zip 

Zip 
archi
ve 

~20 Mb 

1st, 
11th 
and 
21st of 
each 
month 

~1-5 
days 
later 

DMP 

Dry Matter 
Productivity  
- South 
America 

g2_BIOPAR_DMP_YYYYMMDD0000
_S-America_VGT_V0.1.zip 

g2_BIOPAR_DMP_YYYYMMDD0000
_S-America_VGT_V0.1.zip 

Zip 
archi
ve 

~35 Mb 

1st, 
11th 
and 
21st of 
each 
month 

~1-5 
days 
later 

LOC 
Desert 
Locust 
Products 

MCD_GreenArea_YYYYMMDD_[Eritr
ea|Mali|N-Sudan].zip 

MCD_GreenArea_YYYYMMDD_[Eritr
ea|Mali|N-Sudan].zip 

Zip 
archi
ve 

~1-4Mb 

1st, 
11th 
and 
21st of 
each 
month 

~1-5 
days 
later 

CSIR 

FFDI 
McArthur 
Forest Fire 
Danger Index 

CSIR_FFDI_YYYYMMDD1200.txt CSIR_FFDI_YYYYMMDD1200.txt 
ASC
II 

242Kb Daily 12:00 

LFDI 
Lowveld Fire 
Danger Index 

CSIR_LFDI_YYYYMMDD1200.txt CSIR_FFDI_YYYYMMDD1200.txt 
ASC
II 

242Kb Daily 12:00 

INTA 

ANOMN
DVI 

Anomaly of 
Normalised 
Difference 
Vegetation 
Index Map - 
South 
America 

INTA_HRPT_Vegetation_Index_Anom
aly_YYYYMM-K.gif 
[K = Dekad = 1,2,3] 

INTA_HRPT_Vegetation_Index_Anom
aly_YYYYMM-K.gif 
[K = Dekad = 1,2,3] 

Gif 
~240 
Kb 

1st, 
11th 
and 
21st of 
each 
month 

~1-5 
days 
later 

FDI 
Fire Danger 
Index - South 
America 

INTA_NOAA_AVHRR_18_19_Fire_Ri
sk_ YYYYMM-K.gif 
K = Dekad = 1,2,3] 

INTA_NOAA_AVHRR_18_19_Fire_Ri
sk_ YYYYMM-K.gif 
K = Dekad = 1,2,3] 

Gif 
~ 300 
Kb 

1st, 
11th 
and 
21st of 
each 
month 

~1-5 
days 
later 
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NDVIM 

Normalised 
Difference 
Vegetation 
Index Map - 
South 
America 

INTA_HRPT_Vegetation_Index_ 
YYYYMM-K.gif 
K = Dekad = 1,2,3] 

INTA_HRPT_Vegetation_Index_ 
YYYYMM-K.gif 
K = Dekad = 1,2,3] 

Gif 
~260 
Kb 

1st, 
11th 
and 
21st of 
each 
month 

~1-5 
days 
later 

ETR 

Real 
Evapotranspi
ration - South 
America 

INTA_NOAA_AVHRR_Evapotranspir
ation_ YYYYMM-K.gif 
K = Dekad = 1,2,3] 

INTA_NOAA_AVHRR_Evapotranspir
ation_ YYYYMM-K.gif 
K = Dekad = 1,2,3] 

Gif 
~500 
Kb 

1st, 
11th 
and 
21st of 
each 
month 

~1-5 
days 
later 

Marine products for dissemination through EUMETCast. 

 
 
<PML_area>=Algeria, Egypt, EMadagascar, Ghana, Libya, Mozambique, NEMadagascar, NMorocco, RedSea, 
SierraLeone, or SMorocco 
<UCT_area>= Angola, CotedIvoire, ESAfrica, Guinea, Mauritania, MChannel, Namibia, Nigeria, 
NSomalia, Senegal, SSAfrica, SSomalia, Tanzania, or WSAfrica 

 

Product 
acronym 

Full product 
name 

Filename OIS In Filename EXGate Out 

Form
at 
Out 

Compr
essed 
Size 
and 
type 

Produc
ts 
Freque
ncy 

Generati
on Time 
(UTC) 

PML 

PMLAFR 

Near real 
time ocean 
product – 
Africa 

PML_<pml_area>_MODIS_sst_nrt_YY
YMMDDHHMMSS.nc.bz2 
PML_<pml_area>_MERIS_oc_nrt_YY
YMMDDHHMMSS.nc.bz2 
(see) 

PML_<pml_area>_MODIS_sst_nrt_YY
YMMDDHHMMSS.nc.bz2 
PML_<pml_area>_MERIS_oc_nrt_YY
YMMDDHHMMSS.nc.bz2 

NetC
DFv3

Bzip2 
24 per 
day 

Various 

PMLBRA 

Near real 
time ocean 
product – 
Brazil 

PML_Brazil_MERIS_oc_nrt_<passtime
>.nc.bz2 

PML_Brazil_MERIS_oc_nrt_<passtime
>.nc.bz2 

NetC
DFv3

Bzip2 
1 per 
day 

Various 

TBC 
Refined 
ocean 
Products 

PML_<pml_area>_MODIS_sst_refined
_<passtime>.nc.bz2 
PML_<pml_area>_MERIS_oc_refined_
<passtime>.nc.bz2 

PML_<pml_area>_MODIS_sst_refined
_<passtime>.nc.bz2 
PML_<pml_area>_MERIS_oc_refined_
<passtime>.nc.bz2 

NetC
DFv3

Bzip2 
1 per 
day 

TBC 

UCT 

AQUA:O
CPUCT 

Level 3 
Ocean 
Product 

UCT_<uct_area>_MODIS_chlora_YYY
YMMDD.nc.bz2  
UCT_<uct_area>_MODIS_Kd490_YY
YYMMDD.nc.bz2  
UCT_<uct_area>_MODIS_nflh_YYYY
MMDD.nc.bz2  
UCT_<uct_area>_MODIS_sst_YYYY
MMDD.nc.bz2  

UCT_<uct_area>_MODIS_chlora_YY
YYMMDD.nc.bz2  
UCT_<uct_area>_MODIS_Kd490_Y
YYYMMDD.nc.bz2  
UCT_<uct_area>_MODIS_nflh_YYY
YMMDD.nc.bz2  
UCT_<uct_area>_MODIS_sst_YYYY
MMDD.nc.bz2  
 

NetC
DFv3 

40-
2000K
b 
bzip2 

1 per 
day per 
area 

Various 

ENVISA
T:OCPU
CT 

Level 3 
Ocean 
Product 

UCT_<uct_area>_MERIS_algal1_YYY
YMMDD.nc.bz2 
UCT_<uct_area>_MERIS_algal2_YYY
YMMDD.nc.bz2 
UCT_<uct_area>_MERIS_totalsusp_Y
YYYMMDD.nc.bz2 
UCT_<uct_area>_MERIS_yellowsubs_
YYYYMMDD.nc.bz2 

UCT_<uct_area>_MERIS_algal1_YY
YYMMDD.nc.bz2 
UCT_<uct_area>_MERIS_algal2_YY
YYMMDD.nc.bz2 
UCT_<uct_area>_MERIS_totalsusp_
YYYYMMDD.nc.bz2 
UCT_<uct_area>_MERIS_yellowsubs
_YYYYMMDD.nc.bz2 

NetC
DFv3 

40-
2000K
b 
bzip2 

1 per 
day per 
area 

Various 

JRC 

JRC 
Level 4 
Ocean 
Product 

TBD, but currently 
AYYYYJJJYYYYJJJ_<product>_A
MIS.nc.bz2 

TBD Ascii 
5-7MB 
bzip2 

Monthl
y 

after end 
of 
month 
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2. ABOVEGROUND BIOMASS QUANTIFICATION FOR 
NATURAL GRASSLANDS IN THE PAMPA BIOME  

By: Eliana Lima da Fonseca1; Charles Tebaldi2; Adriana Ferreira da Costa Vargas3 and Vicente 
Celestino Pires Silveira4 
 

2.1.  Introduction and relevance of application  

The Pampa biome has a unique kind of vegetation, characterized by C3 and C4 plants adapted to the transition from 

subtropical to temperate climates. The Pampa biome is situated in Brazil, Uruguay and Argentina and can broadly be 
classified as “grassland of the River Plate”. The biome is covering an area of approximately 700,000 km2. This region 
is an important site for migrant birds in the American Continent and there are a quite number of vegetal species in 
danger of extinction. 
The main economic activity in the region is cattle-raising (cows and sheep) based on the natural grasslands since the 
18th century. This “free range” grazing system in natural pastures is compatible with the conservation of the Pampa 
environment. In the Rio Grande do Sul state (most southern Brazilian state) this continuous grazing has been 
existing for more than two hundred years, like a form of economic use of natural grasslands, with a low level of 
damage to the Pampa biome (Overbeck et al, 2007). Data from the Brazilian Ministry of Environment show that the 
Pampa biome in Brazil has been reduced by 54% of its original area due to agricultural activities and forestry 
(cellulose industry) during the last 30 years. These activities are the main reason of the loss of biological diversity as a 
result of the replacement of natural grasslands with other systems of production.  
The monitoring of the aboveground biomass production of vegetation in this region will allow fitting cattle-raising 
activity with the actual biomass production, allowing an adjustment of the number of livestock per area to enable the 
economic exploitation of these areas jointly with the conservation of natural vegetation and of the environment. 

The methodology adopted here can be applied in natural and cultivated areas to estimate aboveground biomass. The 
limitation for replication of this methodology is a good dataset with in situ measurements and knowledge about the 
phenology as well as about the vegetal species that are growing in the study area.   

2.2. Objective 

The main objective of this study is the quantification of the aboveground biomass production for the natural 
grassland of the Pampa biome using NDVI data calculated from images acquired by SPOT-Vegetation instrument. 

2.3.  Study Area 

The study area is located in the “Environmental Protection Area (EPA) of Ibirapuitã” (see also figure 2.1), which is a 
region of 320,000 hectares. The objective of the EPA is to ensure the conservation of a significant portion of the 

biodiversity of the Pampa biome alongside other economic activities.  

                                                      
1 Professor at Department of Geography - Universidade Federal do Rio Grande do Sul (UFRGS) - Brazil  eliana.fonseca@ufrgs.br    

(Corresponding Author) 
2 Bachelor Student at Department of Geography - Universidade Federal do Rio Grande do Sul (UFRGS) – Brazil 
3 Agronomist at Fundacao Maronna - Brazil 
4 Professor at Centre of Rural Science - Universidade Federal de Santa Maria (UFSM) - Brazil 
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Figure 2.1 The location of study area. 

2.4. Data sets used for the study 

For this study two dataset are necessary, namely “in situ” measurements of the amount of aboveground biomass 
(kg/ha-1) and satellite data recorded by the Vegetation Instrument onboard of SPOT 4-5. 

2.4.1. Aboveground biomass data 

The aboveground biomass dataset were collected in the field during a 12 month period (January to December 2002). 
The data was collected on a monthly basis on a plot using a methodology described by Fonseca et al. (2007). The “in 
situ” collected aboveground biomass values are provided for the purpose of the exercise. The plot where the 
aboveground biomass data was collected is situated at the following position: 30°06’S and 55°41’W. 

2.4.2. Satellite data 

The NDVI data from the Vegetation instrument will be analyzed for the same months that “in situ” data of 
aboveground biomass are collected. Here NDVI images are used, the so-called VGT-S10 products, which are a ten-

day Maximum Value Composite (MVC) synthesis for each pixel. The data can also be downloaded from the 
Vegetation website (http://free.vgt.vito.be). Here the images are available in ten predefined regions of interest. For 
this exercise it is necessary to select images from the South America region of interest. In order to match the field 
data and the satellite date it is necessary to choose the same ten-day MVC synthesis for each month that the field 
data were collected, e.g. when the field work was conducted on 3rd of April 2002 the NDVI image selected is for the 
first ten-day MVC synthesis of April 2002. In table 2.1 the selected period for each decade-month used in this study 
is presented. 
 

Month MVC decade selected Month MVC decade selected 

Jan/2002 1st to the 10th  days Jul/2002 1st to the 10th  days 

Feb/2002 1st to the 10th  days Aug/2002 1st to the 10th  days 

Mar/2002 1st to the 10th  days Sep/2002 1st to the 10th  days 

Apr/2002 1st to the 10th  days Oct/2002 1st to the 10th  days 

May/2002 1st to the 10th  days Nov/2002 1st to the 10th  days 

Jun/2002 11th to the 20th  days Dec/2002 1st to the 10th  days 

Table 2.1 Dates selected for NDVI files used in this study 
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2.5. Methodology 

The flowchart (figure 2.2) shows all the steps necessary in order to convert NDVI values in biomass values and to 
obtain an aboveground biomass map. First of all it is necessary to establish the relationship between the NDVI and 
aboveground biomass values collected in the field. This relationship can be expressed as an exponential equation 
using NDVI values as the independent variable. The next step is to calculate for each NDVI pixel the aboveground 
biomass values, using the equation established in the previous step.  

Figure 2.2 Flowchart of methodology adopted 

2.6. Satellite image processing 

2.6.1. Create the NDVI time series 

The NDVI time series can be processed using the GEONETCast (GNC) Toolbox, available as plug in for ILWIS. 
In this toolbox it is possible to extract the files that contain the SPOT Vegetation NDVI maps of Latin America. 
The first step is to choose the date, according the format required by the toolbox. This step is repeated several times, 
for each of the files necessary for construction of the NDVI time series. In this study 12 NDVI images collected 
over the year 2002 were used (see table 2.1). After extraction of all files, 12 NDVI and Status maps are obtained. As 
example, extract a SPOT Vegetation NDVI of Latin America of the first decade of 2002 (note the date format: 
“20020101”), using the GNC-toolbox. Select from the ILWIS Operation Tree, “Geonetcast”, “Toolbox”, “SPOT 
VGT Products”, “SPOT VGT Latin America”, “NDVI”. Specify the appropriate Date, here 20020101. Also select 
the appropriate input and output folders! The last one should be your active working directory!  After extraction is 
completed display the map “ndvi20020101”, using the “NDVI1” Representation. Add also the point map, called 
”insitu” to get an idea where the field observations have been collected. The results should resemble those of figure 

2.3. 

2.6.2. Create the “Sub map” 

In order to calculate the operations only for the study area it is necessary to create a “Sub map”. To create a sub map 
it is necessary to press with the right button over the “ndvi20020101” map and choose from the context sensitive 
menu the “Spatial Reference Operations => Sub Map”. The details to select only the Environment Protect Area of 
Ibirapuitã are provided in the Figure 2.4 (left hand figure) and press “Show” to execute the operation.  

 Field data 
(aboveground biomass) 

Field data 
(sample area location) 

NDVI values collected over sample area 

Regression model 

Biomass (kg/ha
‐1

) = a + exp b*NDVI 

Satellite images 
(NDVI – Spot Vegetation) 

Aboveground biomass 
map 
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Figure 2.3 SPOT Vegetation NDVI, Latin America of 20020101 
 

Figure 2.4 Options to create a Sub Map of the study area and resulting map obtained  
 
To prepare the data for this exercise the above described import and subset routines have been used various times. 

In order to conduct operations and calculations using all 12 files at the same time it is necessary to create a “Map 
list”. Using the command “Create => Map list” available from “File menu”. All the 12 NDVI images used for this 
study have been selected to create this map list and sub maps have been created subsequently. In your active working 
directory you find a map list called “Ibirapuita_2002” with the NDVI maps of the study area only. Note that the 
sequential number at the end of the file name is indicating the month, e.g. the Ibirapuita_2002_3 is the NDVI sub 
map corresponding to the March 2002 NDVI image. All the NDVI time series maps over the Environment Protect 
Area of Ibirapuitã for the year 2002 are presented in Appendix 1. 

2.7. Visualizing the study area over the satellite image 

Open the map list “Ibirapuita_2002” and double click the “Ibirapuita_2002_1” map layer and display this map using 
a Representation called: “NDVI1”. In order to visualize the study area a vector file called “uso” can be draw over the 
Ibirapuita_2002_1. This operation can be performed by dragging this file over the window where the 
Ibirapuita_2002_1 image is shown. Unselect as Polygon Map Display Options “Info” and select the option 

“Boundaries Only” and press “OK”. Result of this operation should be identical to the right hand portion of figure 
2.4. Note that the vector file called “uso” contains all the national protected areas of Brazil (MMA, 2011), but after 
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creating the sub map only the Environment Protect Area of Ibirapuitã region is visualized. You can display it over 
the NDVI map of Latin America. 

2.8. Extract the NDVI values over the sample area 

To extract the NDVI values over the sample area it is necessary to know the geographic coordinates that allow 
locating this area on the NDVI map. For this study the sample area where the field data was collected is located at 
the position: 30o06’S and 55o41’W. If not displayed already, once more open the “Ibirapuita_2002_1” map layer 
from the map list “Ibirapuita_2002”. Now add the point file called “insitu”, showing the location of the field 
measurement site. 
By creating a graph over the “Ibirapuita_2002” map list is possible collect all the NDVI values over the sample area 
at the same time.  The command for this operation is located under “Operations-List” menu from the main ILWIS 
window (“Operations menu => Statistics => MapList => MapList Graph”). The mouse should be clicked over the 
sample area (the sample area is located in line 19 and column 29). The result for this operation is visualized in figure 
2.5. 
To export the NDVI values to a spreadsheet, in order to establish the relationship between NDVI and the measured 
aboveground biomass values, it is necessary to click the button “Clipboard Copy” and then paste these values in 

spreadsheet programme or into an ILWIS table. 

Figure 2.5 Graph of NDVI values collected over the sample area using “Ibirapuita_2002” map list 

2.9. Establishing the relationship between NDVI and aboveground biomass values 

In order to establish the relationship between NDVI and aboveground biomass values a table has been prepared, 
called “insitu_measurement”, containing four columns, map_name, month, NDV and Measured respectively (see 
also figure 2.6). Double click the table to open it and to check if there is a relationship between the measured 
biomass and obtained NDVI, select from the menu “Columns”, “Statistics” and as Function, select “Correlation” 
(see also figure 2.6). The two columns to be selected are “Measured” and “NDVI”. Is important to note that a low 
correlation coefficient is obtained (R=0.517). For this kind of vegetation (natural grasslands) one does not expected 
high correlations (Fonseca et al., 2007) because these are non-homogeneous areas, since the Pampa biome support 
very high levels of biodiversity (Overbeck et al., 2007). This behaviour is also observed for other non-homogeneous 
areas when the NDVI is used to estimate aboveground biomass (Wessels et al.; 2006). 
Having observed that there is a positive correlation, the next step is to express the relationship in the form of an 
equation to transform the NDVI into above ground biomass. According to Gamon et al. (1995) the relationship 
between these two variables is exponential. First select from the Table menu the graphics icon , and from the 

“Create Graph” menu, select as X-axis “NDVI” and as Y-axis “Measured”. Press “OK” to display the graph. You 
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can modify the Graph properties by selecting the items in the left hand graph legend. E.g. unselect “Legend” and for 
the item ”NDVI*Measured”, by double clicking with the mouse on the item name, use as “Color” “Red”. Also 
change the Min-Max settings of the graph axis (X: from 0 to 1, interval of 0.2 and Y: from 0 to 1400, interval 200). 

Proceed from the active Graph window, select from the menu “Edit”, “Add Graph” and select “Least Square Fit. 
Select as X-column “NDVI” and as Y-column “Measured”, use as Function “Exponential” and press “OK”. From 
the Graph legend, select the item: “NDVI*Measured-Exponential”, change the Color to “Black” and set the Line 
Width to “0.2”. Also note the regression formula, which is given on the lower left hand of this menu. Press “OK”. 
Your results should resemble those of figure 2.6. 

Figure 2.6 Table with insitu measurements and scatter plot showing relationship 
 
Close the graph window, eventually save the graph (or select from the graph menu the option File and Save). 
Activate the table “insitu_measurements” again and from the table Menu select “Column”, “Least Squares” and for 

the X-column select “NDVI” and the Y-column “Measured”, specify as output column “Calculated”. Use as 
function “Exponential” and press OK to execute the operation. In the column properties window select the option 
“Additional Info”, here the function is given that needs to be used later to transform the NDVI maps to 
aboveground biomass maps. The derived function should resemble the one given in figure 2.7, leave the other 
options as default and press OK. A new column, called “Calculated” is now added to the table. Check also the results 
obtained in the table. 

Figure 2.7 Exponential function derived 

2.10. Generate the aboveground biomass map 

2.10.1. Calculate the aboveground biomass 

To generate a set of aboveground biomass maps, the equation that expresses the relationship between this variable 
and the NDVI needs to be applied to each pixel for the “Ibirapuita_2002” Map List. To perform this operation 
select the option “MapList calculation” available from the “Operations => Raster Operations” menu. The symbol 
“@1” in the equation represents the “Ibirapuita_2002” Map List. The results are express in a dataset of new output 



APPLICATION MANUAL 

27 

maps, called “Above_biomass_2002” Map List. The options to conduct this operation are shown in figure 2.8. Press 
“Show” to execute the operation.  
 

Figure 2.8 Options to generate the set of aboveground biomass map 

2.10.2. Visualizing the results 

All the aboveground biomass maps calculated for each month in 2002 can be visualized like a slide show, or 
individually like a map. Since the range of “Aboveground_biomass_2002” Map List value is between 260 kg/ha and 
1070 kg/ha, is necessary build a new colour representation that allows one to visualize the aboveground biomass 
variations. To do this select “New Representation” available from the “Operation-List” menu. For visualizing the 
Pampa aboveground biomass the colour representation made for this exercise is called “biomass_pampa”, which is 
presented in figure 2.9. 
 

 
Figure 2.9 The colour representation for the Pampa aboveground biomass 

 
An example of aboveground biomass map for January 2002 is presented in figure 2.10. The entire set of 
aboveground biomass maps over the Environment Protect Area of Ibirapuitã for the year 2002 is given in Appendix 
2. Display an aboveground biomass map calculated using the “biomass_pampa” Representation. Browse with the 
mouse cursor over the map, keep the left mouse button pressed to see the values. 
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Figure 2.10 Aboveground biomass map for January 2002 

2.11. Verification of the results 

The calculated aboveground biomass can be compared with the “in situ” aboveground biomass in the table. Since the 
vegetation of the Pampa biome is non-homogeneous, the distribution of the points does not fit as straight line, 
having a 45 degree angle. This is expected for this kind of vegetation. Consult once more figure 2.6 to see the 
distribution of the points and the relationship used. 

Open the table “insitu_measurements” again and type in the Command line the following expression: 
Residual:=Measured-Calculated 

Press enter and leave all options default in the newly opened Column Properties dialog box and press “OK”. A new 
column is obtained, called “Residual”. Make a new graph and use as X-axis the column “Month” and as Y-Axis the 
column “Residual”. Display the graph and from the graph legend uncheck the item “Legend”. Your results should 
resemble those of figure 2.11. As can de observed from this figure the residual analysis shows clearly a time 
dependency. The high residuals are associated with the beginning of the year. During the start of 2002 the El Nino 
phenomena resulted in above average rainfall in this region (CPTEC, 2011) and this may have affected the quality of 
satellite information. 

Figure 2.11 Residual analysis 
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2.12. Conclusions 

The data obtained from the Spot-Vegetation instrument can be used to derive estimates of aboveground biomass. 
The satellite observations can be converted into NDVI maps and this in turn, using an equation - mathematic model, 
can be converted into biomass. This kind of information is useful to monitor the Pampa biome and it is necessary in 
order to preserve the natural vegetation in association with economic exploration done by the traditional people.  
Model calibration for each kind of vegetation cover, also considering the local weather, will allow one to make more 

realistic models, which are more useful at local conditions and at regional scale when it is compared with global scale 
models. To develop a global model to estimate the aboveground biomass some generalizations are made, like for the 
Brazilian Cerrado and the African Savannas. These generalizations are necessary to build a global scale model but it 
can be an obstacle to apply the results for the purpose of local planning and monitoring. 
The results of the analysis presented here can be improved with a larger dataset of “in situ” measurements for 
different plots and collected over a longer period of time for analysis. 
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Appendix 1 NDVI time series over the EPA of Ibirapuitã for the year 2002 
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Appendix 2 Aboveground biomass map time series over the EPA of Ibirapuitã for the year 2002. 
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3. CROP MONITORING 

By: André Souza1 and Agmom Rocha2   
 
The Company for Food Supply (CONAB) is present in all Brazilian regions, following the trajectory of agricultural 
production, from planning to sowing until the consumers table. CONAB contributes to the decision of the farmer's 
time to seeding, harvesting, storage and will remain involved until the distribution of the products on the market. 
The operations performed by CONAB are coordinated by the Ministry of Agriculture, Livestock and Supply 
(MAPA). For these actions, the company conducts studies and statistics of prices, as well as surveys of agriculture 
production costs, the prospect of sowing and harvesting of grain, besides the volume and location of public and 
private stocks of a range of products. The estimated ethanol production and other relevant information are also 

extended to the harvest of coffee and sugar cane. 
The Faculty of Agronomy of University of Campinas (UNICAMP/FEAGRI) is very active in developing research 
projects focused on technological solutions to problems of Brazilian agribusiness. The FEAGRI’s Laboratory of GIS 
has a role to train highly qualified professionals to act and use geoinformation as a tool for decision making. It also 
works on the development of studies, designs and integrated multidisciplinary courses on GIS applications, such as 
geographical information system (GIS), remote sensing and global positioning systems (GPS) in agriculture, 
environment and other disciplines. 

3.1. Relevance of the topic selected 

In agriculture, Brazil stands out among the world's largest producers, with emphasis on grains, coffee and bio fuels. 
This was made possible by technological advances that have provided this high ranking worldwide. However, due to 
the country's continental dimensions, climate variability is a major challenge to maintain this position and for this 
reason, the adoption of new techniques, technologies and methodologies should be developed to improve crop 

monitoring and forecasting. 

3.2. Objective of the application 

Using vegetation indices derived from SPOT-VEGETATION instrument to monitoring and identify agricultural 
areas with temporary (like maize, rice, soybeans, sugarcane) and permanent (coffee) crops as well as reforestation.  

3.3. Methodology  

The methodology used in this exercise to conduct crop monitoring was based on vegetation indices derived from the 
SPOT-VEGETATION instrument and additional information such as the regions where these crops are established 
in São Paulo and Minas Gerais, who excel in agricultural production. Also the States of Rio de Janeiro and Espirito 
Santo were included. The study area is depicted in figure 3.1. 

The time period for this case study is depending on the availability of the Dry Matter Productivity (DMP) data for 
South America. The starting decade of this product is the first decade of April 2010 and the time series ends during 
the second decade of January 2011. Two decades are missing, namely the first decade of July and the last decade of 
November 2010, therefore the time series is consisting of 27 decades. In addition to the DMP, the Normalized 
Difference Vegetation Index (NDVI) and Normalized Difference Water Index (NDWI) were used. Based on these 
data sets other indices were generated to complement the information provided by the NDVI, NDWI and DMP. 
These indices are: Fraction Vegetation Cover (FVC), Leaf Area Index (LAI), Structural Scattering Index (SSI) and 
                                                      
1 André Souza (CONAB) andrelfsouza@gmail.com 
2 Agmom Rocha (UNICAMP/FEAGRI) agmon@agr.unicamp.br 



APPLICATION MANUAL 

34 

another one that is the result from the combination of NDVI, NDWI and DMP data. The latter only serves to 
highlight the structural patterns of agricultural crops in this study and was designated as COMBVI; the Combined 
Vegetation Index. For further information on the SPOT Vegetation products the VGT4Africa user manual can be 

consulted (Bartholomé, 2006). 
 

 
Figure 3.1 Region selected in the Southeast of Brazil  

 
The FVC was calculated using equation 1, according to Jiménez-Munhoz et al. (2005), see also table 3.1. The LAI 

was calculated by equation 2, according to Norman et al. (2003). The SSI was calculated by equation 3, following the 
procedures given by Gao et al. (2003). There is no reference provided to calculate the COMBVI index.  This index is 
a newly developed index and can be calculated using equation 4. This index intends to combine DMP, NDVI and 
NDWI, putting the last ones “almost” in the same scaling as the DMP.  Figure 3.2 shows the methodology adopted. 
 

Equation number Equation used 

Eq1 FVC = 1.1101 * NDVI – 0.08577

Eq2 LAI = -2 * ln (1 - FVC)

Eq3 SSI = 3.175 * NDVI – 0.297

Eq4 COMBVI = DMP + 10 * NDVI + 10 * NDWI

Table 3.1 Set of equations used 

3.4. Data collection and pre-processing 

Before working with the data, open ILWIS, ensure that the GEONETCast toolbox plug-in is installed, and navigate 
to your active working directory. The following pre-processing steps are already conducted to minimize the sample 
data size and processing time needed. A description of the various steps (chapter 3.4.1 to 3.4.3) is given as reference 
and applied to the raw NDVI, NDWI and DMP time series data derived from the SPOT Vegetation instrument. 

3.4.1. Pre-processing step 1  

Process data from GEONETCast - DevCoCast using the ILWIS GNC-Toolbox menu. The same process can also 
be performed using batch looping routines. Also this procedure is described.  

3.4.1.1. Importing raw files to ILWIS using the GNC-Toolbox menu 

Simply put all the raw files in a folder and set this folder path using the 'Navigator' in ILWIS. Thereafter, from the 
‘Operation-Tree’, select “Geonetcast” and “Toolbox”. Now choose the specific data source, region and finally the 
desired product. 
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Observe that you should “Configure” the “Folders”, available from the GNC-Toolbox Menu and correctly specify 
the ‘Input directory’ and ‘Output directory’. The native files from SPOT-VEGETATION for South America obey 
to a standard name convention, such as: “V2KRNS10__20090101_NDVI__S-America.ZIP”. Using the GNC 

Toolbox, only the ‘Date’ field needs to be specified according to the format required (yyyymmdec). Figure 3.3 shows 
the Toolbox menu details. 
 

Figure 3.2 Methodology for crop yield monitoring using SPOT-VEGETATION indices 
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Figure 3.3 GNC-Toolbox menu for import of the SPOT VGT products for Latin America 
 

3.4.1.2. Importing several images using batch looping routines 

It is possible to adapt the ILWIS import batch files that are stored in the “Extensions\Geonetccast-
Toolbox\Toolbox_Batchroutines” directory, see also figure 3.4. Use your Windows Explorer to browse this folder, 
situated under the main ILWIS directory. There are numerous batch files for import of data delivered through 
GEONETCast into ILWIS format, using simple MSDOS commands. 

Figure 3.4 The batch routine directory of the GNC-Toolbox 
 
To obtain the details of the raw data format meta-data information is required. Usually, this documentation also 
contains information about correction - conversion parameters and the geometry that is used. With this information, 
one can develop an import routine for the desired purpose. See the example given in figure 3.5 of a routine to import 
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data generated from the SPOT Vegetation NDVI for the Latin American region. This batch routine is adapted 
compared to the regular import when using the menu. Here the status map is applied as well. 
 

 
Figure 3.5 SPOT VGT NDVI import batch file for Latin America 

 
As more data needs to be imported to generate a time series of each of the products a new batch file can be created 
as indicated in figure 3.6, using a “FOR” and “DO” loop routine. In this example all the products with a file name 
string consisting of “*V2KRNS10__*” will be taken and the “NDVI_SPOT_Veg_import.bat” (see figure 3.5) will be 
executed. Note that the path to the batch file to be executed needs to be correctly defined, here it is assumed that all 
data is situated in the same directory.   
 

 
Figure 3.6 For – Do loop batch procedure 

 
Having selected the required time series of raw SPOT VGT NDVI products one can just execute the batch routine 
'NDVI_Start_SPOT_Veg.bat' (figure 3.6), which in turn will run the main import routine (“NDVI_SPOT_Veg_ 
import.bat”, see figure 3.5). Note: ILWIS does not need to be active as it is now operated from the MSDOS 
command prompt. Handling your import in this manner facilitates efficient construction of time series data. Figure 
3.7 provides a screen dump of the import routine when active. The import procedures should be adapted to each 
data set used, basically by configuring these two import batch routines. 
 



APPLICATION MANUAL 

38 

Figure 3.7 NDVI S10 import routine screen information 

3.4.2. Pre-processing step 2  

Next step is to create Map Lists containing the imported files. From the ILWIS menu, use the ‘Create’ option and 
select ‘Map List’. Then, select the files that will be part of the list. 

Figure 3.7 Create a Map List 
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3.4.3. Pre-processing step 3 

To create sub-maps for your region of interest (ROI) from the processed Map Lists you must prepare and select a 
spatial reference with your ROI boundaries. The Map List can subsequently be resampled. From the main ILWIS 
menu go to ‘Operations > Spatial Reference Operations > Raster > Resample > Resample Map ‘. When pressing 
“Show” the Map List will be resampled. Note that various Resample Methods can be applied, here the “Bicubic” 
method is selected.  

Figure 3.8 Resampling a Map List 

3.5. Calculation of the various time series indices   

At your disposal are the NDVI, NDWI and DMP time series sub maps and a number of polygon files indicating the 
ROI, areas covered by water and the regionalized crop masks of Coffee, Sugarcane, Bio Fuel and Reforestation. To 
proceed you are going to calculate the remaining indices as indicated in table 3.1. From the ILWIS menu, select 
“Operations”, “Raster Operations” and “MapList Calculation”. Insert the formula as indicated in figure 3.9, identical 
to equation 1, now only applied if the NDVI value is greater than 0. If this is not the case, a “no data” value will be 
returned for the output map, here represented as “?”. 

Figure 3.9 Map List calculation to derive the FVC using a NDVI time series 
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Open the newly calculated Map List and display the map “SPMG_FVC_1” using as Representation “fvc”, note that 
this is the map representing the first decade of April 2009! All more recent decades have received a higher sequential 
number. Move, with the left mouse button pressed the cursor over the active map layer. You will see “no data” 

values, represented by a “?” and negative values due to the resampling method selected. To correct for these negative 
values a new maplist can be calculated by entering the following equation directly on the command line on the main 
ILWIS menu and press enter: 
 
 SPMG_FVC_cor.mpl:=maplistcalculate("iff(@1>0,@1,?)",0,26,SPMG_FVC.mpl) 
 
Display once more the first decade of April 2009 of this newly computed map list and check if the results are correct, 
note that in the Raster Map Display Options also the minimum and maximum map values are given! 
 
Calculate in a similar manner also the other indices (equation 2 to 4 as indicated in table 3.1) and check you results. 
Correct the SSI map identical to the procedure indicated above. Display the calculated LAI map using 
Representation “lai”, and for SSI and COMBVI using the Representation “Pseudo”. 
 

SPMG_LAI.mpl:=maplistcalculate("iff(@1>0,-2*ln(1-@1),?)",0,26,SPMG_FVC_cor.mpl) 
SPMG_SSI.mpl:=maplistcalculate("iff(@1>0,3.175*@1-0.297,?)",0,26,SPMG_NDVI.mpl) 
SPMG_COMBVI.mpl:=maplistcalculate("@1+10*@2+10*@3",0,26,SPMG_DMP.mpl, 
SPMG_NDVI.mpl,SPMG_NDWI.mpl) 

3.6. Local / regional (in-situ) data 

The Southeast Region of Brazil was selected to be monitored using data provided (NDVI, NDWI and DMP) and 
derived indices (FVC, LAI, SSI and COMBVI). Regionalized crop locations are also provided for the Southeast 
Region from Brazil (figure 3.10). 
 

 
Figure 3.10 Local data from areas with sugarcane, coffee, bio fuels and reforestation in States of São Paulo, 

Minas Gerais, Rio de Janeiro and Espírito Santo, Southeast Brazil 
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The cropping areas for coffee are based on data obtained from Brazilian Institute of Statistics and Geography 
(IBGE). The sugarcane growing areas are defined by a buffer zone around the cane processing facilities, having a 
maximum radius of 30 km distance. The processing plant locations are georeferenced by CONAB. These buffer 

areas cover the main sugarcane crops grown in the region. The same process was applied to create buffer zones for 
bio fuels. To identify the reforestation areas statistical techniques were applied, such as standard deviation, using 
SPOT-Vegetation NDVI data. Around the identified areas also buffer zones have been created.  
Display in a new window the vector file “G__Data_Shapes_Geoweb_BR_Graos_DevCoCast_SEBR”, showing the 
administrative boundaries. Select from the active map window menu, the option “Layers” and “Add Layer” and 
select the layer “DevCoCast_SEBR_Waters”, as display options, activate the option “Boundaries Only” and press 
“OK”. Now from the active map window select from the menu the option “File” and “Open Pixel Information”. 
Browse with the cursor over the map and note the tabular information presented as well. Close the Pixel Information 
window. Now add the vectors of Bio Fuel, Reforestation, Coffee and Sugarcane as well, using the display option 
“boundary only”, applying a different “Boundary Color” for the various vector files. Your results should resemble 
those of figure 3.10. 

3.7. Combining “insitu” and data from GEONETCast – DevCoCast 

The processed and resampled time series indices from SPOT-Vegetation (NDVI, NDWI, DMP, FVC, LAI, SSI and 
COMBVI) for the region of interest can now be further analysed using the crop masks provided and temporal 
profiles can be generated of the agriculture areas to indentify the crop(s) behaviours due the variation of climate and 
his influence. 
Open the maplist “SPMG_NDVI” and display the map “SPMG_NDVI_1”. Add to this map the vector layer 
showing the locations of the coffee areas, called “F__Vectors_DevCoCast_RegProdCoffee” and use the option 
boundaries only for display of this vector layer. Now from the main ILWIS menu, select “Operations > Statistics > 
MapList > MapList Graph” In the malist graph window, select as MapList “SPMG_NDVI”, use a fix stretch of 0 to 
1, activate the options “Continuous” and “Always on top”. Activate the map window showing the previously opened 
map layer “SPMG_NDVI” and zoom in to the southwest corner of the map, see also figure 3.11. Browse with the 
left mouse cursor pressed over the map and try to locate the pixel situated at row 769 and column 223. Note the 
NDVI time series values in the graph window. 

Figure 3.11 NDVI map with coffee mask and time series graph of a pixel 
 
Uncheck the option “Continuous” and select the pixel situated at row 769 and column 223. Press the option 
“Clipboard Copy”.  From the main ILWIS menu select “File > Create > Table”, as table name enter “Coffee” and 
specify that there are “27” records, press “OK” to create the table. From the Table Menu, select “Columns > Add 
Column”, as “Column Name” specify “NDVI” and for “Precision”, use 4 decimals by typing: “0.0001”. Click on the 
column heading “NDVI”, the whole column now becomes blue and paste the data copied to clipboard into this 
column. Create also a number of other columns, call these “DMP”, “NDWI”, FVC_cor”, “LAI”, “SSI_cor” and 
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“COMBVI” respectively, using the same precision. From the “Maplist Graph” window, change the Maplist to 
“SPMG_DMP”, uncheck the “Fix Stretch” option and press the option “Clipboard Copy”, paste the data into the 
“Coffee” table, under the column “DMP”. Repeat this procedure until all columns have been filled with the 

appropriate time series data. Your results should resemble the table given in figure 3.12. Note that from the Table 
menu, Option “View”, the “Statistics Pane” can be activated to get some summary statistics of the respective 
columns as well. 

Figure 3.12 The resulting coffee table containing the time series indices values 
 
Press from the Table menu the Graph icon , uncheck the X-Axis and as Y-Axis select the column “ndvi”, press 
“OK”. In the felt hand graph menu, uncheck the option “Legend”. Double click the “ndvi” item and from the 
"Graph Options –Graph from Columns” menu, select the option “Line” and press “OK”, double click the “Y-Axis 
left”, modify the text as follows:”ndvi, dnwi, fvc_cor, lai and ssi_cor”, change the “Min-Max” scaling from -1 to 4 
and specify as “Interval”:”1”, press “OK”. Double click also the “Y-Axis right”, modify the text as follows:”dmp and 
combvi”, change the “Min-Max” scaling from 0 to 150 and specify as “Interval”:50. Activate the option “Show Axis” 
and unselect the option “Show Grid”, press “OK”. Double click the text “ndvi” at the top of the graph and specify 
as “Graph Title”: “Coffee time series index response [location row-col 769,223]”.  
From the Graph menu, select “Edit > Add Graph > From Columns”, now select the column “dmp” and press 

“OK” to add this column. Double click the item “dmp” in the left hand legend menu of the graph, change it to a line 
representation and use a black color. Now “Use Y-Axis” “Right” to scale the data, note also from the table that the 
data range is completely different for the dmp and the combvi. Press OK to see the newly dmp time series on the 
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graph. Repeat this procedure until all columns are added, change the axis of the combvi to right hand Y-axis, for the 
others the left hand axis can be used. Your resulting graph should resemble the top left graph of figure 3.13.   
Repeat the procedure described above and prepare a table and graph for sugarcane (pixel row- col 381, 1414), bio 

fuel (pixel row- col 127, 1063) and reforestation (pixel row- col 227, 1155). You can copy the already created 
“coffee” table to a new table called “sugarcane’ by selecting the table “coffee” (press it once using the left mouse 
button and from the main ILWIS menu, select “Edit > Copy Object to” and select the option “New Name”, in this 
case use as name “Sugarcane”. Open the table “sugarcane” and from the clipboard the data can now be pasted into 
this table for the various columns.  

Figure 3.13 Time series graphs of coffee, sugarcane, bio fuel and reforestation 
 
It is clear that for the selected crops and reforestation there is a different temporal response using the various indices. 
It should be noted that sometimes there are remarkable peaks and dips in the time series which might require 
additional filtering steps as this response could be related to pre-processing of the initial data.  The graphs can now 
be further analysed, this should be done in conjunction with a good knowledge on the cropping calendar and the 

normal (average) response that is expected during a given time of the crops. Deviations can be easily identified, both 
positive (good crop performance) and well as negative (crop development stresses). Other climatological information 
can be used as well for this purpose.  

3.8. Conclusions 

This exercise shows the ability and potential to use data delivered through GEONETCast in the development of a 
monitoring system based on data obtained from satellite and local observations. Accordingly, this information can be 
fully explored and the results can be applied in various sectors, providing data that can be used to quantify 
bioclimatic parameters and monitor its evolution in time and space, thus constituting an important source of 
information. 
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4. ESTIMATION OF EVAPOTRANSPIRATION IN MINAS 
GERAIS STATE, BRAZIL 

By: Elizabeth Ferreira1, Antonio Augusto Aguilar Dantas2, Alfredo Gabriel Garcia3 
 
The University of Lavras was founded in 1908 as Agricultural School of Lavras, in 1938 it was renamed School of 
Agriculture of Lavras; it was federalized in 1963 and in 1994 it became Federal University of Lavras (Portuguese: 
Universidade Federal de Lavras) – UFLA. Since then it is committed to provide and foster development and 
continuous expansion of services to society. UFLA’s force and grandeur may be measured when considering its 
current structure and future prospects. The institution is organized into 17 Didactic-Scientific departments, which act 
in different areas of knowledge. UFLA prepares more than 5,600 students in its 30 under-graduate courses (23 

classroom courses and 7 distance learning courses). There are more than 1,500 graduate students, distributed in 20 
Masters and 18 PhD degrees. In the distance-learning program, there are more than 5,000 students from all Brazilian 
states and abroad. UFLA projects to count on an enrollment of about 15,000 students by the year 2012. For further 
information see: http://www.ufla.br/en 

4.1. Introduction 

Evapotranspiration (ET) is the term used to describe the amount of water which is effectively lost from the earth 
surface to the atmosphere by soil surface evaporation and plant transpiration. ET is an important component of the 
water cycle and its importance in the hydrological cycle makes its accurate quantification necessary for calculation of 
the soil water balance, either for the detection of water stress conditions, their use as input variable in crop yield 
models or the study of ecosystem functioning and its relationship to local and regional climate, among others. The 
Brazilian Institute of Geography and Statistics 2006 Census revealed that in Brazil approximately 5.2 million 
agricultural establishments are occupying 36.75% of the national territory (IBGE, 2006). Regarding the use of 

irrigation, 6.3% of establishments reported using this technique, accounting for a 39% increase in the number of 
agricultural establishments, compared to the previous Census of 1995, furthermore resulting in an absolute increase 
of 1.3 million hectares (42%). The irrigated area, with 4.45 million ha (7.4% of the total area) under temporary and 
permanent crops, has the following means of water supply: 24% of the area is irrigated by flooding, 5.7% by grooves, 
18% has a centre pivot, 35% use other sprinkler methods, 7.3% supply water using localized methods and 8.3% is 
irrigated using other methods. The Minas Gerais State (586,528.293 km² and a population of 20,595,499 people) is 
the Brazilian state with the largest number of establishments (48.39 thousand) using some form of irrigation 
technique. A total of 3789 center pivots in Minas Gerais State have been identified as from the start of 2011 (Ferreira 
et al 2011). One of the major problems of irrigated agriculture is the correct sizing of the quantity of water 
requirements of the cultures. The estimation of evapotranspiration from data obtained by remote sensing is an 
alternative in the determination of water required by crops, especially for large areas, since the traditional methods 
using data collected using meteorological ground observations, represents only points in geographic space. 
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4.2. Objective of the application 

The objective of this application is to estimate daily Evapotranspiration (ET) using the  Surface Energy Balance 
System (SEBS) Model to know the ET pattern over irrigated areas by center pivots, in MG State, Brazil using ILWIS  
and the GEONETCast Toolbox with data obtained through GEONETCast and DevCoCast. Since the Land 
Surface Analysis Satellite Application Facility (LSA SAF) also provides an ET product (SAF ET), the estimated ET 
calculated using the SEBS model and the SAF ET product are also compared. 

4.3. Methodology  

First a brief review of the SEBS Model is presented. Su (2002) indicates that SEBS requires as inputs three sets of 
information. The first set consists of land surface albedo, emissivity, temperature, fractional vegetation cover, leaf 
area index and the height of the vegetation (or the roughness height). When vegetation information is not explicitly 
available, the Normalized Difference Vegetation Index (NDVI) is used as a surrogate. These inputs may be derived 
from remote sensing data in conjunction with other information about the concerned surface. The second set 
includes air pressure, temperature, humidity and wind speed at a reference height. The reference height is the 
measurement height of the meteorological parameters for point application and the height of the planetary boundary 
layer (PBL) for regional application. This data set can also be extracted from a large scale meteorological model. The 
third data set includes downward solar radiation and downward long wave radiation which can either be measured 
directly, obtained through model runs or using a different type of parameterization. 
According to Su et al (2005), the SEBS model (Su 2002) was developed to estimate surface energy fluxes and the 

evaporative fraction using remotely sensed data in combination with meteorological information at scales that are 
dependent on the forcing data. SEBS consists of several separate modules to estimate the net radiation and soil heat 
flux and to partition the available energy (=Rn-G0) into sensible and latent heat fluxes, as presented in equation 1: 
 

Rn - G0 = H+ λ E  (eq 1) 
Where: Rn: the net radiation; 

G0: the soil heat flux; 
H: the sensible heat flux; 
λ E: the latent heat flux. 

 
SEBS estimates the net radiation based on the radiative energy balance. The other component comprising the 
available energy is the soil heat flux. In the absence of observed soil heat flux measurements, as in satellite 
applications or at large regional scales, empirical formulations of the soil heat flux based on net radiation and the 
vegetation fraction are used to estimate the total soil heat flux for the area. The remaining variable that SEBS 
independently estimates is the sensible heat flux (H), which is solved using a combination of three equations using 

wind speed and the friction velocity. In SEBS, the model output of sensible and latent heat fluxes is also constrained 
by considering dry-limit and wet-limit conditions, which give the upper and lower boundary of sensible heat flux 
estimation. Further details on the particular techniques used to separate the sensible and latent heat flux from the 
available energy can be found in Su (2002). The SEBS model is implemented in ILWIS and BEAM (Wang et al, 
2008). The ILWIS SEBS plug-in version used here is 1.1. Note that additional information on SEBS is also available 
from the main ILWIS menu. Select the option “Help”, and select “SEBS Help”. 

4.4. Input data  

4.4.1. Local / regional (in-situ) data 

The input data (in situ) for SEBS model are: average daily wind speed at 2m (m/s), mixing ratio (kg/kg), daily air 

temperature (oC), solar net radiation at crop surface (W/m2). These data are obtained from the Climatological 
Ground Stations, that are located in the following municipalities of Minas Gerais State: Araçuaí,  Araxá,  Bambuí,  
Barbacena, Belo Horizonte, Poços  de Caldas,  Cambuquira,  Capinópolis,  Caratinga, Cataguases,  Conceição do 
Mato Dentro,  Coronel  Pacheco, Curvelo,  Diamantina, , Espinosa,  Florestal,  Governador Valadares, Ibirité,  
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Itamarandiba,  Januária,  João Monlevade,  João Pinheiro, Juiz de Fora, Lavras, Machado,  Montes Claros,  Oliveira, 
Passa Quatro,  Patos de Minas,  Pedra Azul,  Pirapora, Pompeu,  Salinas,  São João del-Rei,  São Lourenço,  Sete 
Lagoas,  Teófilo Otoni, Uberaba and  Viçosa. These data were retrieved from a CD “Normais Climatologicas do 

Brasil 1961-1990”. The specific local and regional data files needed for this exercise is listed below:  
 DEM (obtained from http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/gtopo30_info): 

GTOPO30_Minas (ILWIS map layer) 
 Climate data (CD ordered from http://www.inmet.gov.br/): 

Station_MG.txt 
 Boundaries (obtained from http://www.geominas.mg.gov.br/): 

Boundary (ILWIS map layer) 
Municipalities (ILWIS map layer)  
pivots_MG (ILWIS map layer) (from the authors) 

4.4.2. Data from GEONETCast-DevCoCast 

The GEONETCast-DevCoCast products are obtained from the LSA SAF for the South American window. 
Products used are: albedo, DSSF, LAI, LST, FVC and the Daily Evapotranspiration product. Finally, from 
DevCoCast the SPOT Vegetation S10 Maximum Value Composite NDVI was collected. The specific data files 
needed for this exercise is listed below: 

 Landsaf products (obtained from https://landsaf.meteo.pt/): 
S-LSA_-HDF5_LSASAF_MSG_ALBEDO_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_FVC_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_LAI_SAme_201005020000.bz2 
S-LSA_-HDF5_LSASAF_MSG_DSSF_SAme_201005021500.bz2 
S-LSA_-HDF5_LSASAF_MSG_LST_SAme_201005021500.bz2 
ET_Minas_geo (ILWIS map layer) 

 SPOT Vegetation product (obtained from http://www.devcocast.eu/): 

V2KRNS10__20100501_NDVI__S-America.ZIP 

4.5. Data analysis 

In order to evaluate the spatial variation of evapotranspiration using the SEBS algorithm, the data of 02 May 2010 
are analyzed. The primary data was downloaded from the GEONETCast-DevCoCast data providers. The other 
products used here were also obtained from the internet (DEM, NDVI and LSA SAF) and from a CD with Brazilian 
climatological ground station data. A flow chart describing the main (pre-) processing steps to perform the 
application is shown in Figure 4.1. 

4.5.1. Data pre-processing steps required 

Ensure that you have unzipped the exercise data and move using the ILWIS navigator to this active working 
directory. You will note that there are two sub directories, “gnc_data” and “lst”. The first directory is containing the 
raw data from GEONETCast-DevCoCast, the second one is containing a time series of Land Surface Temperature 
data. Once close ILWIS and Open ILWIS again to ensure that the directory settings are correct. You can have a look 
at the data that is available in this folder, open some of the maps and have a look at their content. 
Now, from the ILWIS menu, ensure that the GEONETCast toolbox plug-in is installed, open the “Geonetcast” => 
“toolbox”, select the option “Configuration” and Folders”. Now select the folder settings for “SPOT VGT4 Latin 
America”, set the appropriate input and output folders, note that the input folder is your active working directory 
and add here the sub-directory “\gcn_data”. Repeat this procedure and specify the appropriate folder setting for the 
“SAF South America” Products. 
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Figure 4.1 Flow chart showing the main steps to derive ET using SEBS model in ILWIS and 
GEONETCast toolbox  

4.5.1.1. Import LSA SAF products  

From “GEONETCast” and “Toolbox” main menu select “Satellite Application Facility (SAF)”, “South America” and 
“Albedo” to import the Surface Albedo product. Type the appropriate date according to the pre-defined format: 

“201005020000”. Repeat these steps to import the other SAF products (DSSF, FVC, LAI and LST). Note that to 
import the DSSF and LST the date format is “201005021500”. Check the resulting imported maps, open them and 
browse with the left mouse cursor pressed over the maps. As Representation use “Pseudo” for Albedo, DSSF and 
for LAI, FVC and LST the representations “lai_SAF”, “fvc” and “lst” respectively. You will note that there are a lot 
of “no data” values for the “lst” map, probably due to cloud cover. As this is an important input layer in SEBS 
additional attention needs to be given to this map. The temporal resolution of this product is 15 minutes and we can 
process a longer time series of data to obtain a better land surface temperature map, using more time stamps. To 
conduct this multi temporal import you are going to apply a batch looping routine, for further explanation on the 
procedure, see Maathuis et al (2011). Using the ILWIS Navigator go to the sub-directory “\lst”, you will see a 
number of ILWIS service objects that are used for the georeferencing. 
Close ILWIS from this sub-directory. With the Windows Explorer navigate to the sub-directory “\lst” and unzip the 
file “lst.zip”, using the option “extract here”. After this operation is completed, check the temporal interval of the lst 
data, note the time stamp is in UTC (local time = UTC – 3 hours)! Right click with the mouse on the file called 
“multi_lst_start.bat” and from the context sensitive menu, select “Edit”. Inspect the batch command line given and 
close the file. Now select the second batch file, called “multiSame_lstimport.bat”, again select “Edit” from the 

context sensitive menu. Now modify the directory name strings in this batch file and specify the correct path names 
where ILWIS is situated on your system (see lines 7 to 9). After the correct directory has been specified for these 
three lines in the batch file, select from the text editors main menu, the option “File” and “Save”. Close the text 
editor. Now double click with your mouse on the first batch file “multi_lst_start”. The multi temporal import of the 
lst product is now started and all SAF-lst files are now imported. Upon completion of the batch routine start ILWIS 
again and navigate to the sub-directory “\lst”. Open one of the imported lst maps and use as Representation “lst”.  
Now you are going to calculate the average land surface temperature for this time period. To do so, from the main 
ILWIS menu select the option “File => Create => MapList” and add all maps to this maplist, using the “>” icon, 
specify an appropriate Map List name, e.g. “lst_time” and press “OK” to execute the operation. First all “no data” 
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values are going to be reassigned to 0, to do so select from the ILWIS main menu, the option “Operations => 
Raster Operations => MapList Calculation”, as input map list use “lst_time”, only “1” input Maplist. As 
“Expression” type: 

ifundef(@1,0.00)  
Specify as output map list “lst_time0” and press “Show”. After calculation is finished, open one of the new maps 
created and check the result, all “no data” values have been reassigned “0.00”. Right click with the mouse the maplist 
“lst_time0”, select from the context sensitive menu the option “Statistics => MapList Statistics”, as Statistical 
function select “Sum” and specify as output map name: “lst_sum”, press “Show” to execute the command. Repeat 
this procedure and select as statistical function, the option “Count”, but now use as input map the original time 
series, called “lst_time”, call the output map “lst_count”. Note that this map gives the number of events that an 
appropriate lst value was given in the time series data! Now calculate the average lst by typing the following 
expression on the ILWIS command line: 

lst_avg:=lst_sum/lst_count  
and use all options as default. Check this output map. Right click with the mouse the map name “lst_avg” and from 
the main IWLIS menu, select the option “Edit => Copy Object to”, select the option “New Directory” and copy 
this file in the your main active working directory you used to extract all other SAF data. Use the ILWIS Navigator to 
go back to your main working directory 

4.5.1.2. Import Spot Vegetation products 

From “GEONETCast” and “Toolbox” main menu select “SPOT VGT4 Products”, “SPOT VGT4 Latin America”, and 
finally select “NDVI”. The date format to be entered is “20100501”. Open the imported map “ndvi20100501” and 
use as Representation “NDVI1”, browse with the left mouse cursor pressed over the map and inspect the values. 
Note that also a status map is created, this map is going to be applied to select only those pixels that meet the 
following criteria: cloud free, land pixel and having good radiometry in the red and near infra red channels. For 
further explanation on the procedure, see also Maathuis et al (2011). Type the following map calculation formula on 
the command line in the main ILWIS menu: 

Status_ok:=iff((((ndvi20100501_SM div 1)mod 2)+(( ndvi20100501_SM div 2)mod 2)=0) and 
(((ndvi20100501_SM div 8)mod 2)+((ndvi20100501_SM div 32)mod 2)+((ndvi20100501_SM div 64)mod 
2)=3),1,0) 

Leave all other options as default and execute the operation. Inspect the resulting map and now apply the mask, 
showing the pixels meeting the selection criteria, to the NDVI map by entering the following map calculation 
statement on the command line in the main ILWIS menu: 

ndvi_ok20100501:=iff(Status_ok=1,ndvi20100501,?) 
Again use all other settings as default and execute the operation, check the results, use as Representation “NDVI1”. 

4.5.1.3. Submap of the Minas Gerais State and resampling other maps 

With the “ndvi_ok2010050” active, add from the map menu, using the option ”Layer” and add the layer “boundary”. 
Open from the main ILWIS menu “Operations”, “Spatial Reference Operations”, “Raster” and “Sub Map”. Create a sub 
map of Minas Gerais State, using the settings of the Figure 4.2 (left hand figure).  
It is important in order to apply SEBS that all maps are in the same projection - coordinate system, same datum and 
same spatial resolution. Resample all the other imported products using the georeference of the Minas Gerais NDVI 
Sub Map. The maps will be transformed into a Plate Carree, latlon coordinate system, WGS 84 datum and ellipsoid 
and the spatial resolution of the SPOT VGT4 product used (here 0.0089285714, or 112 pixels per degree). 
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Figure 4.2 Creating a sub map of  SPOT VGT4 NDVI for Minas Gerais State and sub map details  
 
To resample the LSA SAF products and GTOPO30_MINAS digital elevation model follow the instructions below: 

first right click the mouse over the map that you want to resample and choose “Spatial Reference Operations => 
Resample”. For resampling settings select the specifications given in figure 4.3. Repeat the procedure to resample 
also the other maps like Albedo, LST_avg, LAI, DSSF, FVC and GTOPO30_minas. Here the file name prefix “re_” 
is used for the resampled output maps. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.3 Resampling settings and the resulting Albedo sub map 

4.5.1.4. Change of units for LST and ALBEDO of the Minas Gerais Sub Maps 

Take special care of the following steps, because they are required to run SEBS and derive the ET. The LST units 
have to be changed from degrees Celsius to Kelvin and for the Albedo map from percentage to ratio. 
To do this for the LST Minas Gerais sub map (re_lst) type in the following expression in the ILWIS command line:  

re_lst_kelvin:=re_lst+273.15 
Keep all other options default and press “OK” to execute the operation. To change the units of the Albedo sub map 
(re_Albedo), from percentage to ratio, type the following expression in the ILWIS command line: 

re_albedo_ratio:=re_albedo*0.01 
Keep all other options default and press “OK” to execute the operation. Check the results of the operations. 

4.5.1.5. Calculate Emissivity, Solar Zenith Angle and derive downward solar radiation 

To calculate the emissivity, using the procedure according to Valor and Caselles (1996), type the following expression 
in the ILWIS command line: 
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re_emis:=0.985*re_fvc+0.96*(1-re_fvc)+0.015  
Keep all other options default and press “OK” to execute the operation. Check the resulting map.  
From the “GEONETCast” and “Toolbox” main menu select the option “Calculate MSG Angle”, “Calculate solar 

and satellite zenith angle maps for MSG field of view” and type for year 2010, Month 05, Day 02 and hour (UTM) = 
15.00. Note that the appropriate output directory is assigned correctly! The resulting map, called “sol_zenres”, 
should be resampled using the NDVI sub map georeference (ndvi_minas). Your results should resemble those of 
figure 4.4. 
 

Figure 4.4 Solar zenith angle of MSG for the full disk and resampled to the Minas Gerais georef 
 
The downward solar radiation data can be spatially represented by a map, e.g. using the LSA SAF DSSF product, or 
by a single value. In this case a single value of 623 W/m2 is derived, being the mean value obtained from the 
operational meteorological ground station in MG State at 15:00 hrs (data obtained from: 
http://sinda.crn2.inpe.br/PCD/historico/consulta_pcda.jsp). Note that a UTC time of 15:00 hours corresponds to 
12:00 hour’s local time. 02 May corresponds to Julian day number 122 (sum of days for a given year, starting from 01 
January: 31+28+31+30+2). Note that you have already imported and resampled the DSSF product previously! 

4.5.2. Import table and processing of in situ data  

From the ILWIS main menu select “File => Import => ILWIS => Table => Space delimited”. Choose 
“Station_MG.txt” file as input file and as output file type “Station_MG”. Press “OK” and “Next” to continue 
importing the data, in the “Edit column detail” window, by double clicking and typing in each line of the first column 
the appropriate column name: Y (column1), X (column2), Temp (column3), HumityRel (column4), Pressure 
(column5), Mix_ratio (column6), Ins_hrs (column7) and Windspeed (column8). Edit all column names and press 
“OK” to import the table. The “Edit column detail” is also given in figure 4.5 and the resulting imported table is 
presented in appendix 1. 

Figure 4.5 Editing first column of each line with appropriate column name 



APPLICATION MANUAL 

52 

Select from the ILWIS main menu “Operations => Table Operations => Table to point map”. Specify identical 
settings as those given in the left hand picture of figure 4.6 and press “Show”. To see the resulting point map with 
the distribution of INMET climatological ground stations, open the vector map “boundary”, using default settings, 

select “Add layer” from the map window menu and select the point map “station_MG”. 
 

Figure 4.6 Table to point map conversion and INMET ground stations distribution  
 
As can be seen from the imported table showing the climatological observations, for the columns “Ins_hrs” and 
“Mix_ratio” hardly any differences appear. The mean value for these variables would be a good approximation for 
the whole area. For the columns “Windspeed”, “Pressure” and “Temp” a larger variation occurs, this could be 
spatially represented if there is a correlation with elevation. 
To determine if there is a correlation, first transform the point map to a raster format, right click with the mouse the 
point map “station_MG”, from the context sensitive menu, select the option “Rasterize => Point Map to Raster”, 
use as georeference “NDVI_Minas” and leave other options as default given, press “Show” and “OK”. Look 
carefully, eventually Zoom-in, as the stations are presented using a single pixel! Next step is to cross the rasterized 
point map with the elevation model, in this case the resampled GTOPO30 DEM (see again section 4.5.1.3), here 
called “re_gtopo30”. 
Select from the main ILWIS menu “Operations => Raster Operations => Cross”, as first map select the map 
“re_gtopo30” and as second map, select from the map “station_MG”, by pressing the “+” sign in front of the map 
name, the table column “Temp”. As output table specify “dem_temp” and press “Show”. Open the table and from 
the active table menu, select “Columns => Statistics” and select as function “Correlation”, note the column 
assignment and press “OK”. Note that there is a reasonable correlation between the variables elevation and 
temperature (R=-.757). From the table Menu select “Column”, “Least Squares” and for the X-column select 

“re_gtopo30” and the Y-column “map2” (representing the variable Temp), specify as output column “dem2temp”. 
Use as function “polynomial”, “Nr. of terms” of “2” and press “OK” to execute the operation. In the column 
properties window select the option “Additional Info”, here the function is given that needs to be used later to 
transform the elevation map to temperature. Note down the equation, press “OK” to close the window, leave the 
other options as default and press “OK”. A new column, called “dem2temp” is now added to the table. Check the 
results obtained in the table. 
Repeat the procedure to derive the relationship between the gtopo_30 elevation model and the check the new 
column “pressure” from the table “station_MG”. 
 
Transform the re-gtopo30 elevation model into air temperature (in degree Celsius) and pressure reference height (a 
height of + 2 meters is used in SEBS, in Pa) using the following equations (that you have derived in the previous 
steps) by typing the expressions in the ILWIS command line: 
 re_air_temperature:=24.096+-0.006*re_gtopo30 
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Keep all other options default and press “OK” to execute the operation. Repeat it to derive the “reference pressure” 
by typing the following expressions in the ILWIS command line: 
 re_pressure_reference:=100355.628+-9.175*re_gtopo30 

Keep all other options default and press “OK” to execute the operation. To derive the pressure at the surface a mean 
daily air temperature of 20 degree Celsius is used which accounts for a pressure increase of 23 Pa over a 2 meter 
difference as a Reference Height of 2 metres is assumed during the collection of the field observations. To obtain the 
pressure at the surface type the following expressions in the ILWIS command line: 

re_pressure_surface:=re_pressure_reference+23  
Keep all other options default and press “OK” to execute the operation. Check your results obtained, use as 
Representation “Pseudo”. 
 
To get a spatial representation of the windspeed, as there is no correlation with the elevation model, a different 
approach has to be followed. Select from the main ILWIS menu, the options “Operations => Interpolation => 
Point Interpolation => Moving Average”. Specify the column “windspeed” from the point map “Station_MG (press 
the “+” sign in front of the point map and select the appropriate column), use the option “Inverse Distance” as 
Weight Function, leave the default “Weight Exponent” as “1” and check the option “Use Spherical Distance”. 
Specify as Output Raster Map “re_windspeed” and select the georeference “ndvi_minas”, Press “Show” to execute 
the operation. Check your results obtained, use as Representation “Pseudo”. 

Correct the obtained windspeed map to represent the windspeed at the surface by using a correction factor. Type the 
following expressions in the ILWIS command line: 
 Re_windspeed_cor:=re_windspeed*0.75 
Keep all other options default and press “OK” to execute the operation. Check your results obtained, use as 
Representation “Pseudo”. 

4.6. Running SEBS in ILWIS 

After all pre-processing you are now able to run SEBS. Choose “Operations”, “SEBS Tools” and “SEBS” from the 
main ILWIS menu. See also figure 4.7, indicating all input maps required to run the SEBS plu-in. Ensure that all 
input maps are correctly specified as well as the single values, representing the various model parameters. Note that 
you can run SEBS twice, the first run with a single “Instantaneous Downward Solar Radiation Value” of “623 
W/m2” and for a second run, active the check box in from the “Inst. Downward Solar Radiation Map (W/m2 )” and 
use as input map the resampled DSSF map, called here “re-dssf”. Figure 4.8 shows the SEBS daily 

evapotranspiration results in mm/day for both runs. 
Note that once SEBS has completed the computation, select the map “SEBS_Daily_Evap”, when SEBS is started 
again a new daily evaporation map is produced, called “SEBS_Daily_Evap__1”. From the command line, pressing 
the command line history drop down button (on the right hand side of the command line in the main ILWIS 
window) the SEBS command line can be extracted. The example command line below is the result of the 
specifications given in the entry menu form of figure 4.7. If small changes have to be implemented the parameters 
can be easily replaced using the command line, instead of filling out the full form. The example command line is give 
below: 

sebs.mpr=MapSEBS(re_lst_kelvin,re_emis,re_albedo_ratio,ndvi_minas,1,re_lai,1,re_fvc,1,re_solzen,0,1,re_ 
gtopo30,0,1,122,0,0,0,2,1000,0,,0.0109,1,Re_windspeed_cor,2,1,re_air_temperature,25,1,re_pressure_refere
nce,100000,1,re_pressure_surface,100100,39.2,1,623,0,nomap,0,nomap,0,nomap,0,nomap,0,,20,0,,7) 

 
Note that for the specific humidity the average value of the column “Mix_ratio” is used from the table 
“station_MG” and the following equation has been applied: specific humidity in kg/kg = mix_ratio/(1+mix_ratio), 
or 0.011/(1+0.011). For the sunshine hours per day the average value is extracted from the climatological data 
presented in the table “station_MG”, roughly amounting 7 hours of sunshine. KB^-1 is the inverse Stanton number, 
a dimensionless heat transfer coefficient and can be left default.  Display your SEBS results, using as Representation 
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“sebs_ET” available from your main working directory. Your results should correspond to those given in figure 4.8 
below. Inspect your daily ET values obtained (unit in mm/day). 
 

 Figure 4.7 SEBS data entry form in ILWIS  

Figure 4.8 SEBS daily ET (mm/day), using single downward solar radiation value (left) and LSA SAF 
DSSF map (right) 

4.7. Derive statistical information aggregating  Minas Gerais state and center pivot area 

Now you are going to use the SEBS daily evapotranspiration results (sebs_ daily _evap) to extract the information 
for the whole Minas Gerais state and for each center pivot area. To obtain the information for Minas Gerais state 

only, first display the map “SEBS_Daily_Evap” and add the vector layer “boundary”. In the “add layer” display 
options uncheck the option “Info” activate the option display “Boundaries only”. 
Convert the polygon file “boundary” to a raster map format, select from the ILWIS main menu “Operations => 
Rasterize => Polygon to raster”. In the “Polygon to raster” window select the vector layer “boundary” and select the 
georeference “NDVI_Minas”. As output map type “boundary” and press “Show” and subsequently “OK” to see the 
newly created rater “boundary” map. 
Now mask the two ET maps created with SEBS using the boundary raster map. Type the following expressions in 
the ILWIS command line: 

sebs1_mask:= iff(boundary="1",sebs_daily_evap,?) 
sebs2_mask:= iff(boundary="1",sebs_daily_evap__1,?) 
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Keep all other options default and press “OK” to execute the operation. Check your results obtained, use as 
Representation “sebs_ET”. To obtain some general statistics, right click with the mouse the map “sebs1_mask” and 
select from the context sensitive menu the options “Statistics => Histogram” and press “Show”. Repeat the 

procedure also for the map “sebs2_mask” and check and compare the results. 
Another way to get statistical results is by classifying the continuous data range into user defined classes. To do this a 
domain is used. Double click on the domain “sebs_cl” and take note of the classes that have been defined. From the 
main ILWIS menu, select the option “Operations => Image Processing => Slicing” and specify as raster map 
“sebs1_mask” and as output raster map “sebs1_mask_cl” and as domain “sebs_cl”, press “Show”. The resulting 
map is now classified according to the data ranges specified by the domain. Close the map and right click with the 
mouse the map “sebs1_mask_cl” and select from the context sensitive menu the options “Statistics => Histogram” 
and press “Show”.  
Repeat the classification procedure also for the map “sebs2_mask”, check and compare the results. 
 
To obtain the ET information, but now for each center pivot, a polygon map “pivots_MG” is available. First display 
the vector map “boundary” and add the layers “pivots_MG” and “municip”, see also figure 4.9. Convert the polygon 
map “pivots_MG” to a raster map format, select from the main ILWIS menu “Operations => Rasterize => 
Polygon to Raster”. As output raster name type “pivots_MG”, as georeference use “ndvi_minas”.  
 

Figure 4.9 Map detail showing various vector layers of irrigated areas by center pivots 
 
To obtain a table with statistical results per pivot, select “Cross” (from the ILWIS main menu select “Operations => 
Raster Operations”) and use the raster map “pivots_MG” and the SEBS daily evapotranspiration map, here called 
“sebs_daily_evap”. Specify as first raster map “pivots” and as second raster map “sebs_daily_evap”. Specify as 
output cross table “sebs_pivots”. Keep the other options as indicated by default. Now aggregate the daily 
evapotranspiration from SEBS and append this as a new column into the table “pivots_MG”. To do this select from 
the “sebs_pivots” table menu the option “Column” and from the drop down list select “Aggregation”. Specify the 
settings according the figure 4.10. 
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Figure 4.10 Aggregating the daily evapotranspiration from SEBS to pivots areas 
 
Display the ET_Minas_geo raster map, using a “Pseudo” Representation, the map is provided in your main working 

directory. This raster map was obtained from the LSA SAF, the so called ET-product.  The temporal resolution of 
this product is 30 minutes, so the 48 time steps have been aggregated to get a daily ET map, in a similar manner as 
how the LST map was created. Already an appropriate sub map has been made.  
The same method to get the statistical results from SEBS can be used to obtain the statistics from the ET LSA SAF 
map called “ET_Minas_geo”. From the ILWIS main menu select “Operations => Raster Operations”, select the 
function “Cross” and specify as first raster map “pivots_MG” and as second raster map “ET_Minas_geo”. Specify 
as output cross table “saf_ET_pivots”. Now aggregate the daily evapotranspiration from the column 
“ET_MINAS_geo” into the “pivots_MG” table, call the column “avg_et_saf”. To do this select from the table menu 
“Column” and from the drop down list the function “Aggregation” and specify as output column “avg_et_saf”and 
as output table “pivots_MG”, press “OK” to execute the operation.  
 
Open the table “pivots_MG” and inspect the two newly added columns. Type the following expression on the table 
command line:  

difference:=avg_sebs-avg_et_saf 
Keep all other options default and press “OK” to execute the operation. Check your results obtained. 

4.8. Conclusions 

The SEBS model was used to estimate the daily evapotranspiration for the 2nd of May 2010. The results show an ET 
ranging from 2.063 to 4.321 mm/day in the Minas Gerais State using a single instantaneous solar downward 
radiation value and an ET ranging from 2.633 to 4.560 mm/day using the LSA SAF DSSF product (using 0.5 % 
cutoff interval). More detailed statistics, like mean, standard deviation and median reveal that the overall results look 
quite comparable despite the fact that the last ET estimation is slightly higher as a single time step noon image (local 
time) was used. The daily aggregated ET LSA SAF product gives ET values in the range of 0.01 to 4.21 mm/day, 
showing a larger difference between the SEBS ET estimation (both runs) and the one obtained from the LSA SAF.  
Considering that for the SEBS model runs a lot of local climatological - meteorological in situ input data was used, 
we consider that ET estimated using SEBS are more realistic compared to those from the ET LSA SAF and that the 
last one is slightly underestimating the ET. Further validation is required using local in situ ET observations. It is 
important to consider that a number of input layers used in the SEBS model are actually derived from other LSA 

SAF products, also used in the computation of the ET LSA SAF product. 
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APPENDIX 1 

Table with “in-situ” data of meteorological ground stations for Minas Gerais. 
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5. ASSESSING VEGETATION COVERAGE AT THE SAO 
PAULO STATE SCALE: “A TOOL FOR AIDING THE 
DECISION MAKING PROCESS” 

 
By: Fabio Enrique Torresan1 
 

5.1. Relevance and importance of the application 

The availability of reliable information of the agricultural production data is increasingly a fundamental demand in 
the decision making process, both for national and international scenarios (Pino, 1999; Epiphanio et al., 2002; 
Dronin & Bellinger, 2005; Epiphanio, 2007; Castillejo-González et al., 2009). 
The operational methodology currently applied to perform agricultural forecasting in Brazil is done through 
extensive, prolonged, expensive and subjective surveys based on the opinion of technical agents involved in the 
agricultural segment (Instituto Brasileiro de Geografia e Estatística, 2002) and therefore the analysis is biased, due to 

the errors and uncertainties involved and renders this methodology less practical.  
Therefore, an increasing demand is observed for agricultural forecasts derived from remote sensing data, which allow 
faster results, with higher accuracy and lower costs than the traditional techniques (Food and Agriculture 
Organization of the United Nations, 1998; Prasad, 2006). 
In the same way, there is also a great gap with respect to information about the degree of conservation of the 
remaining natural vegetation coverage. Global demand for agricultural products is now a major driver of cropland 
and pasture expansion across much of the developing world. Whether these new agricultural lands replace forests, 
degraded forests or grasslands greatly influences the environment. While the general pattern is known, there is still 
no definitive quantification of these land cover changes (Gibbs, 2010). 
Conservation of biodiversity within managed landscapes calls for a strategy that includes increasing the conservation 
value of the agricultural matrix both in terms of providing viable habitat for forest-dependent species, as well as 
increasing connectivity between protected areas and forest fragments (DeClerck et all, 2010). 
The identification, mapping and monitoring of the land use changes is an important tool to support decision making, 
both for public managers and for agribusiness investors. At the same time, recovery and utilization of degraded areas 
and restoration of native vegetation could prevent the advance of deforestation in areas of agricultural expansion. 
In this context, the Vegetation instrument on board the SPOT satellite deliver measurements specifically tailored to 
monitor land surface properties with a frequency of about once a day on a global basis and at a spatial resolution of 
one kilometer (in fact 5 times over 6 days at the equator, once a day at 30° latitude, and twice a day at latitudes higher 
than 60°). These characteristics allow monitoring large extents of land in a continuous way. 

 

                                                      
1 Embrapa Satellite Monitoring, Av. Soldado Passarinho, 303 - Fazenda Chapadão CEP 13070-115 - Campinas, SP, Brasil                    

(www.cnpm.embrapa.br), email torresan@cnpm.embrapa.br 
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5.2. Objective of the application 

The main objective for this application is to assess the vegetation coverage at the municipalities from the Sao Paulo 
State (Brazil) using data from a temporal set of S10 NDVI images, acquired by SPOT Vegetation instrument, which 
are available from the DevCoCast project. After the validation of this methodological approach in a near future, it 
would be useful to implement a monitoring system using the vegetation cover and make it available to decision 
makers and for the society. 

5.3. Methodology and study area 

5.3.1. Methodology adopted  

A flow chart of the followed methodology is presented in figure 5.1 below. 

Figure 5.1 Flowchart of the adopted methodology 
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5.3.2. Study Area 

The study area covers the São Paulo State, Brazil, consisting of 645 municipalities, see also figure 5.2. 

Figure 5.2 Sao Paulo State with the municipal boundaries and its location in Brazil 

5.4. Data pre-processing 

For this application, a temporal data set is used of S10 NDVI images. The 10-day SPOT Vegetation S10 synthesis 
products are a combination of daily atmospherically corrected data of all VEGETATION segments (measurements) 
of the given decade (10-day period) into a single image using the Maximum Value Composite (MVC) algorithm, 
which selects the pixels with the best ground reflectance values (Bartholomé, 2006). Here a temporal data set is used 
from the years 2008 and 2009. Not all time steps need to be pre-processed, as example of the necessary pre-
processing required, the month of December 2009 is used. 

5.4.1.  Importing the S10 NDVI images 

A temporal series of S10 NDVI images derived from the SPOT Vegetation Instrument, for the years 2008 and 2009, 
available within the GEONETCast data stream should be imported into the Integrated Land and Water Information 
System (ILWIS), using the GEONETCast Toolbox (see figure 5.3). Ensure that you have unzipped the exercise data, 
open ILWIS and move using the ILWIS navigator to this active working directory. You will note that there is a sub 
directory “gnc_data”. The directory is containing the raw data from GEONETCast-DevCoCast. Once close ILWIS 
and Open ILWIS again to ensure that the directory settings are correct.  
Ensure that the GEONETCast toolbox plug-in is installed, open from the main ILWIS menu the option 
“Operations => Geonetcast” => “toolbox”, now select the option “Configuration” => Folders”. Specify the folder 
settings for “SPOT VGT4 Latin America”, set the appropriate input and output folders, note that the input folder is 
your active working directory and add here the sub-directory “\gcn_data”. 
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From the ILWIS Main Menu, import the NDVI images for the 3 decades of December for the year 2009, select 
from the ILWIS menu: “Operations => Geonetcast => Toolbox => SPOT VGT Products => SPOT VGT Latin 
America => NDVI”. Use as “Date” stamps: “20091201”, “20091211” and “20091221” respectively. 

 

Figure 5.3 Importing S10 NDVI images using the Geonetcast Toolbox plug-in 
 
Open the imported maps “ndvi20091201”, “ndvi20091211” and “ndvi20091221”, use as Representation “NDVI1”, 
browse with the left mouse cursor pressed over the map and inspect the values. Note that also a status map, (*_SM) 
is created. This status map is going to be applied to select only those pixels that meet the following criteria: cloud 
free, land pixel and having good radiometry in the red and near infra red channels. For further explanation on the 
procedure, see also Maathuis et al (2011). Type the following map calculation formula on the command line in the 
main ILWIS menu: 

Status_ok:=iff((((ndvi20091201_SM div 1)mod 2)+(( ndvi20091201_SM div 2)mod 2)=0) and 
(((ndvi20091201_SM div 8)mod 2)+((ndvi20091201_SM div 32)mod 2)+((ndvi20091201_SM div 64)mod 
2)=3),1,0) 

Leave all other options as default and execute the operation. Inspect the resulting map and now apply the mask, 

showing the pixels meeting the selection criteria, to the NDVI map by entering the following map calculation 
statement on the command line in the main ILWIS menu: 

ndvi_ok20091201:=iff(Status_ok=1,ndvi20091201,?) 
Again use all other settings as default and execute the operation, check the results, use as Representation “NDVI1”. 
Repeat this procedure for the other two decades as well. Use the command line history from the main ILWIS menu 
and change the date string portions! 

5.4.2. Creating a Map List for the imported NDVI images 

Create one map list for each month, with the three decades from its corresponding month (see figure 5.4). From the 
ILWIS Main Menu select “File => Create => Map List” and make for the month of December 2009 a map list 
consisting of the 3 corrected decadal maps “ndvi_ok200912*”. Specify as output map list name “122009” 
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Figure 5.4 Example Map List created with the three decades from December 2009 

5.4.3.  Extracting the Monthly Maximum Value Composition 

From the map list created, the three NDVI images will be merged into another raster map, resulting in the maximum 
NDVI value for each month. Right click with the mouse the map list “122009”, from the context sensitive menu 
select “Statistics => Maplist Statistics”, as Statistic Function select “Maximum”, specify as output map “max200912” 
and press “Show” to execute the operation. To display the map use as Representation “NDVI1” and press “OK”. 
Now add the polygon file “spnovo”, select from the active map window the options “Layers => Add Layer” and 

select “spnovo”. From the menu “Display Options – Polygon Map”, unselect the option “Info” and activate the 
option “Boundaries Only”. The polygon boundaries are now draped over the raster NDVI map, use the “Zoom-in” 
option from the active map window and select the area of interest. Next, from the active map window, select the 
option “File => Open Pixel Information” and move the mouse cursor over the map to see the corresponding table 
attributes. Your results should resemble those of figure 5.5. 

 

 
  
 
 
 

Figure 5.5 Monthly NDVI maximum value composite with Sao Paulo State political vector map 
 
In order to calculate the operations only for the study area it is necessary to create a “Sub map”. To create a sub map 
it is necessary to select using the right mouse button the “max200912” map and choose from the context sensitive 
menu the “Spatial Reference Operations => Sub Map” options. The details to select only the Sao Paulo State are 
provided in figure 5.6 and press “Show” to execute the operation and display the sub map using the Representation 
“NDVI1”. 
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Figure 5.6 Sub map settings to select the Sao Paulo State region 
 
Most of the analysis in ILWIS is based on raster data. Therefore, conversion from vector to raster format (rasterize) 
is often a necessary step preceding the analysis. Right-click with the mouse the polygon file “spnovo”, from the 
context sensitive menu select the option “Polygon to Raster”, as Georeference select “submax2008_1” and type for 
the Output Raster Map: “municipios”, press “Show” to execute the operation. Press “OK” to display the map using 
the default settings. Close the map and right-click with the mouse the newly created raster map “municipios”, select 
“Properties” and note that the Attribute Table “spnovo” is attached to this map. Double click with the left mouse 
button the table “spnovo” to display it and inspect the content. Its content is identical to the record that is displayed 
when using Pixel Information (see also figure 5.5). 

5.5. Data analysis 

In order to conduct the full pre-processing chain, as indicated in chapter 5.4, for the whole time series requires a lot 

of time. Therefore a full pre-processed sub set of NDVI data of the Sao Paulo region has been prepared. The 
methodology used to create this time series is identical as described above. The time series NDVI maximum value 
composites are provided in the map list “submax2008_2009”. Double click with the mouse the map list name, use 
the option “Open as Slide Show”, select as Representation “NDVI1” and press “OK” twice to see then animated 
sequence of this time series. After the content is inspected close the visualization. 

5.5.1. Statistical analysis on the NDVI values for each municipality 

An important tool for data analysis in ILWIS is the Cross operation, which calculates the frequency of occurrence of 

all possible combinations of two maps. The Cross operation performs an overlay of two raster maps by comparing 
pixels at the same positions in both maps and keeping track of all the combinations that occur between the values or 
classes in both maps. The input maps used in a Cross operation should be raster maps that have the same 
georeference. During the Cross operation, combinations of class names, identifiers or values of pixels in both maps 
are listed, the number of pixels occurring as this combination is counted, and the areas of the combinations are 
calculated. The results are stored in an output cross table and optionally an output cross-map can be created. The 
output cross-table and the output cross-map obtain an ID domain with the same name as the output cross-table. The 
domain contains items, which are combinations of the class names, IDs, group names or values of the first input 
map and those of the second input map. 
You are going to cross a raster map with an identifier domain called “municipios” (created before, containing the 
municipal areas of the State of Sao Paulo) and the NDVI maximum monthly value map for each month of the years 
2008 and 2009. The result is a large cross-table which contains the combinations of the municipality names - codes 
and the number of pixels with a certain NDVI value. 
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Open from the main ILWIS menu the option “Operations => Raster Operations => Cross”. Select the raster map 
with the maximum monthly NDVI values for the 1st month of 2008, here called “submax2008_1” as 1st Map. Select 
raster map “municipios” as 2nd Map. Type “avg_01_2008” as Output Table and press “Show”. From the menu of 

the newly created table, select the option “Columns => Aggregation”. The Aggregate Column dialog box is opened 
and now select the Column: “submax2008_1”, as Function “Average” Group by “municipios”, as Output Table 
specify “spnovo” and type for the Output Column “avg2008_1”. Click “OK” in the Aggregate Column dialog box, 
see also figure 5.7. 

Figure 5.7 Column aggregation and adding resulting column to external table 
 
Open the cross table and open the table “spnovo”. Inspect the newly created column “avg2008_1”. This procedure 
should be repeated for all maps in the time series. If you do not want to do this another 23 times, open the table 
“spnovo_ndvi” and inspect the content of this table.     

5.5.2. Estimating vegetation cover 

For this step, the methodology proposed by Gao et al. (2006) is adopted, which uses vegetation cover (VC) to 
calculate the rate of degradation and the result can be applied to establish a system for assessment and monitoring of 
the environment using remote sensing. In this application, the following expression will be used to estimate the 
vegetation coverage (VC): 

 

           (Eq 1) 

 
Where: 

VC  the vegetation coverage 
NDVIS the average of the minimal NDVI value of the study area (here 0.192) 
NDVIV the average NDVI value of pure vegetation or the average of the maximum NDVI value in the 

study area (here 0.671) 
 
Note that NDVIS and NDVIV values specified above can be obtained from the table (e.g. the table “spnovo”, using 
the aggregated minimum and maximum statistical values of the 24 “avgyear_month” columns). Select from the main 
ILWIS menu the option “Operations => Raster Operations => MapList Calculation”, see also figure 5.8. Select the 
NDVI time series map list “submax2008_2009” as input MapList and as Output MapList specify “vc2008_2009”. 
Here only “1” Input MapList is used.  In the expression field, type the following expression: 

((@1-0.192)/0.671)*100 
and press “Show” to execute the operation. Now 24 new maps are calculated, representing the vegetation coverage 
for each month. After the calculation is finished open the newly created maplist “vc2008_2009”, double click one of 
the map layers and display the map using a Representation “vgcover”. See a resulting example of January 2008 with 
the municipality boundaries in figure 5.9. Close the map and now display it as an animated sequence, using the same 
Representation. Close the animation when finished. 
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Figure 5.8 MapList Calculation 

 

Figure 5.9 Vegetation coverage for January 2008 
 
Now the monthly average vegetation cover maps have to be crossed with the municipality raster map. Repeat the 

same procedure as described in chapter 5.5.1 but now cross the vegetation cover maps for each month with the 
raster municipality map. This will result in 24 new columns in the table “spnovo”, use as column prefix name “vc_”. 
If you don’t want to repeat the procedure 24 times, open the table “spnovo_ndvi_vc” and inspect the content. 

5.5.3. Municipal Vegetation Cover maps 

Having calculated the average vegetation cover per municipality in the table, this information is now going to be 
spatially represented. First select, by right clicking the mouse over the raster map “municipios” the Properties Dialog 
Box. Ensure that from here the Attribute Table “spnovo_ndvi_vc” is selected and press “Apply” and “OK”. Again, 
right click with the mouse, the map “municipios” and select “Raster Operations => Attribute Map”, as Attribute 
select the column “vc012008” and as Output Raster Map specify “muni_vc012008”, press “Show” to execute the 
operation and display the resulting map using a Representation “vgcover”. The result is also given in figure 5.10.  
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Figure 5.10 Vegetation cover aggregated per municipality, Sao Paulo State, January 2008 
 
Check the command line string from the main ILWIS menu, use the drop down icon on the right hand corner of the 
command line. The expression generated to execute the operation can be adapted and a new map can be calculated. 
The string that was used to calculate the attribute map is: 

muni_vc012008.mpr{dom=value;vr=4.28:94.79:0.01} = MapAttribute(municipios,vc012008) 
To calculate a new map the output map name needs to be changed and the attribute column. Open once more the 
table and note that the attribute column for the vegetation cover of February 2008 is called “vc_fev2008”. Now 
change the expression given in the command line history following: 

muni_vc022008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_fev2008) 
Press enter (from the active command line) to execute this operation and “OK”. Keep on changing the input 
attribute column and output map name to obtain a time series of 24 VC municipality aggregated maps. All command 
line expressions are also presented in appendix 1. 
When all 24 muni_vc* maps are created, open from the ILWIS main menu the options “File => Create => 
MapList”, specify as MapList name “muni_vc”, select all 24 muni_vc* maps and use the “>” icon to transfer them to 
the right hand map listing, press “OK”. Display the newly created maplist as an animated sequence, using as 
Representation “vgcover”, and press “OK” twice. In the active map window, select the option “Layers =>Add 
Layer”, add the polygon file “spnovo”, from the menu “Display Options – Polygon Map”, unselect the option 
“Info” and activate the option “Boundaries Only”. 
Once more open the maplist “muni_vc” and display the map “muni_vc012008”. Add to this map the vector layer 

showing the municipalities and use the option boundaries only for display of this vector layer. Now from the main 
ILWIS menu, select “Operations => Statistics => MapList => MapList Graph” In the maplist graph window, select 
as MapList “muni_vc”, use a fix stretch of 0 to 100, activate the options “Continuous” and “Always on top”. 
Activate the map window showing the previously opened map layer “muni_vc012008”. Browse with the mouse 
cursor over the map. Note the aggregated vegetation cover time series values in the graph window, see also figure 
5.11. You can also change the maplist, e.g. use submax2008_2009 to see the maximum monthly NDVI values. Note 
that you have to change the fix stretch from 0 to 1! 
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Figure 5.11 Aggregated Vegetation Cover and time series graph of a pixel 

5.6. Conclusions 

This methodology needs to be validated with in-situ data. The thresholds of the NDVI values used to calculate the 
vegetation cover (NDVIS and NDVIV) may be changed depending on the length of the time series available and also 
on the area of interest. 
This methodology can be adapted to different objectives, like crop and biomass monitoring and for biodiversity 
monitoring and environmental management of protected areas. In this case, other geographical limits of analysis 
need to be adopted, like the extents of a certain land use regions, the boundaries of watersheds or of parks and 
protected areas. 
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APPENDIX 1 

Listing op map calculation statements to compute the aggregated VC per municipality.  
 
Type the expressions below on the command line in the main ILWIS menu to calculate the vegetation cover (VC) 
for each month of the year 2008 and 2009. 
 

muni_vc012008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc012008) 
muni_vc022008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_fev2008) 
muni_vc032008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_mar2008) 
muni_vc042008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_abr2008) 
muni_vc052008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_mai2008) 
muni_vc062008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_jun2008) 
muni_vc072008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_jul2008) 
muni_vc082008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_ago2008) 
muni_vc092008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_set2008) 
muni_vc102008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_out2008) 
muni_vc112008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_nov2008) 
muni_vc122008.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_dez2008) 
muni_vc012009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_jan2009) 
muni_vc022009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_fev2009) 
muni_vc032009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_mar2009) 
muni_vc042009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_abr2009) 
muni_vc052009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_mai2009) 
muni_vc062009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_jun2009) 

muni_vc072009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_jul2009) 
muni_vc082009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_ago2009) 
muni_vc092009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_set2009) 
muni_vc102009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_out2009) 
muni_vc112009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_nov2009) 
muni_vc122009.mpr{dom=value;vr=0.00:100.00:0.01}:=MapAttribute(municipios,vc_dez2009) 
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6. A GIS APPROACH USING REMOTE SENSING 
DERIVED PRODUCTS FOR QUANTIFICATION OF 
SUGAR CANE PRODUCTIVITY IN BRAZIL 

 

By: Diego Rocha1, Humberto Barbosa1 & Leandro da Silva1  

 

This application uses GEONETCast products to test a satellite remote sensing approach to improve sugar cane 
estimates over the Coruripe municipality located in Alagoas, Brazil. The test is performed for the period April to 
August, 2010. The quantification results presented here show the values of sugar cane production are in the mean 

range of 27 to 66 Ton ha-1 at the level of the municipality during the period of test. Results are very encouraging, 
though a high spatial variability of crop yield is found. This suggests that adjustments are needed to transform the 
original satellite product-based scheme into satellite derived agro-meteorological parameters. Further studies are 
needed to better understand these results, which depend on the resolution of the input background fields, their 
physical content and several other factors. This application represents a first step towards operational use of GIS 
based quantification of sugar cane productivity in Brazil using GEONETCast delivered products. 

6.1.  Relevance of the application 

6.1.1. The gap between science and practical agricultural management 

Current management practices in Brazil in the field of agricultural management are very often still based on outdated 

knowledge and technology. Similarly to what happens in many other regions of the world, frequently scientists plan 
and develop their methods in isolation, not grasping what is really required by relevant stakeholders. On the other 
hand, stakeholders are often unaware of what science or knowledge-based alternatives are available. Scientific 
research is further isolated by lack of proven utility and inadequate representation of results, whilst agricultural policy 
and management is isolated by legal and professional precedence. 

6.1.2.  Making crop modeling useful for decision-making: what output is needed, and what input data are 
required to achieve the modelling goals 

In the scientific community frequently model performance is evaluated using procedures and statistical indicators 
which do not necessarily reflect the usefulness for practical decision-making in the region of interest. Improved 
awareness of stakeholders’ real needs can help scientists to better orient their work. On the other hand, typical 
current performance rates of crop modelling applications in the region may not be sufficient for practical decision-
making. Low model performance is often a consequence of limited input data sets on which the model application is 
based. However, over the past decades an increasing amount of potentially useful products derived from remote 
sensing have become available, but their potential for improving model performance in the region has not been well 
assessed yet.  
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6.1.3. Agro-meteorological parameters from satellite remote sensing products and GIS approach 

Remote sensing images play an important role in agricultural crop production over large area, quantitatively and non-
destructively, because agricultural crops are often difficult to access, and the cost of ground based estimation of 
productivity can be high. The recent development of GEONETCast–EUMETCast data has provided the capability 
to obtain frequent and accurate measurements of a number of basic agro-meteorological parameters (e.g. 
evapotranspiration, surface albedo, surface temperature, solar radiation, rainfall etc.). The GEONETCast real-time 
data dissemination system represents a global network of communication satellite based data dissemination system to 
distribute space-based, air-borne and in situ data, metadata and products to diverse user communities. The satellite 
estimated agro-meteorological parameters provide a complete and spatially dense observations capability for 
assessing regional vegetation potential productivity (Barbosa et al., 2006; Barbosa et al., 2009). With a Geographic 

Information System (GIS) approach, it provides a framework to ingest in the analysis the information of agro-
meteorological parameters that influence crop yield. 

6.1.4. Sugar cane crops in Brazil 

Agricultural production in the semi-arid region of Brazil is characterized by extensive, low investment subsistence 
farming focused on limiting the impacts of hydrological and policy risks. As a consequence, agricultural, labor and 
natural resource productivity has remained low, however at high environmental costs, especially with respect to land 
degradation and loss of natural resources and biodiversity. Agriculture is the primary social and productive economic 
sector in the semi-arid Latin American countries and forms the basis for rural welfare and food security, and the 
platform for structural change and economic take off towards sustainable socio-economic development and growth. 
Sugar cane is one of the most important cash crops in Brazil. It is an annual crop with solid jointed stems and its 
mode of photosynthesis is very efficient and growth is quick. Brazil is the biggest grower of sugarcane, which is used 
to produce sugar and ethanol gasoline-ethanol blends gasohol for transportation fuel. Its bio fuel industry is a leader, 

a policy model for other countries, and sugarcane ethanol is considered the most successful alternative fuel to date. 

6.2. Objectives of the application 

6.2.1. General objective 

The general objective of this application is to increase the role of crop modelling applications for estimating sugar 
cane productivity in Brazil by incorporating satellite remote sensing products to evaluate estimation of productivity 
of sugar cane crops. A number of tailored and GIS-compatible products are generated and integrated to quantify 
sugar cane productivity. 

6.2.2.  Specific objective 

For this application products that are disseminated through GEONETCast (NDVI S–10, SPOT Vegetation DMP 
and ETp) are used to develop a remote sensing based approach to improve sugar cane productivity estimation for 
the municipality of Coruripe, located in Alagoas, Brazil. The study is conducted for the period of April to August, 
2010. The sugar cane productivity is derived in 9 computational steps.  

6.3. Data used 

6.3.1. Local/Regional (in-situ) data 

The application focuses on the sugar cane plantation for the entire Coruripe municipality, located in Alagoas State, 
Brazil. The sugarcane parameters used are:  

 BF = Respiration Factor (0.5 for temperatures ≥ 20°C and 0.6 for temperatures <20°C), after Gouvêa 
(2008);  

 APF = Agricultural Productivity Factor (2.9), after Ruddorf (1985); 

 Ky= yield response factor, after Doorenbos et al (1979); 
 Kc= Crop coefficient. 
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The crop coefficient is defined as the ratio of crop evapotranspiration (Etc) with respect to reference 
evapotranspiration (ET0). Kc is crop specific and is depending on the crop growth stage. Crop evapotranspiration at 
any time during the growing season is the product of reference evapotranspiration and the crop coefficient, 

expressed as: ETc = ET0 * Kc. Crop coefficients have been developed for nearly all crops by measuring crop water 
use with lysimeters and dividing the crop water use by reference evapotranspiration for each day during the growing 
season. 

6.3.2. Products used from GEONETCast 

The following data delivered through GEONETCast has been used for the period April to August, 2010: 
 Remote sensing images: SPOT Vegetation–2 and SPOT–5, SEVIRI instrument on METEOSAT–9; 
 Remote sensing based products:  

o NDVI S10 (NDVI) and Dry Matter Productivity (DMP) having a spatial resolution of 1Km.; 
o LSA–SAF ETp product for South America.  

Source of the data is the GEONETCast ground receiving station installed at the Laboratory of Analysis and 
Processing of Satellite Images (LAPIS), Federal University of Alagoas (UFAL) (see: http://www.lapismet.com) and 
the SPOT Vegetation products are obtained from the archive, maintained by VITO (see: http://free.vgt.vito.be/). 

6.4. Methodology 

This application proposes to test a remote sensing approach to quantify estimates of sugar cane productivity over the 
Coruripe municipality and sugar cane crop estimates are computed for each map pixel using NDVI, DMP and ETp 
images by applying radiative, aerodynamic and energy balance physics using 9 computational steps. The flow diagram 
of the methodology to quantify sugar cane productivity using these satellite derived products is shown in figure 6.1. 

 
Figure 6.1 Flow chart of the methodology adopted 
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6.5. Data pre-processing for quantification sugar cane productivity 

Ensure that you have unzipped the exercise data and move using the ILWIS navigator to this active working 
directory. Close ILWIS and open ILWIS again and ensure that the path to your active working directory is correct. In 
order to minimize the data load for this exercise all time series data (NDVI, with and without status mask, DMP, 
ETp_avg and ETp_std) have been pre-processed and sub maps for the Coruripe Municipality have been created. 
The pre-processing steps are described in the following section. 

6.5.1.  Step 1: Input NDVI and DMP databases using algorithm adapted from GEONETCast Toolbox 

To implement a methodology to import both the NDVI and DMP time series raster data into ILWIS, specific 
routines available within the GEONETCast–Toobox are adapted for import. Upon import also the status mask was 
applied, to retain only the map values that meet the flag criteria, such as cloud free, land pixels, good radiometric 
quality in the Red and NIR bands. For further details see also Chapter 4.5.1.2 as well as Maathuis et al, 2011. 
Open the MapList “NDVI_Coruripe_Apr_Aug” and display the time series as an animated map sequence, using as 
Representation “NDVI1”. Note that there are 15 maps and each map is representing the decadal NDVI computed 
using a Maximum Value Composite Algorithm. Map layer 1 represents the 1st decade of April 2010 and map layer 15 
is the last decade of August 2010. Move the mouse, keeping the right mouse button pressed, over the active map 
display window and note the values. From the menu of the active map display window, select the option “Layers => 
Add Layer” and select the Polygon Map “coruripe”, in the Display Options window unselect “Info” and select the 
option “Boundary Only” and press “OK” to see the municipal boundary.  Close the Active map window and now 
display the time series “NDVI_SM” in a similar manner. Here the status flags have been applied and those pixels 
that did not meet the flag criteria have been re-assigned as “no-data”, represented by a “?”. 

6.5.2. Step 2: Computation of FVC from NDVI 

The FVC is the one biophysical parameter that determines the contribution partitioning between bare soil and 
vegetation for surface evapotranspiration, photosynthesis, albedo, and other fluxes crucial to land–atmosphere 
interactions. The NDVI needs to be converted to FVC. Here use is made of the formula proposed by Muñoz et al 
(2005), see equation 1. The flag corrected NDVI time series is going to be used.  
 

  (Eq 1) 
 
To carry out this calculation for each NDVI map within the time series open from the main ILWIS menu the option 
“Operations => Raster Operations => MapList Calculation” and provide the information as given in figure 6.2. 

Figure 6.2 Calculation the FVC time series from NDVI 
Press “Show” to execute the operation, display the resulting time series as an animated sequence, use as 
Representation “fvc” and check the values obtained using the mouse, keeping the right mouse button pressed, over 
the active map display window. 
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6.5.3. Step 3: Computation of LAI from FVC 

The LAI, defined, as the total one-sided leaf area per unit ground area, is one of the most important parameters 
characterizing a canopy. Because LAI most directly quantifies the plant canopy structure, it is highly related to a 
variety of canopy processes, such as evapotranspiration, interception, photosynthesis and respiration. The FVC is 
converted to Leaf Area Index (LAI) by means of the formula proposed by Norman et al (2003), see equation 2.  
        
      (Eq 2) 
 
To carry out this calculation for each FVC map within the time series open from the main ILWIS menu the option 
“Operations => Raster Operations => MapList Calculation” and provide the information as given in figure 6.3. 

Figure 6.5 LAI MapList calculation to obtain LAI  
 
Press “Show” to execute the operation, display the resulting time series as an animated sequence, use as 
Representation “lai” and check the values obtained using the mouse, keeping the right mouse button pressed, over 
the active map display window. Now also check the command line history from the main ILWIS menu by pressing 
the “drop down” button on the right hand side of the command line. Note the command line string that has been 
used to create the LAI time series. It is given by the following string: 

 
 LAI.mpl = maplistcalculate("-2*ln(1-@1)",0,14,FVC.mpl) 
 

Check the expression, compare it with figure 6.2. Note that in the following sections the command line expressions 
to calculate a maplist will be given. 

6.5.4. Step 4: Computation of growth factor from LAI 

Experimental evidence indicated that the growth rate of several agricultural crop species increases linearly with 
increasing amounts of LAI, when soil water nutrients are not limiting (Doorenbos and Kassam, 1979). Berka et al 
(2003) developed a simple approach for deriving the growth rate from the LAI, see equation 3.  
     

(Eq 3) 
 
Where: CGF = Corrected Growth Factor and LAI = Leaf Area Index. 
 
To derive the Corrected Growth Factor (CGF) type the following equation on the ILWIS command line: 
 
 CGF.mpl:=maplistcalculate("0.515-exp(-0.667-(0.515*@1))",0,14,LAI.mpl) 
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Press “Enter” to execute the operation, display the resulting CGF time series as an animated sequence, use as 
Representation “Pseudo” and check the values obtained using the mouse, keeping the right mouse button pressed, 
over the active map display window. 

6.5.5. Step 5: Computation of maximum yield potential (Yp) 

The final equation that can be used to derive maximum yield potential (Yp) is based on an equation which includes 
evaporative fraction corrected growth factor (CGF), respiration factor (BF), agricultural productivity factor (APF) 
and production of dry matter (DMP) product.  
 

 (Eq 4) 
 
Where Yp is the maximum yield potential (kg ha-1), BF is the respiration factor (0.5 for temp. ≥ 20°C and 0.6 for 
temp <20°C), APF is the agricultural productivity factor (2.9) as described in Rudorff (1985) and DMP is the Dry 
Matter Productivity derived from Spot-Vegetation data. First display using an animated sequence the time series 
“DMP_04_08_coruripe” using as Representation “Pseudo” and check the map values using the mouse, keeping the 
right mouse button pressed, over the active map display window. Further information on this product can be found 
in Bartholomé (2006), the unit is kg/dry matter/ha/day. After you have seen the animated sequence, close the 
animation. 
To calculate the maximum yield potential for each time step, type the following expression on the command line in 
the main ILWIS menu:  
 
 Yp.mpl:=maplistcalculate("@1*0.5*10*2.9*@2",0,14,CGF.mpl,DMP_04_08_Coruripe.mpl) 
 
Press “Enter” to execute the operation, display the resulting CGF time series as an animated sequence, use as 
Representation “Pseudo” and check the values obtained using the mouse, keeping the right mouse button pressed, 

over the active map display window. Note that the factor 10 in the expression above is used to convert from kg/dry 
matter/ha/day to kg/dry matter/ha/decade!  

6.5.6. Step 6: Retrieval of evapotranspiration (ETp) via LSA –SAF ETp product  

The crop coefficient is defined as the ratio of crop evapotranspiration, ETr, to reference evapotranspiration, ETp. Kc 
is crop specific depending on the crop growth stage and details are given in table 6.1. Crop evapotranspiration at any 
time during the growing season is the product of reference evapotranspiration and the crop coefficient as given by 
equation 5. 
  

            (Eq 5) 
 
Crop coefficients have been developed for nearly all crops by measuring crop water use with lysimeters and dividing 
the crop water use by reference evapotranspiration for each day during the growing season of 2009/2010 (after 
Toledo Filho, 1988). 
 

Crop species in Alagoas 

Days 

Crop Growth Crop coefficients (Kc) 

CANE PLANT      CANE SOCA   
0 – 60                          0 – 60 10% of development 0,25 

60 – 300                     60 – 300 Greenup 1,65 

300 – 450                 300 – 360 Senescent / Harvest 1,18 

Table 6.1 Kc for various crop growth stages. 
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By use of the newly developed LSA–SAF products, one is now able to obtain frequent and accurate measurements 
of a number of basic agro-meteorological parameters (e.g. surface albedo, surface temperature, evapotranspiration). 
The satellite estimated agro-meteorological parameters have several advantages compared to conventional 

measurements of agrometeorological data using a scattered ground meteorological observation network.  
Open the map list “ETp_avg” and display the time series as an animated sequence, using as Representation 
“Pseudo”. This maplist has been compiled processing each 30 minutes LSA_SAF ET-product from 1 April to 31 
August 2010. All products have been added on a daily basis, corrected for the time interval, as the product unit is 
expressed in mm/hr, but the time step is half hourly (therefore the daily sum has been divided by 2). For each decade 
the respective daily products have been summed and the average was computed to obtain the average ET per decade. 
Also the standard deviation has been computed and was aggregated to obtain the decadal standard deviation. This 
map list is called “ET_std. Display also this map list using as Representation “Pseudo”.  
To obtain the crop evapotranspiration the following procedure has been adopted using the time series ETp_avg and 
ET_std data: 
 
For the months of April, May and June a crop coefficient was used of 1.68: 
 
    ETr = (ETp_avg – ET_std) * 1.68   (Eq. 6) 
 

For the months of July and August a crop coefficient was used of 1.18: 
 

ETr = (ETp_avg – ET_std) * 1.18   (Eq. 7) 
 
Type the following equations in the command line of the main ILWIS menu and press enter and “OK” to execute 
the operations: 
 
 ETr1:=(etp_avg_0401_coruripe- et_0401_stddeviation_coruripe)*1.68 

ETr2:=(etp_avg_0402_coruripe- et_0402_stddeviation_coruripe)*1.68 
ETr3:=(etp_avg_0403_coruripe- et_0403_stddeviation_coruripe)*1.68 
ETr4:=(etp_avg_0501_coruripe- et_0501_stddeviation_coruripe)*1.68 
ETr5:=(etp_avg_0502_coruripe- et_0502_stddeviation_coruripe)*1.68 
ETr6:=(etp_avg_0503_coruripe- et_0503_stddeviation_coruripe)*1.68 
ETr7:=(etp_avg_0601_coruripe- et_0601_stddeviation_coruripe)*1.68 
ETr8:=(etp_avg_0602_coruripe- et_0602_stddeviation_coruripe)*1.68 
ETr9:=(etp_avg_0603_coruripe- et_0603_stddeviation_coruripe)*1.68 
 
ETr10:=(etp_avg_0701_coruripe- et_0701_stddeviation_coruripe)*1.18 
ETr11:=(etp_avg_0702_coruripe- et_0702_stddeviation_coruripe)*1.18 
ETr12:=(etp_avg_0703_coruripe- et_0703_stddeviation_coruripe)*1.18 
ETr13:=(etp_avg_0801_coruripe- et_0801_stddeviation_coruripe)*1.18 

ETr14:=(etp_avg_0802_coruripe- et_0802_stddeviation_coruripe)*1.18 
ETr15:=(etp_avg_0803_coruripe- et_0803_stddeviation_coruripe)*1.18 

 
After all calculations are performed a new map list has to be created. From the main ILWIS menu, select “File => 
Create => MapList” and add all newly created ETr* maps in a sequential order to the right hand listing, using the 
“>” icon. Specify as Map List name “ETr” and press “OK”. Display the newly created map list “ETr” as an 
animated sequence, using as Representation “Pseudo”, check the map values obtained. 
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6.5.7. Step 7: Estimation of sugar cane productivity  

The sugarcane yield estimation model over the growing season, on a decadal basis, is accomplished by using an 
agrometeorological model (Equation 8) according to Doorenbos and Kassam (1979):  

    
       (Eq 8) 

 
where Ye is the estimated yield (kg ha-1), Yp the maximum yield (kg ha-1), ky the yield response factor described in 
(Doorenbos and Kassam, 1979); ETr the actual evapotranspiration (mm) and ETp the maximum evapotranspiration 
(mm). Maximum yield (Yp) is established by the genetic characteristics of the crop and by the degree of crop 
adaptation to the environment (Doorenbos and Kassam, 1979). The ky factors used here are for April = 1.2, for May 
= 1.3, for June = 1.2, for July = 1.1 and for August = 1.1. To calculate the estimated yield the following equations 
have to be entered from the command line on the main ILWIS menu: 
 
 Ye1:=Yp_1*(1-1.2*(1-(ETr1/etp_avg_0401_coruripe))) 
 
In the Raster Map Definition window, set the minimum value range to “0” and the “Precision” to “0.01” and press 
“OK” to execute the operation. Display the map calculated and check the values obtained. Note that each pixel 
represents and area of 1 km2 and the estimated yield is expressed in kg ha-1! Repeat the Ye calculations for the other 
decades using the following set of equations (note the change of the Yp) and keep on setting the minimum map 
value to “0” and use as Precision “0.01”: 
 
 Ye2:=Yp_2*(1-1.2*(1-(ETr2/etp_avg_0402_coruripe))) 
 Ye3:=Yp_3*(1-1.2*(1-(ETr3/etp_avg_0403_coruripe))) 

Ye4:=Yp_4*(1-1.3*(1-(ETr4/etp_avg_0501_coruripe))) 
Ye5:=Yp_5*(1-1.3*(1-(ETr5/etp_avg_0502_coruripe))) 
Ye6:=Yp_6*(1-1.3*(1-(ETr6/etp_avg_0503_coruripe))) 
Ye7:=Yp_7*(1-1.2*(1-(ETr7/etp_avg_0601_coruripe))) 
Ye8:=Yp_8*(1-1.2*(1-(ETr8/etp_avg_0602_coruripe))) 
Ye9:=Yp_9*(1-1.2*(1-(ETr9/etp_avg_0603_coruripe))) 
Ye10:=Yp_10*(1-1.1*(1-(ETr10/etp_avg_0701_coruripe))) 
Ye11:=Yp_11*(1-1.1*(1-(ETr11/etp_avg_0702_coruripe))) 
Ye12:=Yp_12*(1-1.1*(1-(ETr12/etp_avg_0703_coruripe))) 

Ye13:=Yp_13*(1-1.1*(1-(ETr13/etp_avg_0801_coruripe))) 
Ye14:=Yp_14*(1-1.1*(1-(ETr14/etp_avg_0802_coruripe))) 
Ye15:=Yp_15*(1-1.1*(1-(ETr15/etp_avg_0803_coruripe))) 
 

After all calculations are performed a new map list has to be created. From the main ILWIS menu, select “File => 
Create => MapList” and add all newly created Ye* maps in a sequential order to the right hand listing, using the “>” 
icon. Specify as Map List name “Ye” and press “OK”. Display the newly created map list “Ye” as an animated 
sequence, using as Representation “Pseudo”, check the map values obtained. Close all active map windows. 

6.5.8. Step 8: Local mask of estimated yield 

The resulting map list of the estimated yield (Ye) should be clipped to the mask of the Coruripe municipality 
boundaries in the State of Alagoas, Brazil. Right click with the mouse button on the polygon map “coruripe” and 
from the context sensitive menu, select the option ”Polygon to Raster”, as GeoReference select 

“CFG_Coruripe_Apr_Aug_1”, leave the Output Raster Map name as indicated by default and press “Show”. 
Display the map and note the content. Close the map, right click with the mouse on the RasterMap “coruripe” and 
from the context sensitive menu, select the option “Properties”. Note that the domain here is specified as Identifier 
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“coruripe” and although when looking at the map content the “1” which was indicated is representing an identifier 
number but not a value. In order to use this map in a calculation we have to change it to a value. Type the following 
expression in the command line of the main ILWIS menu: 

 
mask:=iff(coruripe="1",1,0)  

 
Note that from the Raster Map Definition window the domain given is now a “value” domain. Press “OK” to 
execute the operation. Display the map “Mask” and note the content. Now we can use the mask to extract the “Ye” 
for the Coruripe Municipality. Type the following expression on the command line in the main ILWIS menu: 
 
 Ye_Coruripe.mpl:=maplistcalculate("iff(mask=1,@1,?)",0,14,Ye.mpl) 
 
Press “Enter” to execute the operation, display the resulting “Ye_Coruripe” time series as an animated sequence, use 
as Representation “Pseudo” and check the values obtained using the mouse, keeping the right mouse button pressed, 
over the active map display window. 

6.5.9. Step 9: Total Yield Productivity using a sugar cane crop mask 

The time series “Ye_Coruripe” corresponds to the estimated sugar cane yield on a decadal basis. To estimate Total 
Yield Productivity for whole time series, each decadal period from the Map List Ye_Coruripe should be 
accumulated. Enter the following expression on the command line to obtain the sum of the time series and press 
enter to execute the operation: 
 

Ye_sum:=MapMaplistStatistics(Ye_Coruripe.mpl, Sum, 0, 14) 
 
Finally to estimate total yield productivity the average amount of water (76 %) withtout stress is added to the sugar 
cane and the initial weight of the sugar cane stems during planting has to be added as well (here a value is used of 15 

ton/ha). Enter the following expression on the command line to obtain the Total Yield Productivity and press enter 
to execute the operation: 
 

Ye_total:=Ye_sum*1.76+15000 
 

Right click with the mouse button on the polygon map “sugarcane_mask” and from the context sensitive menu, 
select the option ”Polygon to Raster”, as GeoReference select “CFG_Coruripe_Apr_Aug_1”, leave the Output 
Raster Map name as indicated by default and press “Show”. Display the map and note the content.  
Open from the main ILWIS menu the option “Operations => Raster Operations => Cross”. Select the raster map 
with the total yield productivity, here called “Ye_total” as 1st Map. Select raster map “sugarcane_mask” as 2nd Map. 
Type “yield_mask” as Output Table and press “Show”. Note the content of the cross table. The figure below shows 
the final results of the analysis, using the boundaries of the municipality and the sugar cane mask as overly on the 
Ye_total map. 
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Figure 6.9 Ye-total for the Cururipe area and cross results using a sugar cane mask. 

6.6. Summary and Conclusions 

For this exercise GEONETCast– EUMETCast data (NDVI S-10, DMP SPOT and ETo) is applied to test a remote 
sensing approach to improve sugar cane Total Yield Productivity over the Municipality of Coruripe. The test is 
performed for the period April to August, 2010 and the sugar cane productivity is derived using nine computational 
steps.  
The results show that the methodology adopted has three distinct advantages compared to the generally accepted “kc 

x ETo” method for computing ET. First advantage is that the acreage of water-using land is observed directly from 
the satellite products, so accurate land use is implicit to the process. Second, there is no need to incorporate a crop 
type map to solve the energy balance, so accurate records of cropping patterns are not required. These features 
overcome the typical difficulty of assembling accurate records of irrigated areas and cropping patterns, especially for 
historical analyses. Thirdly, the LSA-SAF ETo (aggregated) product can be imported into a GIS for spatial analysis, 
either alone or in combination with land use and other spatial data, inherently accounting for the effects of salinity, 
deficit irrigation or water shortage, disease, poor plant stands and other ET-reducing influences on the ET flux. 
These influences are difficult to take into consideration using the standard “kc x ETo” computation. Furthermore 
the software tools have demonstrated a great flexibility and ease of use.  
The results presented in this research show the values of sugarcane production are in the average range of 37 to 40 
ton/ha at the level of the municipality area during the test period. The sugarcane area finally selected is showing 
significantly higher values. This is a first indication where the sugar cane areas can be harvested.  Results are very 
encouraging, through a high spatial variability of crop yield is found, suggesting adjustments are needed to transform 
the original satellite data-based scheme into satellite estimated agro-meteorological parameters. Further studies are 
required to analyse these results into more detail as these depend for example on the spatial resolution of the input 
background fields, their physical content and many other factors. Furthermore there is a need to use a longer time 
series and analyse into more detail the temporal response of e.g. the DMP of the study area. These finding present a 
first step towards an operational use of ILWIS in Brazil using NDVI S-10, DMP SPOT and ET0 for operational 
estimating of sugar cane productivity. This preliminary assessment demonstrates the feasibility of the proposed 
methodology to be useful in homogenous areas with the same characteristics and to focus on the control factors and 
incorporate local information to enable better model calibration and thus improve the results. 
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7. DEVELOPMENT OF A TOOL TO MONITOR CROP 
GROWTH AND GRAIN YIELD 

By: Antonio de la Casa1 and Gustavo Ovando2 
 

The Center for Surveying and Assessment of Agriculture and Natural Resources (CREAN) is an applied research 
unit of the Agricultural Sciences Faculty (Department) of the Córdoba National University (Argentina). The general 
objective of CREAN is to contribute to the development of strategies for sustainable management of natural and 
agricultural resources, based on rational use, preservation and recovery of the environmental patrimony. This 
involves the elaboration of application programs using remote sensing information and geographic information 
system. CREAN plays an active role to develop new methodologies to assess desertification processes, crop yield 
productivity and crop geographic distribution. Furthermore the Centre provides technological support to the public 
and private sectors on uses and applications of meteorological and natural resources information. 

7.1. Relevance of the topic selected 

Monitoring of agricultural crops throughout the growing season may provide information to make predictions of 
performance before harvest time. This is important for decision making at various levels, both for logistic and 
commercial activities (Rizzi and Rudorff 2005). 
The yield of a crop is determined by its genetic characteristics and prevailing conditions during the growing period, 
such as climate and weather conditions, soil fertility, pest and disease control, soil water stress and other factors 
affecting crop growth. The crop yield can vary widely in response to dominating conditions. By means of a 
mechanistic crop growth model, the expected yield for several growing conditions can be estimated (Boote et al., 
1998; Brisson et al., 2003; Yang et al., 2004). Such type of models not only simulates yield but also crop development 

throughout the growing cycle. The mechanistic models, however, generally require a huge set of input data which is 
often not readily available outside research stations. Since they also demand an extensive site-specific calibration 
before they can be applied, this type of model might not be very useful for developing irrigation strategies or applied 
to yield forecasting under practical conditions.  
For planning and evaluation purposes with limited data, a more general and simpler approach is available. The 
functional model presented by Doorenbos and Kassam (1979), describing the relation between water stress and the 
corresponding productivity loss is very useful: 

     
       

 
where Ya/Ymax is the relative yield; (1-Ya/Ymax) the relative yield decrease; ETa/ETmax the relative 
evapotranspiration; and (1-ETa/ETmax) the water stress or relative evapotranspiration deficit.  
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The response of yield to water stress for a given environment, is quantified through the yield response factor (Ky). 
The relationship between yield decline and water stress is linear as long as water stress is less than 50%. In the model, 
the actual yield (Ya) is expressed as a fraction of the maximum yield (Ymax) that can be expected under the given 

growing conditions for non-limiting water conditions. ETa refers to the actual crop evapotranspiration under the 
given growing conditions and ETmax is the evapotranspiration under the same conditions but for non-limiting water 
conditions.  
This functional model has been implemented in various ways according to the type and availability of information 
used (Rojas, 2007). Raes et al. (2006) used a water balance procedure to estimated ETa from meteorological 
information (ETmax and precipitation data), as well as soil characteristics relating to soil water content to calculate 
the crop yield loss. 
Remote sensing provides extensive spatial information about the actual status of crops and it has been used to 
support the parameterization of crop models (Guérif and Duke, 2000). The advantages of remote sensing are being 
exploited in recent years to monitor vegetation and assess the impact of drought on crop yield. Caselles et al. (1993) 
used NDVI images from NOAA-AVHRR to determine, together with field data, the various components of the 
FAO Model productivity. Funk and Budde (2009) present a detailed breakdown of the studies on the NDVI and 
crop yield and sustain the desirability of tuning the relationship between drought and productivity on the basis of 
phenological data. De la Casa and Ovando (2007) developed a crop model to estimate the yield of maize at 
regional/departmental level, integrating NDVI data with phenological information. 

A strategy to make yield estimation methods more robust and easily exportable is provided by the integration of 
remote sensing data with crop simulation models (Doraiswamy et al., 2003). Moriondo et al. (2007) present the 
development and testing of a methodological framework which utilizes NDVI data and a simulation model 
(CROPSYST) to estimate the crop phenology. This operation relies on two main steps, the first being the 
computation of above-ground biomass (AGB) obtained through the use of NDVI-derived fraction of absorbed 
photosyntetically active radiation (fAPAR), which is calculated by: 

     

   

 
 
As crop canopy cover fraction (fCov) could be considered similar to fAPAR in corn (Edwards et al., 2005) and 
soybean (Purcell, 2000), this expression can be rewritten as: 
 

 
 
Where εi and PARi are the radiation use efficiency (RUE, g MJ−1) and the photosynthetically active radiation (PAR) 
at day i, respectively; n is the number of simulation days. 
The second step consists of the final partition of the estimated biomass into maximum crop yield (Ymax), which is 

obtained through the use of the harvest index (HI) where HI is set to 0.47 for maize and soybean. 
 

 
The actual evapotranspiration (ETa) can be estimated using different calculation alternatives depending on the 
sources of information. The soil water balance was routinely used, but it needs precipitation (PP) and maximum 
evapotranspiration (ETmax) data, as well as information about the type of soil and its ability to retain water.  
In a similar but more simplified way, NDVI values are considered substitutes to the transpiration rate (Funk and 
Budde, 2009) and therefore the FAO productivity model can be adapted according to the following expression: 
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Where ΣNDVIa is NDVI value accumulated during the entire cycle or each stage of development and ΣNDVImax 
the highest value of all fields. 

Córdoba government compiles statistics of agricultural production using traditional methods based on field surveys 
to establish at department scale the planted/harvested area, yield and production of crops of major economic 
importance (SAyGA, 2010). These methods are laborious, requires field staff and they do not generate results as 
quickly as required by the markets (Rosenthal et al., 1998). 

7.2. Objective of the application 

This application proposes to develop a semi-operational procedure to estimate corn and soybean yield in Cordoba 
Province, Argentina. The procedure will be implemented in a regional framework making use of different ILWIS 
routines to calculate FAO Model productivity components, with NDVI data from MODIS satellite, and local (in 
situ) field information.  

7.3. Data collection and pre-processing 

7.3.1. NDVI data 

Ensure that you have unzipped the exercise data and move using the ILWIS navigator to this active working 
directory. Once close ILWIS and Open ILWIS again to ensure that the directory settings are correct. You can have a 
look at the data that is available in this folder; open the map list “sub_modis_ndvi” and display the map list as an 
animated sequence, using as Representation “NDVI1”. For this application 17 raster NDVI images (MODIS - 
MOD13Q1 16 days product, 250m, tile h12v12, ENVI format), ranging from September 2005 to May 2006 have 
been selected. These images were transformed to ILWIS image format and a sub map was prepared covering the 
region of interest. Further details are listed in table 7.1.  
 

Raster Name From To SRAD 
sub_modis_ndvi_1.mpr 6-Sep-05 21-Sep-05 11.6
sub_modis_ndvi _2.mpr 22-Sep-05 7-Oct-05 16.8
sub_modis_ndvi _3.mpr 8-Oct-05 23-Oct-05 18.2 
sub_modis_ndvi _4.mpr 24-Oct-05 8-Nov-05 19.8 
sub_modis_ndvi _5.mpr 9-Nov-05 24-Nov-05 20.7 
sub_modis_ndvi _6.mpr 25-Nov-05 10-Dec-05 21.6 
sub_modis_ndvi _7.mpr 11-Dec-05 26-Dec-05 20.5 
sub_modis_ndvi _8.mpr 27-Dec-05 11-Jan-06 23.1 
sub_modis_ndvi _9.mpr 9-Jan-06 24-Jan-06 23.3
sub_modis_ndvi _10.mpr 25-Jan-06 9-Feb-06 19.0
sub_modis_ndvi _11.mpr 10-Feb-06 25-Feb-06 19.6
sub_modis_ndvi _12.mpr 26-Feb-06 13-Mar-06 22.2
sub_modis_ndvi _13.mpr 14-Mar-06 29-Mar-06 18.2 
sub_modis_ndvi _14.mpr 30-Mar-06 14-Apr-06 17.6 
sub_modis_ndvi _15.mpr 15-Apr-06 30-Apr-06 13.8 
sub_modis_ndvi _16.mpr 1-May-06 16-May-06 15.8 
sub_modis_ndvi _17.mpr 17-May-06 1-Jun-06 14.1 

Table 7.1 NDVI images, timing details and Manfredi accumulated solar radiation (SRAD, MJ m-2) 

7.3.2. Administrative boundary map 

The administrative boundaries have been obtained from a vector map with departmental boundaries of Cordoba 
Province, in drawing exchange format (DXF), imported in ILWIS and have been named “boundary”. Add the 
polygon file “boundary” to your active map display window, using “info off” and “boundaries only” Display 
Options. 
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7.3.3. Meteorological data 

The daily solar radiation data from Manfredi meteorological station (31° 49’ 12’’ S, 63° 46’ 00’’ W, altitude 292 m osl) 
have been used, located in the central area of Cordoba. The accumulated value for each image period was calculated 
(see table 7.1).  

7.3.4. Canopy cover fraction (fCov) measurements 

Field measurements of fCov were made by classification of digital photos with a maximum likelihood algorithm, as is 
shown in figure 7.1. Pictures for soybean and corn crops were collected during 3 years, including the 2005-2006 crop 
cycle, in several fields in the central region of Cordoba. They were taken vertically from a height of 1.5 m. In total 
150 pictures have been classified for soybeans and corn.  

Figure 7.1 fCover measurements of corn, original (left) and classified results (right) 
 
The fCov values were analyzed by regression with NDVI to obtain a model which was used for both crops. The 
model used is:  
 

7.3.5. Departmental Crop yield data  

The Agricultural Secretary of Córdoba Province supplies statistics of departmental agricultural production. They use 

traditional methods based on reports to establish the planting, harvesting, yield and production of crops of major 
economic importance in the region (SAyGA, 2010). Details are provided in Table 7.2. 
 

ID 

Number 
Department 

Corn Yield 

(kg ha-1) 

Soybean Yield 

(kg ha-1) 

1 Calamuchita 7,000 2,442 

2 General Roca 6,800 2,300 

3 Gral. San Martín 5,500 2,150 

4 Juárez Celman 6,000 2,370 

5 Marcos Juárez 8,000 3,300 

6 Pte. R. S. Peña 6,500 2,200 

7 Río Cuarto 4,000 2,000 

8 Río Primero 6,000 2,200 

9 Río Segundo 7,000 2,300 

10 San Justo 5,500 2,050 

11 Santa María 6,500 2,400 

12 Tercero Arriba 6,500 2,800 

13 Unión 7,000 2,442 

 
Table 7.2 Corn and soybean yields of main agricultural crops in Cordoba in 2005-2006 crop season 

245,0228,1  NDVIfCov Eq. 7 
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7.4. Methodology 

The flow chart showing the procedure adopted to estimate grain yield is presented below in figure 7.2.  

Figure 7.2 Flow chart of adopted methodology 

7.5. Data processing and analysis 
The various data processing steps, as indicated in figure 7.2 are further elaborated upon below. 

7.5.1. NDVI images (step ❶) 

Once more display one of the 17 NDVI images, open the map list “sub_modis_ndvi” and display as example the 
first date image “sub_modis_ndvi _1” using as Representation “NDVI1”. Note that most of the necessary pre-
processing has already been done, this mainly in order to limit the file size needed to conduct the exercise. Check the 
map values by pressing the left mouse button and roaming the mouse over the active map window. Note the time 
steps of each of the NDVI images as is given in table 7.1. Add to your active map window the polygon file 
“boundary”, use the display option “Boundaries Only”. From the Menu of your active Map Window, select “File => 
Open Pixel Information”. Check the content from the pixel information window; note that the departmental crop 
yield data have been added, identical to table 7.2. Move with the cursor over the northernmost Department, called 
San Justo and note the negative NDVI values over the water body. These negative NDVI values do not represent 
vegetation and therefore these will be reclassified as “no data” values”. Close all active map windows.  Now from the 
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main ILWIS window, select the options “Operations => Raster Operations => Maplist Calculation”. Fill the 
MapList Calculation window as given in figure 7.3 and press “Show” to execute the operation. Display the resulting 
maplist “sub_modis_ndvi_und” as an animated sequence and check the values, note that no data is represented by a 

“?”. 

Figure 7.3 Reclassify negative NDVI values as no data values  

7.5.2. Solar radiation (step ❷) 

The solar radiation values used are provided in table 7.1 (see column SRAD) and is further described under the 
section “Meteorological data” in chapter 7.3.3.  

7.5.3. Crop classification (step ❸) 

To evaluate different crops existence a multi criteria classification method 
was adopted based on the knowledge of corn and soybean growing cycles 
in Cordoba province as reflected by the NDVI profiles, see also figure 7.4. 
Soybean is cultivated in 2 different ways: late soybean (soybean_2) is sown 
after wheat so it is expected that the September NDVI values are high, they 
are lowest at harvest time in December, and rising to a maximum in 
February when soybean full cover occurs. Following this criteria a Boolean 
raster map can be calculated by typing the following expression in the 
command line of the main ILWIS menu:  
 

soybean_2:=iff((sub_modis_ndvi_und_1>0.6)and(sub_modis_ 
ndvi_und_7<0.3) and(sub_modis_ndvi_und_11>0.7),1,0) 

 
Press enter to execute the operation and after the calculation has finished 
display the map. On the other hand, as early soybean (soybean_1) comes 
from fallow therefore the September NDVI is low, the sowing starts in 
November so the maximum NDVI appears in late December. To separate 
this crop we use the following expression:  

soybean_1:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_nd
vi_und_8>0.7)and(sub_modis_ndvi_und_12>0.5)and(sub_modis 
_ndvi_und_15<0.3),1,0) 

 
For corn, similar to early soybean, the minimum value occurs in September, but as thermal requirements are lower 
than soybean, the seeding can be earlier so it’s maximum NDVI value is reached in November (corn_1) or 
December (corn_2). The expressions used for the classification of corn are:  
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corn_1:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_6>0.6)and(sub_modis_ndvi_und_15
<0.3),1,0) 
 

corn_2:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_7>0.7)and(sub_modis_ndvi_und_12
<0.5)and(sub_modis_ndvi_und_15<0.3),1,0) 

 
Execute the expressions from the command line of the main ILWIS menu, display and check your results. For the 
exercise we only need to know where soybean and corn are cropped because they have different radiation use 
efficiency values (ε), so we make a unique Boolean image for each crop using the following commands:  
 

soybean:=iff((soybean_1=1)or(soybean_2=1),1,0) 
corn:=iff((corn_1=1)or(corn_2=1),2,0) 
 

To check the results of the classification, basically to see if crops are double classified, add the soybean and the corn 
maps together, using the following expression from the command line of the main ILWIS menu: 
 
 class_check:=corn+soybean 
 

display the map using as Representation “lai_SAF” and visually check your results, note the values range from 0 to 3, 
as corn has been assigned a value of 2! Close the map and right click the mouse button over the map “class_check”, 
from the context sensitive menu, select the option “Statistics => Histogram” and press “Show” to see the statistics 
per class. To correct for the classification error, execute the following expression from the command line of the main 
ILWIS menu: 
 
 class_cor:=iff(class_check<3,class_check,0) 
 
display the map using as Representation “lai_SAF” and visually check your results, note the values range now from 0 
to 2, soybean is now classified with a value of 1 and corn has obtained a value of 2. 
Finally the distribution of the classified pixels per department has to be considered. Right click the mouse button 
over the polygon map “boundary”, from the context sensitive menu, select the option “Polygon to Raster”, as 
Output Raster Map, leave “boundary”, use as Georeference “sub_modis_ndvi_1” and press “Show”. Note that the 
map is resampled to the NDVI georeference, which is in the original MODIS projection, the so-called Sinusoidal 
Projection, therefore the boundaries look distorted. Next step is to cross the raster map “boundary” with the map 
“class_cor”, select from the main ILWIS menu the option “Operations => Raster Operations => Cross” , as 1st 
Map specify “boundary” and as 2nd map select “class_cor”, as Output Table specify “representation_department” 
and press “Show”. Check the results shown in the displayed cross table, type the following expressions in the table 
command line: 
 
 pixel_soybean:=iff(class_cor=1,npix,?) 

 pixel_corn:=iff(class_cor=2,npix,?) 
 
New columns are created showing the number of pixels representing corn and soybean per department. These two 
newly created columns are going to be added to the attribute table “boundary”. Close the table 
“representation_department” and open the table “boundary”. From the active table menu, select the option 
“Column => Join”, as table select “representation_department” and as Column “pixel_soybean”, press “Next” 4 
times, accept the default Output Column “pixel_soybean” and press “Finish” and “OK”. Repeat this procedure to 
join also the “pixel_corn” column. Your results should represent those as provided in figure 7.5 
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Figure 7.5 Yield and number of sample pixels per Department for corn and soybean 

7.5.4. Sum of NDVI (step ❹) 

To calculate the sum of NDVI from all images during the crop cycle (from band 7 to 14) use the Maplist Statistics 
utility to obtain the ndvi_sum. From the main ILWIS window, select the options “Operations => Statistics => 
MapList =>Maplist Statistics”. Fill the MapList Statistics window as given in figure 7.6 and press “Show” to execute 
the operation.  

Figure 7.6 MapList Sum Function 
 
Display the resulting “ndvi_sum” map using as Representation “lai” and note the minimum and maximum values of 
the map. Move the mouse with the left mouse cursor pressed over the active map window. 

7.5.5. fCov*PAR calculation (steps ❺ and ❻) 

For each of the NDVI maps during the crop cycle (from band 7 to 14), the fCov needs to be calculated, in this case 
using equation 7 (see chapter 7.3.4). This can be combined with the average of the solar radiation transformed to 
PAR (PAR=SRAD*0.5) for a 16 days period (see table 7.1). Type the following expression in the command line of 
the main ILWIS menu: 
 

fCov_PAR7:=(sub_modis_ndvi_und_7*1.228-0.245)*10.25*16 
 
use the default values and press “OK”. For first date, where the solar radiation was 20.5, the PAR is 10.25 Mj m-2 d-

1. Display the resulting map and check the values obtained, use as Representation “Pseudo”. Repeat this procedure 
for the other maps for the crop cycle using the expressions below (note the changing PAR values): 
 

fCov_PAR8:=(sub_modis_ndvi_und_8*1.228-0.245)*11.55*16 
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fCov_PAR9:=(sub_modis_ndvi_und_9*1.228-0.245)*11.65*16 
fCov_PAR10:=(sub_modis_ndvi_und_10*1.228-0.245)*9.5*16 
fCov_PAR11:=(sub_modis_ndvi_und_11*1.228-0.245)*9.8*16 

fCov_PAR12:=(sub_modis_ndvi_und_12*1.228-0.245)*11.1*16 
fCov_PAR13:=(sub_modis_ndvi_und_13*1.228-0.245)*9.1*16 
fCov_PAR14:=(sub_modis_ndvi_und_14*1.228-0.245)*8.8*16 

 
For all resulting fCov_PAR* maps a new MapList has to be created, from the main ILWIS menu, select “File => 
Create => MapList”, specify as Map list name “fCov_Par” and add the maps in a sequential order using the “>” 
sign. See also figure 7.7. 

Figure 7.7 Final Maplist of fCov_PAR 

7.5.6. Maximum yield – Ymax (step ❼) 

As shown in the flowchart (see figure 7.2), Ymax is calculated using the sum of fCov_PAR, multiplied by the 
Radiation Use Efficiency (ε) and the Harvest Index (HI). To calculate fCov_PAR_sum, use the Maplist Statistics 
option. From the main ILWIS menu, select the options “Operations => Statistics => MapList =>Maplist 
Statistics”. Fill the MapList Statistics window as given in figure 7.8 and press “Show” to execute the operation.  

Figure 7.8 MapList Statistics SUM function of fCov_PAR 
 
As there are negative values, this intermediate map is corrected and all negative values are re-assigned as undefined 
(?). Type the following expression on the command line in the main ILWIS menu: 
 

fCov_PAR_sum_cor:=iff(fCov_Par_sum ge 0,fCov_Par_sum,?) 
 

Use the settings as given in figure 7.9 for the “Raster Map Definition” and press “OK” to execute the operation. 



APPLICATION MANUAL 

92 

 Figure 7.9 Raster Map Definitions 
 

To estimate maximum yield (Ymax) for each crop one has to take into account different ε values (1.8 gr Mj-1 and 3.8 
gr Mj-1 for soybean and corn, respectively (Sinclair and Mochow, 1999; Lindquist et al., 2005). For both crops a 
harvest index (HI) of 0.47 is assumed. To obtain the estimated yield in kg ha-1 furthermore a conversion factor of 10 
needs to be applied. These two computations can be done using a single expression from the command line in the 
main ILWIS menu: 
 

Ymax_soybean:=iff(class_cor=1,fCov_Par_sum_cor*1.8*0.47*10,?) 
Ymax_corn:=iff(class_cor=2,fCov_Par_sum_cor*3.8*0.47*10,?) 
 

Execute both expressions and check the resulting maps. 

7.5.7. Actual yield - Ya (Step ❽) 

From experimental data the accumulated NDVImax value obtained from of a set of 10 plots within the study area 
was 7.6 for the entirely cycle. To account for different crop water stress sensibility a Ky value of 2.1 and 1.3 for 
soybean and corn is applied, respectively. The ILWIS commands to calculate the actual yield are shown below: 
 

Ya_soybean:=iff(class_cor=1,Ymax_soybean-Ymax_soybean*2.1*(1-ndvi_sum/7.6),?) 
Ya_corn:=iff(class_cor=2,Ymax_corn-Ymax_corn*1.3*(1-ndvi_sum/7.6),?) 

 
Execute the expressions and display the resulting maps, check the values obtained. 

7.5.8.  Image Masking (step ❾) 

Display the map “Ya_soybean” and add to this map the polygon map “boundary” using the Display Options Info 

off and Boundaries Only. Repeat this procedure once more using the map “Ya_corn” and check the distribution of 
those pixels that have been used to calculate the yield of corn and soybean respectively. Also use the option “Pixel 
Information”, select “File => Pixel Information” from the active map display window. Close all active map 
windows. 

7.5.9. Yield per Department (Step ❿) 

In order to obtain the average Yield per Department the yield of each crop of every agricultural administrative region 
has to be extracted and aggregated to obtain the average yield. To do so select from the main ILWIS in menu the 
options “Operations => Raster Operations => Cross”, as 1st Map select “boundary” and as 2nd map “Ya_corn”. As 
Output Table specify “department_corn” and press “Show” to execute the operation. Open the table 
“department_corn” and note the content of the table. From the table menu, select the option “Columns => 
Aggregation” and specify the Aggregate Column Options window as indicated in figure 7.10 (left) and press “OK”. 
Note that the average yield for corn is computed per department and the result is added to the table “boundary”, 
using a new column, named “Ya_corn”. Close the cross table. 
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Repeat the Cross operation, now using as 1st Map “boundary” and as 2nd map “Ya_soybean”. As Output Table 
specify “department_soybean” and press “Show” to execute the operation. Again note the content of the table 
created. Again use the aggregation function as given in figure 7.10 (right), now use the column “Ya_soybean”, as 

output table specify “boundary” and as output column “Ya_soybean” 
 

Figure 7.10 Table Aggregation of corn – soybean yield per Department 
 
Now open the table “boundary” and inspect the newly created columns called “Ya_corn” and “Ya_soybean”. Also 
have a look at figure 7.11. From the table menu, select the options “Columns => Statistics”, select as function 
“Correlation” and calculate the correlation between the columns “CornYield” – “Ya_corn” and between the 
columns “SoybeanYield” – “Ya_soybean”. 

Figure 7.11 Resulting table showing observed versus calculated yield 
Calculate the residuals as well. Type from the table command line the following equations and press “OK” to 
execute these: 

 Res_corn:=cornyield-ya_corn 
 Res_soybean:=soybeanyield-ya_soybean 
 
From the Table menu, select the “Graph” icon, in the “Create Graph” menu, unselect the “X-Axis” and select for 
the “Y-axis” the column “Res_corn” and press “OK”. From the left hand graph legend, double click the 
item ”Res_corn” and change the representation to “Line”. From the Graph Menu, select “Edit => Add Graph => 
From Columns” and select the column “Res_soybean” and press “OK”. Again double click on the “Res_soybean” 
item in the graph legend and change it to a line representation, eventually change the colour. Double click on the 
graph title and change the name, repeat this also for the Y-Axis description. Your results should resemble those of 
figure 7.12. 
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 Figure 7.12 Residual analysis of the observed versus calculated yields 
  

7.6. Conclusions 

This exercise shows a methodology that was developed using a geographic information system for estimating corn 
and soybean yields for the province of Cordoba, Argentina, applying only NDVI data (derived from MODIS, having 
a pixel size of 250 m) and solar radiation as background information. 
This procedure is a first prototype that, despite its simplified design, produces objective results which are in contrast 
with the qualitative survey method currently used by the state agency. It should be noted that in general far fewer 
pixels have been used to calculate the average yield for corn, for the Department Calamuchita only 13 pixels have 
been used. This might explain the high residual obtained but in general further validation of the approach is required. 
The FAO method for estimating crop productivity structured in a geographic information system is flexible to 
incorporate calculation routines in a modular format. According to the information available the estimation of Ymax, 
ETmax and Eta can be changed using methodologies which are more accurate but often more complex. 
Improving the procedure at a later stage should take into account also the different sensitivity to water stress of 
crops at different phenological stages, as well as the use of spatially distributed rainfall data using satellite derived 

rainfall estimates. 
Furthermore the MODIS derived NDVI could be replaced by the MSG (SEVIRI-Instrument) derived NDVI which 
is has currently become available. 
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8. ABOVEGROUND NET PRIMARY PRODUCTIVITY 
ESTIMATION OF PAMPA GRASSLANDS USING 
MODIS AND GOES DATA 

By: Piedad M. Cristiano1, María Eugenia Beget2, Carlos Di Bella12, Gabriela Posse2 and Tomás 
Hartmann2 

8.1. Relevance of the application 

The Primary Productivity (PP) of ecosystems is the key variable that defines the carbon input of an ecosystem. 
Particularly in areas with an extensive livestock production, where pastures and grasslands are the main forage 
resources that sustain cattle production, accurate estimations of Aboveground Net Primary Productivity (ANPP) are 
considered an elemental necessity to adjust grazing pressure and improve sustainable management. ANPP maps will 
be generated on a monthly basis and can be supplied to farmers, cooperative associations and government decision 
makers to be used as a tool for optimal development of their activities. 

8.2. Objective of the application 

In order to provide a useful tool in the calculation of feed balances for fields of the Pampas Region, the overall 
objective of this exercise is to generate the Aboveground Net Primary Productivity (ANPP) map using the efficiency 
model as proposed by Kumar and Monteith (1982). Particular objective of this exercise is furthermore to compute 
the annual ANPP for 2007. 

8.3. Methodology 

Regional ANPP is estimated applying the efficiency model as proposed by Kumar and Monteith (1982) and monthly 
as well as an annual ANPP map for the Pampas Region in Argentina will be generated. A graphical representation of 
the methodology is given in figure 8.1. The model linearly relates the ANPP to the photosynthetically active radiation 
(PAR) absorbed by vegetation (APAR) and the plant radiation use efficiency (RUE) which is the energy conversion 
coefficient of absorbed radiation into aboveground biomass. The model can be expressed as ANPP = RUE * APAR 
(Kumar and Monteith, 1982). APAR can be calculated by multiplying the fraction of PAR intercepted by vegetation 
(fPAR) by the incoming PAR. This model has the advantage of using spectral information provided by remote 
sensing, such as the NDVI index, to estimate the fPAR.  
A thematic map of the RUE was created reflecting the environmental conditions (water and nutrient availability) in 
the region. This map is used to estimate the regional ANPP in conjunction with the efficiency model.  
The study area includes 3 provinces belonging to the Pampas Region of Argentina: Buenos Aires, Entre Rios and 
South of Santa Fe (see figure 8.2). This region is characterized by a vast plain of grasses but is intensively modified by 

humans. Main activities in the region are agriculture and livestock production. The highest rainfall is recorded during 
the spring-summer season and its intensity decreases from east to west, with an overall mean annual precipitation of 
900 mm. The mean annual temperature is 15ºC with a mean monthly temperature ranging from 7°C during the 
winter season to 21°C in summer. Because of the seasonality of water conditions, the RUE map was separated in a 

                                                      
1 CONICET Buenos Aires, Argentina Corresponding Author (email: piedad78@gmail.com) 
2 Instituto Nacional de Tecnología Agropecuaria (INTA), Corresponding Author (email: mbeget@cnia.inta.gov.ar) 
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dry season RUE (autumn-winter) and wet season RUE (spring-summer). Nutrient availability for the RUE maps was 
derived from the soil types given by the Soil Atlas of Argentina (Soil Institute of CIRN/INTA et al, 1995). 
 

 
Figure 8.1 Flow chart of the followed methodology 
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Figure 8.2 Study area located in the Pampas Region 

8.4. Data processing and analysis  

8.4.1. Introduction 

Ensure that you have unzipped the exercise data and move using the ILWIS navigator to this active working 
directory. Once close ILWIS and Open ILWIS again to ensure that the directory settings are correct. You will not 
see any files in the ILWIS catalogue as all data still needs to be imported. You can use the Windows Explorer to 
check the data available. All data is in TIF format. Regional data needed to conduct the exercise are:  
 

 monthly NDVI (ndvi_mmmyys), where m is month, y is year and s indicates that a submap is used;  

 monthly PAR (par_mmmyy);  
 bi-seasonal RUE maps (rue_ss), where s is season (spring-summer or autumn-winter). 

 
NDVI images used were obtained from the MODIS sensor (Moderate Resolution Imaging Spectroradiometer), on 
board the TERRA satellite (NASA). A submap was created using two tiles covering the region (v 12 h 12 and 13). 
The data was received by the HRPT station operated by INTA. Spatial resolution of these images is 250 x 250 m, 
having a temporal resolution of 16 days. Maximum NDVI was selected from the two biweekly images available for 
each month in order to avoid the degrading effects mainly caused by the atmosphere. 
PAR maps were generated from the average daily global radiation product (W/m2) for each month produced by the 
National Institute for Space Research of Brazil (INPE). This product is based on images from the geostationary 
satellite Geostationary Observational Environmental Satellite-8 and 12 (GOES) which has a spatial resolution of 16 
km2 and temporal resolution of 8 days. These values were converted to MJ/m2 and accumulated for each month of 
the year 2007. To convert the global radiation to PAR, values were multiplied by a factor of 0.47, according to Akmal 
& Jansen (2004). A median filter using a 7x7 matrix was applied to blur the edge effects of these maps. 
The RUE was spatialized according to the stress factors (water and nitrogen) due to the environmental conditions in 

spring and summer months from October to December while the months from April to September was used for 
autumn-winter. A RUE value of 0.48 was taken from literature (Paruelo et al. 1997, Clavijo et al. 2007) which is 
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regarded the optimal value for grasslands. In each environmental condition, a reduction rate was applied to the RUE 
according to different treatments as is established by Cristiano et al. (in press, 2011). 

8.4.2. Data pre-processing 

8.4.2.1. Data import into ILWIS 

Conversion to ILWIS format and resampling of PAR and RUE maps has to be performed before the actual data 
analysis can be done. To convert TIFF format to ILWIS format, a data translation library, called GDAL is going to 
be executed from the DOS Command Line prompt. The executable “gdal_translate.exe” is situated in the main 
ILWIS directory.  
To open the DOS Command Window, select the option “Run” from the Windows Start button and type “Cmd” and 
press “OK”. The command line expression window is opened. Change the directory to your active working directory 
typing: “cd C:\chapter8” (see also figure 8.3). Note that the drive or path could be different if you have copied the 
exercise data into another directory. 

Figure 8.3 MS DOS command line window 
To import a layer into ILWIS format (step 1 of the flow chart of figure 8.1) use the general syntax command: 
 

GDAL_translate.exe –of ILWIS inputfile outputfile 
 

Where: “-of ILWIS” specifies that the output raster format should be ILWIS; “inputfile” is the TIF file to be 
imported and “outputfile” is the raster destination file in ILWIS format. 
 
Import the following layer typing the expressions below in the command line (note the location of the ILWIS and 
the exercise working directory on your system, in this case ILWIS is installed in “C:\ILWIS” and the working 
directory is “C:\chapter8”) and press enter to execute the operation: 
 

C:\ILWIS\gdal_translate.exe -of ILWIS C:\chapter8\ndvi_0107s.tif C:\chapter8\ndvi_0107.mpr 

 
To display the imported NDVI map double click on the newly created file “ndvi_0107” and use as Representation 
“NDVI1” and press “Show”. Inspect the values of the map using the left mouse button pressed while moving the 
cursor over the map. 
Use your Windows Explorer and check the content of the directory once more. You will note another file, called 
“import.bat”. Right click with the mouse on the file “import.bat”, select “Edit” from the context sensitive menu and 
the file content can be displayed using NotePad or WordPad. Check the content. You will note that for each map 
layer an import syntax line has been provided in this batch file, similar as the one you typed in the command line 
window. Furthermore note that you might have to edit each line if the locations of your local ILWIS and Working 
directories are different. You can use from the Notepad menu the options “Edit”, “Replace” and provide the 

appropriate directory settings. When this is done save the file, double click it with the mouse and the import will be 
executed using this batch file. Wait until the import is completed and from the main ILWIS menu, select “Window 
=> Refresh”. Note that the newly imported maps should now be shown in the ILWIS catalog.  Display an example 
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from the NDVI, RUE and PAR maps, using for the NDV map the Representation “NDVI1 and for the other maps 
the “Pseudo” Representation can be used. 

8.4.2.2. Further RUE and PAR pre-processing 

In order not to have an exercise dataset that has a large file size volume a subset of the NDVI map is used here. So 

step 2 in the flowchart of figure 8.1 can be omitted here. If we want to calculate in ILWIS using different maps, they 
have to have the same row and column dimensions. Here the RUE and PAR maps have different dimensions and 
therefore need to be resampled to fit the NDVI map.  
Right click with the mouse the input map “rue_sprsum”, from the context sensitive menu select the options “Spatial 
Reference Operations => Resample”. Select “Nearest Neighbour” as Resampling Method and as output raster map 
name specify “rue_sprsumr”. As Georeference the one from the January NDVI map has to be selected: 
“ndvi_0107”. Press “Show” to execute the operation. Display the resulting map “rue_sprsumr” using a “Pseudo” 
Representation. From the active map window menu, select the option “Layer => Add Layer” and select now the 
“NDVI_0107” map. In the Raster Map Display Options check the box “Transparent” and a transparency of 50 % 
can be used, press “OK”. Now the two maps can be displayed using a single window as the map dimensions and 
coordinate system are identical. Close the map view and repeat the procedure for the map “rue_autwin”, using the 
same resampling method (“Nearest Neighour”) and georeference (“NDVI_0107”), as output map name 
specify”rue_autwinr”. Display and check your resulting map. 
In a similar manner also the PAR monthly maps need to be resampled. Right click with the mouse the input map 
“par_0107”, from the context sensitive menu select the options “Spatial Reference Operations => Resample”. Select 
“Nearest Neighbour” as Resampling Method and as output raster map name specify “par_0107r”. As Georeference 
the one from the January NDVI map has to be selected: “ndvi_0107”. As data value range specify “-100” and 
“1000” as minimum and maximum respectively, the Precision can be kept default. Press “Show” to execute the 
operation. Have a look at the map and then close the map window.  
As this operation has to be repeated another 11 times, use the command line history. From the main ILIWS menu, 
select the command line history drop down button at the right hand side for the command line. Select the string that 

has resulted in the previously conducted resampling of the PAR map. This string is given below: 
  

par_0107r.mpr{dom=value.dom;vr=-100:1000} = MapResample(par_0107,ndvi_0107.grf,nearest) 
 

Modify the string as follows and press enter to execute a new resampling procedure for the February PAR map: 
  

par_0207r.mpr{dom=value.dom;vr=-100:1000}:=MapResample(par_0207,ndvi_0107.grf,nearest) 
 

Repeat the procedure as described above to resample the remaining PAR maps. By the end of this all PAR and RUE 
maps have been resampled and can be used in conjunction with the NDVI maps of 2007. See also figure 8.4. 

Figure 8.4 NDVI_0107 submap and resampled RUE_sprsumr and PAR_0107r maps 

8.4.3. Data analysis 

Intercepted fraction of PAR (fPAR) computation (step 5 in the flowchart of figure 8.1) will be calculated here 
according to the procedure proposed by Potter et al. (1993), indicated in equation 1. 
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(Eq. 1) 
 

To calculate the fpar map on a monthly basis a new map list has to be created. From the main ILWIS menu, select 

“File => Create => MapList” and add all “NDVI_*” maps in a sequential order to the right hand listing, using the 
“>” icon. Specify as Map List name “NDVI_07” and press “OK”. Display the newly created map list “NDVI_07” 
as an animated sequence, using as Representation “NDVI1”, check the map values obtained. 
 
Open from the main ILWIS menu the option “Operations => Raster Operations => MapList Calculation”. Specify 
the settings as indicated in figure 8.5 and press “Show” to execute the operation. Display the newly created map list 
“fpar” as an animated sequence, using as Representation “fapar”, check the map values obtained. 

Figure 8.5 fPar calculations for the whole NDVI maplist 
 
fPAR data range should be between (0-0.95) accordingly to Potter et al. (1993). For that reason the initial fPAR maps 
obtained should be corrected using the following conditions: if fPAR ≤ 0, fPAR=0 and if fPAR ≥0.95, fPAR=0.95. 
To correct the fPAR maps select from the main ILWIS menu the option “Operations => Raster Operations => 
MapList Calculation”. Specify the settings as indicated in figure 8.6 and press “Show” to execute the operation.   

Figure 8.6 MapList calculations to correct the fPAr 
 
The next step is to calculate the Absorbed PAR or APAR (see also step 8 in the flowchart of figure 8.1) by 
multiplying the fPAR monthly maps by the corresponding PAR monthly maps. To do this first create a new maplist 
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using the resampled monthly PAR maps. From the main ILWIS menu, select “File => Create => MapList” and add 
all resampled “PAR_*r” maps in a sequential order to the right hand listing, using the “>” icon. Specify as Map List 
name “PAR_07” and press “OK”. Display the newly created map list “PAR_07” as an animated sequence, using as 

Representation “Pseudo”, check the map values obtained. 
Open from the main ILWIS menu the option “Operations => Raster Operations => MapList Calculation”. Specify 
the settings as indicated in figure 8.7 and press “Show” to execute the operation. Display the newly created map list 
“apar” as an animated sequence, using as Representation “Pseudo”, check the map values obtained. 
 

Figure 8.7 Maplist calculations to obtain the APAR and the resulting map for January 2007 
 
The next step is to calculate the monthly ANPP (e.g. for January 2007, see also step 9 in flowchart of figure 8.1) by 
multiplying the APAR map by the corresponding season RUE map. Note that you have to choose the right RUE 
map regarding the season corresponding to each month. Choose “rue_sprsumr” to compute ANPP from October to 
March and “rue_autwinr” for the April to September period.  
As these calculations have to be repeated for all the months create a script and run it from the ILWIS command line. 
To create a script, select from the main ILWIS menu the options “File => Create => Script”. Select the “Script” tab 
in the script editor and type the content as indicated in figure 8.8 (left). Note that the first line is just a comment; the 
second line is defining the calculation that should be performed. Here three parameters are used, presented by %1 up 
to %3. Open the “Parameters” tab to further define the input and output maps that are going to be used. Provide the 
content as indicated in figure 8.8 (right). When completed select the “Save” Icon from the menu and save the script 
as: “ANPP_Calc”. To run the script press the “>” icon from the menu and provide the relevant input and output 
map information, details for the month of January are presented in figure 8.9. Press “OK” to run the script. 
 

Figure 8.8 Prepare ILWIS script to calculate the monthly ANPP 
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Figure 8.9 ILWIS Script parameter definition for ANPP calculation 

 
When the calculation has finished open the newly created ANPP map, here called “anpp_1” using as Representation 
“Pseudo”. Your results should resemble those of figure 8.10. 

Figure 8.10 ANPP map calculated for the month of January 2007 
 
As this operation has to be repeated another 11 times, use the command line history. From the main ILIWS menu, 
select the command line history drop down button at the right hand side for the command line string that has 
resulted in the previously conducted run of the script. This string is also given below: 
 
 Run ANPP_calc apar_1 rue_sprsumr “anpp_01” 
 
Modify the string as follows and press enter to execute a new script run to create the February ANPP map: 
  

Run ANPP_calc apar_2 rue_sprsumr “anpp_02” 
 
Repeat the procedure as described above to calculate the remaining monthly ANPP maps. Once more note that for 
the months of October to March the “rue_sprsumr” is used to compute the ANPP and from April to September the 
“rue_autwinr” should be used. 
Once you have calculated all monthly ANPP maps, these have to be integrated into the annual ANPP (step 10 in the 

flow chart of figure 8.1). To calculate the ANPP_2007 map a new map list can be created. From the main ILWIS 
menu, select “File => Create => MapList” and add all “ANPP_*” maps in a sequential order to the right hand 
listing, using the “>” icon. Specify as Map List name “ANPP_2007” and press “OK”. Display the newly created map 
list “ANPP_2007” as an animated sequence, using as Representation “Pseudo”, check the map values obtained. 
Close the map display if you have seen the animated sequence. Right click with the mouse the maplist 
“ANPP_2007”, from the context sensitive menu select the options “Statistics => MapList Statistics”, use as 
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Statistical Function “Sum” and specify as Output Raster Map “anpp_sum”, press show to execute the operation. 
When the calculation has finished, open the newly created anpp_sum map, which shows you the annual ANPP in 
kg/ha for 2007. Use as Representation “Pseudo”. You can add a layer with country boundary information onto this 

final map. To do so, select from the active map window the options “Layer => Add Layer” and browse to your 
ILWIS directory, select the sub directory: Extensions\Geonetcast-Toolbox\util\maps and from there select the 
vector layer “country_02” and press “OK”, unselect the option “Info” and select the option “Boundaries Only” and 
press “OK”. Move the mouse, with the left mouse button pressed, over the map and note the values obtained. Your 
results should resemble those of figure 8.11. 

Figure 8.11 Final ANPP map for 2007 

8.5. Conclusions 

A methodology to compute monthly ANPP in the Pampa Region from NDVI and PAR data was presented. The 
methodology is based on the efficiency model using bi-seasonal RUE maps.  

A validation was previously performed comparing with ANPP obtained with the traditional model of Kumar & 
Monteith (1982) that uses a fixed RUE value (in this case, 0.48 g/MJ). Both models were validated against three sets 
of data using simple linear regression using the coefficients of determination (R2) and slopes for all comparisons. The 
three independent set data were: field ANPP estimations, ANPP estimated with a rainfall model (Sala et al. 1988) and 
ANPP estimations from CASA model (Imhoff et al. 2004). For more details see Cristiano et al. (2011). Both 
methods (variable RUE and fixed RUE) presented a low level of adjustment comparing with productivity observed 
in the field (R2= 0.25 and 0.30, respectively). This might be due because the sites used are having the same 
environmental conditions. When we used data covering all environmental conditions (ANPP obtained by the rainfall 
and CASA models), the adjustment level increased significantly and the R2 was greater in the variable RUE model 
than in the fixed RUE model. This indicates that a few number of field ANPP sites did not reflect the variability in 
the environmental conditions required for a proper validation. We believe it is necessary to perform a proper 
validation of the model using more field ANPP data covering the full range of environmental conditions studied.  
Here use is made of the NDVI obtained from the MODIS TERRA instrument. Currently in the GEONETCast-
DevCoCast data stream also NDVI products are available, like the decadal NDVI derived from the SPOT 
Vegetation instrument, or the daily NDVI derived from the SEVIRI-instrument onboard Meteosat Second 

Generation. This is a new daily product that is generated by the Meteorological Product Extraction Facility. All of 
these products can be easily incorporated in your analysis using the import routines available from the 
GEONETCast toolbox. 
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9. ESTIMATION OF ET FROM REMOTE SENSING AND 
METEOROLOGICAL DATA USING THE METHOD 
PROPOSED BY JACKSON 

 
By: Alfredo G. García1, Carlos M. Di Bella 1 and Tomás Hartmann 1 

9.1. Relevance of the application 

The evapotranspiration (ET) is the term used to describe the amount of water, expressed in mm/day, which is 
effectively lost from the earth surface into the atmosphere by soil surface evaporation and plant transpiration. ET is 
an important component of the water cycle and its importance in the hydrological cycle makes necessary its accurate 
quantification both for use in the field of agricultural production and for planning and management of water 
resources. Thus, ET plays a key role in the calculation of the soil water balance, either for the detection of water 
stress conditions, their use as input variable in crop yield models or the study of ecosystem functioning and its 
relationship to local and regional climate, among others. 
The estimation of ET using remote sensing is based on the evaluation of the surface energy balance (Paruelo, 2008). 
These models assume that the ET process uses some of the available energy (net radiation) to vaporize the water. 

The approach uses information derived from remote sensing to estimate surface properties such as albedo, leaf area 
index, vegetation indices, surface roughness, emissivity and surface temperature, and estimate ET as a residual from 
the surface energy balance equation (Gowda et al, 2007): 
 

LE=Rn-G-H      (Eq. 1) 
 

where Rn is net radiation (Wm-2). LE, H and G are the latent heat, sensible and geothermal fluxes (all in Wm-2). LE 
is converted to ET (mmd-1) by dividing it by the latent heat of vaporization (~ 2.45 MJkg-1). 

9.2. Objective of the application 

In order to provide a useful tool in the calculation of water balances for fields of the central region of Argentina, the 
overall objective of this exercise is to provide a procedure for the estimation of evapotranspiration (ET) for clear sky 
conditions, combining information derived from remote sensing in conjunction with meteorological data. 

9.3. Data used 

9.3.1. Local / regional (in-situ) data 

Initial data used to derive the evapotranspiration (ET) are: 
 Land Surface Temperature (LST) derived from MODIS Land Surface Temperature and Emissivity product 

(Land Surface Temperature MOD11A2 product): mod11a2.2009145.LST_Day_1km.tif; 

                                                      
1 Instituto Nacional de Tecnología Agropecuaria 

   (Corresponding author Alfredo García) email: aggarcia@agro.uba.ar 
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 Surface Spectral Reflectances derived from MODIS Surface Reflectances product (Surface Reflectance 
bands 1 and 2 MOD09A1 product): mod09a1.2009145.sur_refl_b01.tif (b01: band 1 - red and b02: band 2 - 
near infrared); 

 Meteorological ground station air temperature data: airtemp.2009145.tif (produced using local ground 
meteorological station data by INTA); 

 Digital elevation model derived from the Shuttle Radar Topography Mission (SRTM); 
 Net radiation: netrad.2009145.tif (produced by INTA following the approach proposed by Kumar et al. 

(1997)). 
Further details on the data used for this exercise are provided in table 9.1.  

Product 
Temporal 

Resolution 

Spatial 

Resolution 
Units Scaling Factor Data Source 

Land Surface 
Temperature 

8 days 1 km Kelvin 0.02 MODIS1 

Surface Reflectance 
(bands 1 and 2) 

8 days 500 m Reflectance 0.0001 MODIS1 

Air Temperature 8days 500 m Celsius - INTA2 

Net Radiation 8 days 500 m MJ.m-2.d-1 - INTA2 

Table 9.1 Data sets characteristics  
 
(1 Warehouse Inventory Search Tool available at https://wist.echo.nasa.gov/api/ and 2 produced at INTA) 

9.3.2. Data from GEONETCast – DevCoCast 

Although the methodology proposed here does not use data from GEONETCast at this moment, INTA plans to 
use products from the GEONETCast – DevCoCast data stream in future versions to derive the ET. It should be 
noted that some of the products do not cover the full geographic extent of the study area. 

9.4. Methodology and description of the study area  

9.4.1. Methodology 

To estimate the ET at regional scale use will be made of the method originally proposed by Jackson et al. (1977), the 
so-called "Simplified Method", which calculates the daily ET (ETd in mmd-1) relating the net radiation received by 
the surface and its temperature difference with the near-surface air, based on the following equation: 
 

ETd=NRd-B(Ts-Ta)n      (Eq. 2) 
 
where NRd (mmd-1) is the daily net radiation, Ts (K) is the surface radiant temperature, Ta (K) is the air temperature 

(near surface), B (mmd-1K-1) and n are parameters that depend on the type and condition of vegetation. 
 
Although it is a relatively simple method, it has been used successfully in estimating the evapotranspiration of 
agricultural crops, reforestations, natural forests and grasslands (Seguin and Itier 1983, Lagouarde and Brunet 1991, 
Courault et al., 1994, Caselles et al., 1998, Nosetto et al., 2005). The ET product will be generated at a spatial 
resolution of 1 km and is having a temporal resolution of 8 days. The overall methodology is presented in figure 9.1. 
Net radiation, which can be separated in net short wave radiation (Sn) and net long wave radiation (Ln) is computed 
using calculations of incoming solar radiation (St) and satellite estimates of land surface albedo (α). The net short 
wave radiation (Sn) is obtained semi-empirically as: 
 

Sn = St (1-α)       (Eq. 3) 
 
where St is the total incoming short wave radiation and α is land surface albedo. 
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Figure 9.1 Flow chart of the proposed ET processing chain  
 
Following Kumar et al. (1997), St is computed as the potential solar radiation received under clear-sky conditions in 
response to latitude and elevation, using a digital elevation model and latitude data, to study the variation in radiation 
for different aspects and slopes. The model takes into account a simplified diffuse radiation. The surface albedo (α) is 
estimated using the reflectance values from bands 1 (620-670 nm), 2 (841-876 nm), 3 (459-479 nm), 4 (545-565 nm), 
5 (1230-1250 nm) and 7 (2105-2155 nm) of the MODIS-TERRA instrument, based on the approach outlined by 
Liang (2000) as: 
 

α = 0.160α1+0.291α2+0.243α3+0.116α4+0.112α5+0.081α7-0.0015  (Eq. 4) 
 
where α(1 to 7) are the reflectance values from the respective MODIS-TERRA bands. 
 
Net long wave radiation (Ln) is estimated empirically according to Granger and Gray (1990). Assuming that 
variations in atmospheric humidity are controlled by the energy supplied to the surface (NR), for clear sky conditions 
and at daily basis, Ln can be estimated from incoming short wave radiation (St) as: 
 

Ln = -4.25-0.24St       (Eq. 5) 
 
Due to the lack of validation for the methodology presented here, INTA is planning to use in the next versions of 
the ET product, data disseminated by GEONETCast (such as Downward Surface Short-wave Flux and Downward 
Surface Long-wave Flux) to estimate the net radiation following the method proposed by LSA-SAF in their 
evapotranspiration product (http://landsaf.meteo.pt). INTA will then compare these approaches and decide to use 
which method is best adjusted in comparison to the ground based meteorological net radiation data. 
The surface radiant temperature (Ts) is obtained from the MODIS Land Surface Temperature and Emissivity 
product, while near surface air temperature (Ta) is derived from a reference height of 1.5 m using the air temperature 
registered by the meteorological ground stations located in the study area. 
The parameter B represents the average bulk conductance for daily-integrated sensible heat flux and n is a correction 
factor for non-neutral static stability (Kalma et al., 2008). While the B value depends on the surface roughness, n 
depends on the atmospheric stability and both coefficients are closely related to the amount of vegetation or 
fractional vegetation cover, which can be estimated from a scaled vegetation index, the Scaled Normalized 
Vegetation Index or NDVI* (Carlson et al., 1995), where: 

 
NDVI* = (NDVI-NDVImin)/(NDVImax-NDVImin)   (Eq. 6) 

 
The Normalized Difference Vegetation Index (NDVI) can also be obtained from the MODIS Vegetation Index 
product. Finally, B and n will be calculated following the equations proposed by Carlson et al. (1995), where: 
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B = 0.0109+0.051(NDVI*)      (Eq. 7) 
n = 1.067-0.372(NDVI*)      (Eq. 8) 

9.4.2. Study Area 

The area of interest (figure 9.2) includes the central portion of the Argentinean territory. This area partly consists of 9 

provincial territories, including Buenos Aires, Entre Ríos, Santa Fe, Córdoba, La Pampa, San Luis, San Juan, La 
Rioja, Rio Negro and Neuquén. From east to west this region presents vast gradients in climate, soils and land use 
types. The main activities of the region are irrigated agriculture and livestock production to the west and rain-fed 
agriculture and livestock production to the east. There are at least two types of climates in this area: temperate humid 
to the east, and semi arid - arid to the west. The mean annual precipitation increases from southwest to northeast, 
ranging between 200 - 1200 mm. The mean annual temperature also increases from southwest to northeast, ranging 
between 14 - 20 ºC. 

 
Figure 9.2 Study area located at the central region of Argentinean territory. Triangles show the location of 

meteorological ground station used to estimate ET 

9.5. Data pre-processing 

9.5.1. Satellite Remote Sensing data 

As mentioned above, the surface temperature (Ts) in the ET equation, the NDVI (needed to calculate the B and n 
coefficients) and the surface spectral reflectance values (needed to compute the albedo in the net radiation estimate) 
are obtained from the Moderate Resolution Imaging Spectroradiometer (MODIS-TERRA) products. Specifically, use 
is made of the Surface Spectral Reflectance 8-day L3 Global 500m (MOD9A1) and Land Surface 
Temperature/Emissivity 8-day L3 Global 1km (MOD11A2) products. Two tiles are used to cover the entire study 
area: h12v12 and h12v13. The images – products have been obtained from the MODIS receiving station located at 
INTA (Buenos Aires, Argentina). The Land Surface Temperature from MOD011A2 needs to be resampled to 500 m 
spatial resolution in order to obtain the same spatial resolution as the MOD09A1 product. First the necessary import 
and pre-processing has to be conducted before the ET can be derived. Copy the zipped exercise data file on your c:\ 
drive. Unzip the file chapter9.zip. On your C:\ drive you now should have a directory called “chapter9” containing 
the following sub directories: ‘DataInput’ and ‘Working_Dir’. The folder DataInput is containing the following sub 
directories: ‘1_SufraceTemp’, ‘2_SurfaceReflect’, ‘3_AirTemp’ and ‘4_NetRad’. Open ILWIS and use the ILWIS 
navigator to browse to the active working directory for this exercise, which is “C:\Chapter9\Working_Dir”. In the 
ILWIS Catalog you find a table, double click the table to open it, look at the content and close the table. Close 
ILWIS and once more open ILWIS. ILWIS should open in your active working directory 
“C:\Chapter9\Working_Dir”.   
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9.5.1.1. Import and scale MODIS LST product 

To import all necessary MODIS Land Surface Temperature (mod11a2*.tif) data in order to estimate ET for a long 
time period using the ILWIS menu can be cumbersome. Use Windows Explorer to check the content of the sub 
directory: “C:\chapter9\DataInput\1_SurfaceTemp”. There are 4 files. The file “SurfaceTemp.rar” contains the 
original Land Surface Temperature images in TIF format for 4 consecutive dates. In order to import these images 
there are two batch files, “multi_import_SurfaceTemp_start.bat” and “multi_import_SurfaceTemp.bat”, respectively. 
The content of these batch files is also provided in figure 9.3 and 9.4. Right click with the mouse the file 
“multi_import_SurfaceTemp_start.bat”, select “Edit” from the context sensitive menu to examine the file content.  

Figure 9.3 Batch file 1 to start the multi temporal import routine 
 

This batch routine states in the first line that it has to create a new batch file, called “import_param.bat” specifying 
the location of your ILWIS directory. The second line adds another line to the batch file “import_param.bat”, 
specifying the location of the directory where you have unzipped the exercise data. Line 3 specifies that the content 
of the “SurfaceTemp.rar” file should be extracted and the content should be written in the same directory. The last 
line indicates that for all (now decompressed) images containing the string “mod11a2*.tif” another instance of a 
batch file, called “multi_import_SurfaceTemp.bat” should be executed. The listing of this batch file is provided 
below. 

Figure 9.4 Batch file 2 for importing the Land Surface Temperature data 
 
This batch routine, which is executed after all data is decompressed, starts with a ‘set’ command. The file is passed to 
the second batch by its file name, here addressed as %1. Two portions of the filename string are being use, namely 
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the filename without the extension (‘shortfilename1’) and the date of the product (‘shortfilename2’). Next command 
is calling the batch file “import_param.bat” that has been created during execution of the first batch file, defining the 
locations of the “IlwisDir” and “ChapterDir”. The next line is executing the ‘gdal_translate.exe’ utility, taking the *.tif 

image and writing the output file in ILWIS format in the same directory. Next command is scaling and converting 
the previously imported map and is applying a scaling factor (0.02) and offset, here a value of ‘273.15’ is used to 
convert from Kelvin to Celsius, respectively. Also note that the final converted image in ILWIS format will be 
located in the “Working_Dir (in this case C:\Chapter9\Working_Dir). 
Now activate from Windows the ‘Start’ menu and select ‘Run’. You are going to use the Windows ‘command.exe’ 
utility to run the batch files. In the new command window that appears navigate to your active working directory (in 
this case ‘C:\chapter9\DataInput\1_SurfaceTemp’) and execute the Land Surface Temperature import batch file. 
For commands to navigate to your working directory and other DOS command syntax, see also figure 9.5. 

Figure 9.5 Starting the batch processing from a CMD window 
Note that on the command line the batch file “multi_import_SurfaceTemp_start.bat” will be executed using two 
parameters. The first parameter specified is “C:\Ilwis”. This parameter is the location of your ILWIS directory; in 
your case this might be different as you might have installed ILWIS using a different folder. In that case specify the 
appropriate folder. The second parameter is “c:\chapter9”; this is the location of your exercise data directory. If you 
have installed the exercise data as described before you don’t need to change it over here, else specify the appropriate 
folder. After the correct string has been typed on the command line press “enter” from the keyboard to execute this 
batch process. 
When the import has finished select from the main ILWIS menu the option “Window => Refresh” and you will 
note that four surface temperature maps have been created, using as time stamp “year” and “Julian day”. Double 
click one of the maps, e.g. “SurfaceTemp_2009145”, use as Representation “Pseudo” and press “OK” to display the 
map. Note the map values by moving the mouse over the active map window, keeping the left mouse button pressed. 
Display also another surface temperature map.  

9.5.1.2. Import and scale MODIS Surface Reflectance product 

To import all necessary MODIS Surface Reflectance images (mod09a1*.tif) repeat the procedure described above 
and now use the data from the sub directory ‘C:\chapter9\DataInput\2_SurfaceReflect’. Note that in this case the 
command line should be specified as “multi_import_SurfaceReflect_start.bat c:\ilwis c:\chapter9”. The 
“multi_import_SurfaceReflect.bat” batch file is importing the TIF file into ILWIS format and subsequently is scaling 
the reflectance values by a scale factor of 0.0001 (see also Table 9.1 and Figure 9.6). 
When the import has finished select from the main ILWIS menu the option “Window => Refresh” and you will 

note that four mod09a12009***_b01 and mod09a12009***_b02 maps (*** = Julian day) have been created. Double 
click one of the maps, e.g. “mod09a12009145_b01”, use as Representation “Pseudo” and press “OK” to display the 
map. Note the map values by moving the mouse over the active map window, keeping the left mouse button pressed. 
Display also the band 2 image of the corresponding time: “mod09a12009145_b02”.  
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Figure 9.6 Batch file 2 for importing the Surface Reflectance data 

9.5.2. Meteorological Data 

9.5.2.1. Import of the INTA air temperature product 

Use is made of air temperature recordings from 100 meteorological ground stations located in the study area, 
recorded at a reference height of 1.5 m. The air temperature at daily temporal resolution is averaging for each 8-days 
period. This information is interpolated covering the full extent of the study area in order to obtain air temperature 
data at the same spatial resolution as the variables derived from remote sensing (1 km).  

 
To import all necessary INTA Air Temperature images (airtemp*.tif) repeat the procedure described above for the 
MODIS products and now use the data from the sub directory ‘C:\chapter9\DataInput\3_AirTemp’. Note that in 
this case the command line should be specified as “multi_import_AirTemp_start.bat c:\ilwis c:\chapter9”. In this 
case the batch routine “multi_import_AirTemp.bat” is only converting the images from TIF to ILWIS format (see 
Figure 9.7). 
When the import has finished select from the main ILWIS menu the option “Window => Refresh” and you will 
note that four air temperature maps have been created, using as time stamp “year” and “Julian day”. Double click 
one of the maps, e.g. “airtemp_2009145”, use as Representation “Pseudo” and press “OK” to display the map. Note 
the map values by moving the mouse over the active map window, keeping the left mouse button pressed. Display 
also another air temperature map.  
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Figure 9.7 Batch file 2 for importing the Air Temperature data 

9.5.2.2. Import of the INTA Net Radiation product 

To import all necessary INTA Net Radiation images (netrad*.tif) repeat the procedure described above for the 
MODIS products and now use the data from the sub directory ‘C:\chapter9\DataInput\4_NetRad’. The last 
command in the ‘multi_import_NetRad.bat’ batch file is also replacing the -999.9 pixel values by a no data value, 
called undefined, in  ILWIS, represented by  “?”. The replace is done using an IFF function (see Figure 9.8). 

Figure 9.8 Batch file 2 for importing the Net Radiation data 
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When the import has finished select from the main ILWIS menu the option “Window => Refresh” and you will 
note that four netrad maps have been created, using as time stamp “year” and “Julian day”. Double click one of the 
maps, e.g. “netrad_2009145”, use as Representation “Pseudo” and press “OK” to display the map. Note the map 

values by moving the mouse over the active map window, keeping the left mouse button pressed. Display also 
another air temperature map.  

9.5.2.3. Resampling the LST product 

After import of all Land Surface Temperature maps to ILWIS format you need to resample these images to 500 m in 
order to obtain the same spatial resolution as the other products. To do this type the following expressions in the 
command line from the main ILWIS menu (note that you can use the command line history from the main ILWIS 
menu to quickly change the date string portions which change within each resampling procedure): 
 

Surfacetemp_2009145r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009145,airtemp_2009145.grf,nearest) 
 
Surfacetemp_2009153r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009153,airtemp_2009145.grf,nearest) 
 

Surfacetemp_2009161r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009161,airtemp_2009145.grf,nearest) 
 
Surfacetemp_2009169r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009169,airtemp_2009145.grf,nearest) 

 
When the resampling of the LST maps has finished, double click one of the maps, e.g. “surfacetemp_2009145r”, use 
as Representation “Pseudo” and press “OK” to display the map. Note the map values by moving the mouse over the 
active map window, keeping the left mouse button pressed. Display also another resampled land surface temperature 
map.  

9.6. Computation of the ET 

9.6.1. Compute Normalized Difference Vegetation Index (NDVI) 

Compute the NDVI using the reflectance values of the red (b01) and near infrared bands (b02) obtained from the 
MODIS Surface Reflectance product. To do this select from the main ILWIS menu the options “Operations => 
Raster Operations => Map Calculation”. Type the indicated algorithm as show the Figure 9.9 in the ‘Expression’ 
window, specify an output map name (in this case “ndvi_2009145”), select as Domain “Value”, specify as Value 
Range: “0” and “1” and set the Precision to  “0.001”. Execute the command by pressing ‘Show’. Display the map 
“ndvi_2009145” calculated, use as Representation ‘NDVI1’. 
Repeat the same procedure to compute the NDVI for the other dates: 153, 161 and 169. For efficient processing it is 
advised to make use of the command line history available from the main ILWIS menu. Change the Julian day string 
portions of the equation and press enter to execute the command and calculate a new ndvi map. You can of course 
keep using the menu option. 
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Figure 9.9 Map calculation window to compute the NDVI 

9.6.2. Create Map Lists 

To compute the ET for different time stamps it is more convenient to create maplists. In order to deal with the same 
operation over all time stamps within a maplist, you have to create a map list for each of the imported and resampled 

products (surfacetemp_resampled, ndvi, airtemp and netrad). To create a map list select from the main ILWIS menu 
the option “File => Create => Map List”. Select the list of layers in the appropriate order to be included in the map 
list, press the “>” button to move the maps to the right hand listing, specify an output Map List name, here “ndvi” is 
used and execute the command by pressing “OK” (Figure 9.10). Repeat the same procedure to create a Map List for 
each data input, here “surftempr”, “airtemp” and “netrad” is being used. 

Figure 9.10 Create Map List window 

9.6.3. Compute Scaled Normalized Difference Vegetation Index (SNDVI) 

To compute SNDVI from the ‘ndvi’ map list, select from the main ILWIS menu the option “Operations =>Raster 
Operations => Map List Calculation”. Type the algorithm as indicated in Figure 9.11: (@1-
MAPMIN(@1))/(MAPMAX(@1)-MAPMIN(@1)). Specify an output Map List name (in this case “sndvi”) and 
execute the command by pressing ‘Show’. 
When the calculations of the scaled NDVI maplist has finished, double click one of the maps, e.g. “sndvi_1”, use as 
Representation “NDVI1” and press “OK” to display the map. Note the map values by moving the mouse over the 
active map window, keeping the left mouse button pressed. Display also another sndvi map. Note also that the map 
layer sndvi_1 represents Julian day 145, etc.! 
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Figure 9.11 Map List calculation window to compute the SNDVI 

9.6.4. Compute B and n 

To compute B from the ‘sndvi’ map list, select from the main ILWIS menu the option “Operations => Raster 
Operations => Map List Calculation”. Type the algorithm as indicated in Figure 9.12 (left): 0.0109+(0.051*@1). 
Specify an output Map List name (in this case “B”) and execute the command by pressing ‘Show’. Repeat the same 
procedure to compute “n”, but now apply the following formula as given in figure 9.12 (right): 1.067-(0.372*@1). 
Check the results obtained, using as Representation “Pseudo”. 

Figure 9.12 Map List calculation window to Compute B (left) and n (right) 

9.6.5. Compute temperature differences 

Follow the same procedure as used above to compute the difference between the resampled Surface Temperature 
maplist (“surftempr”) and Air Temperature maplist (“airtemp”). Apply the following formula (figure 9.13): @1-@2. 
Select from the main ILWIS menu the option “Operations =>Raster Operations =>Map List Calculation”. Type the 
algorithm as indicated in Figure 9.13, use now two Input MapLists. For Maplist 1, select “surftempr” and as maplist 
2 select “airtemp”. Specify an output MapList name (in this case “diftemp”) and execute the command by pressing 
‘Show’. Check the results obtained, using as Representation “Pseudo”. 
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Figure 9.13 Map List calculation window to compute temperature differences 

9.6.6. Compute ET 

Using the Map List calculator apply the following formula to compute evapotranspiration in mm.d-1 (figure 9.14): 
(@1*0.408)-(@2*(POW(@3,@4))). Note that for the net radiation values a transformation factor is applied (the 
reverse of vaporization latent heat) to convert from MJ.m-2.d-1 to mm.d-1. 

Figure 9.14 Map List calculation window to compute the ET 
 
Check the results obtained, using as Representation “Pseudo”. These should resemble for Julian day 153, or map 
layer “ET_2” of your time series “ET”, the map as presented in figure 9.15. From the active map window, select the 
option “Layers => Add Layer”, browse to your ILWIS directory, select the sub directory “Extensions\Geonetcast-
Toolbox\util\maps” and select as vector layer “country_02”, uncheck the option “Info” and activate the option 
“Boundary Only” and press “OK”. Don’t close the map window. 

9.7. Checking the ET results 

Validation of the actual ET is a difficult matter. To at least assess whether the results make some sense the potential 
evapotranspiration (PET) for each meteorological station following the Penman and Thornthwaite methodology 
have been computed. For this purpose, use was made of daily data of air temperature, wind speed at a reference 
height of 2 m., relative humidity and effective heliophany. The maximum daily PET value for each identical 8-days 
period was calculated and this can now be compared with the remote sensing derived ET estimations. 
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Figure 9.15 Resulting ET map for Julian day 153 of 2009 
 
Open once more the table “etp_153” and check the content. You will note that there are sometimes remarkable 
differences between the two PET approaches used. In this case only those stations where the PET is similar will be 
used.  
Type the following equation in the table command line: finalPet:=iff(mean_ETP_Penman-
mean_ETP_Thornthwaite<0.5,mean_ETP_Penman,?). Press enter to execute the operation and accept the defaults, 
press “OK” once more. A new column is created and the values of this column will be crossed with the estimated 
ET for Julian day 153, or ET_2 from your map list. Close the table. 
Convert the table to a point map. To do so right click with the mouse the table “etp_153”, select from the context 
sensitive menu the options “Table Operations => Table to Point Map”, as Coordinate System select 
“airtemp_2009145” and as output Point Map specify “etp_153”. Press “Show” to execute the operation. Look at the 
point map created and close the map. From the active map window used to display the map “ET_2 select the option 
“Layers=> Add Layer”, browse to your ILWIS directory, select the point map “etp_153” and activate from the 
Display Options menu the check box “Attribute”, select the column “finalPET” and press “OK”. From the active 
map window, select “File => Open Pixel Information”, move the mouse cursor over the points on the map and 
check the results from the pixel information table. Close the active map layer. 

Convert the point map “etp_153” to Raster. Right click with the mouse the point map “etp_153”, select from the 
context sensitive menu the options “Rasterize => Point to Raster”, as Georeference select “airtemp_2009145” and 
as output Raster Map specify “etp_153”. Press “Show” to execute the operation. You might need to zoom in to the 
new raster map created to see the results! 
From the main ILWIS menu, select the options “Operations => Raster Operations => Cross”, as first map specify 
“ET_2”, as second map select the attribute column “finalPet”. To do so, click on the “+” sign in front of the raster 
map “etp_153” to select the appropriate column. As Output Table specify “compareETp_Eta and press “Show”. 
From the menu of the newly created cross table select the Graph icon, as X-Axis specify map2 (note that this is the 
resulting value of the attribute table, representing the potential ET according to Penman), and as Y-Axis select 
“ET_2”and press “OK”. Double click in the left hand legend of the graph the X-Axis and specify as Min-Max range 
“0” to “2”, Interval of “0.5” and press “OK”. Do this also for the left hand Y-Axis. Uncheck the Legend option. 
Double click the attribute “map2 * ET_2” and change the Color from Transparent to “Red”. Your results should 
resemble those presented in figure 9.16. 
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Figure 9.16 Comparing estimated ET for Julian day 153 with PET 
 

9.8. Conclusions 

From figure 9.16 it is clear that the computed ET is less than the potential ET which is according to expectation. In 
order to validate the ET estimates based on remote sensing, INTA will use more detailed ET data derived from eddy 
covariance based towers measurement and estimates based on meteorological ground station data. INTA at this 
moment has access to ET measurements from four eddy covariance flux towers located in representative dominant 
land use types in the study area (forest, agriculture, commercial tree plantations and dry forest). 
In conjunction to this the near future additional information can be used from 150 meteorological stations that are 
currently being installing all around the Argentinean territory by INTA. 
To account for possible errors on input variables (NR, B, n and Ts-Ta), INTA will test the ET estimates sensitivity by 
exploring the effects of extreme values of these variables. 
Acknowledging the uncertainties in the air temperature due to the interpolation from low density of meteorological 
ground stations, INTA will furthermore explore the possibility of using the air temperature data derive from the 
MODIS atmospheric profile product. 
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10. FROM CLOUD TOP TEMPERATURE TO RAINFALL; 
BLENDING MSG AND TRMM-TMI  

 
By: Ben Maathuis1  

10.1. Relevance of the application 

Continuous rainfall estimates at high temporal and spatial resolution is of great importance in climate variability 

monitoring, Numerical Weather Prediction and in hydrological model inputs amongst other applications.  
Precipitation is one of the most variable quantities in space and time. The existing rain gauge network is sparse and 
available data are insufficient to characterize the high spatial variable rainfall distribution. Combined with the uneven 
distribution of rain gauges, weather radars and the relative lack of rainfall measurements over the oceans have 
therefore significant limitations.  
Rainfall measurements from space are based on the interpretation of the electromagnetic (EM) radiation that is 
scattered or emitted from clouds, precipitation and underlying surface, and is monitored by the satellite instruments 
at discrete spectral regions. Several studies have focussed on usage of visible and infrared (10.5 - 12.5µm) portions of 
the EM spectrum. Rainfall estimation methods using these spectral regions can be classified into cloud-indexing, 
spectral life history and cloud model-based methods. Each of the categories stresses a particular aspect of the sensing 
of cloud physical properties using satellite imagery. The primary drawback of the VIS/IR techniques is that the 
observations only relate to the characteristics of the cloud tops, rather than the precipitation reaching the surface. 
Clouds are opaque in the VIS and IR spectral range and precipitation is inferred from the cloud top structure. At 
passive MW frequencies precipitation particles are the main source of attenuation of the upwelling radiation. MW 
techniques are thus physically more direct than those based on VIS/IR radiation. The emission of radiation from 

atmospheric particles increases the signal received by the satellite sensor while at the same time the scattering due to 
hydrometeors reduces the radiation stream. Type and size of the detected hydrometeors depend upon the frequency 
of the upwelling radiation (Levizzani et al, 2002, 2007). Research is on-going to blend - combine observations from 
different sensors - spectral regions in an attempt to improve accuracy, coverage and resolution of the satellite derived 
rainfall estimates.  

10.2. Objective  
The main objective of this exercise is to make use of the TRMM-TMI derived rain rates to calibrate a collocated 
Meteosat-9 Cloud Top Temperature image (10.8 micron band) and subsequently transform a time series of MSG 
images into precipitation.  

10.3. Methodology and study area 

10.3.1. Methodology adopted 

A flowchart of the overall procedure is presented in figure 10.1. All required data is provided in the zipped exercise 
data file. The import procedures for the TRMM TMI data are described as well to allow application of the 
methodology to retrieve rainfall for other events. 

                                                      
1 Department of Water Resources, Faculty of Geo-Information Science and Earth Observation (ITC), University of Twente, Enschede, The 

Netherlands. Email: maathuis@itc.nl 
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Figure 10.1 Flowchart of methodology adopted 

10.3.2. Study area 

The study area selected is covering the central and southern part of Africa. The bounding coordinates are from 25 
degrees south to 10 degree north latitude and from 10 degree west to 50 degree east longitude. Most of the rainfall in 

these regions is attributed to convective precipitation as during this time of the year the ITCZ is situated over this 
region. The methodology applied is more suited towards deriving this type of precipitation. The frontal and 
orographic rainfall regions are not appropriately extracted due to the fact that these cloud top temperatures are not as 
cold as the cloud tops from cumulonimbus clouds.   

10.4. Data preprocessing 

Download the exercise data and unzip the file into your active working directory. Note that your working directory 
name should not contain spaces in the name. Note furthermore that there is a sub-directory (“\23febr2008”) 
containing the raw time series MSG HRIT data for the 6.2 and 10.8 micron channels. 

10.4.1. TRMM TMI rainfall data retrieval 

The period selected for this exercise is 23-02-2008. The TRMM data provided in the exercise was retrieved from the 
website: http://mirador.gsfc.nasa.gov/cgi-bin/mirador/homepageAlt.pl?keyword=TRMM. 
If you want to retrieve the data yourself load the website indicated above, select from tab “Available”: TRMM, 
subsequently select from the “TRMM Data Group”: Orbital and finally select as “Data Set”: 2A12 (Version 006): 
Hydrometeorprofile (TMI). Select the appropriate date and time: “2008-02-23” and “18:14:28”, you can also have a look 
at the preview of the image using the “View Image” option, see also figure 10.2. Note once more that this file is 
already provided and is situated in your active working directory. 
Download this data file and unzip it. To inspect the various data layer of the downloaded 2A12 data file you can use 
“Orbit Viewer”. Orbit Viewer is a tool for displaying the HDF data of the Tropical Rainfall Measuring Mission 
(TRMM).  To download Orbit Viewer, follow the link below and press “Download the Orbit Viewer” option from 
http://disc.sci.gsfc.nasa.gov/precipitation/additional/tools/trmm_ov.shtml. 
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Figure 10.2 TMI Surface Precipitation rate. 
 
For the purpose of this exercise you can use the following Orbit Viewer version: “orbit_1.3.5_win.exe”. Eventually 
download the “tutorial.pdf” as well. After download you can install the utility by double clicking on the 
file:”orbit_1.3.5_win.exe” or by right clicking with the mouse on the filename and selecting from the context sensitive 
menu “Run as Administrator”. After specifying an appropriate output directory the self-extractor is unzipping all 
required files. Browse to the specified directory. 
Activate the Orbit Viewer by double-clicking on the  “setupWIN.exe” program.  Then, double-click on the 
“orbitWIN.exe” program (in the sub directory \TSDISorbitViewer) or use the “orbit” shortcut on your systems’ 
desktop. 

10.4.2. TRMM TMI rainfall data extraction of central Africa 
To view the downloaded HDF file you need to use the Orbit Viewer. The example provided here is using the file 
“A12.080223.58539.6.HDF” containing information about the surface rain (mm/hr) for the evening overpass, on 23 
February 2008 (using version 6 of the TRMM rainfall estimation algorithm) over Central Africa, see also figure 10.3.  
Start Orbit and open from the menu “File” > “Open File”, browse to the directory containing the file 
“2A12.080223.58539.6.HDF” (unzipped!). From the left hand “Arrays” options select “Surface Rain” and from the 
bottom global orbit zoom in on “central – southern Africa”. Note that as indicated in figure 10.3 a zoom resolution 
is used of “30 degree Longitude” (from the Menu, under “Option” > “Zoom Resolution”). 

Figure 10.3 Orbit Viewer surface rain rate 
To get the time-date and rainfall intensity information, click with the mouse on a rainfall area, note the values in the 
lower left-hand corner. Also check the time stamps on both ends of the swath over Southern Africa. Note that when 
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you select different locations the time is changing (in this window roughly from 19:25 to 19:35 UTC, from NW to 
SE respectively). 
To export the selected frame to Ascii tables use the option “File” > “Save Data” and select as Output Format “Swath: 

ASCII (ARC/INFO)”, see also figure 10.4. Specify an appropriate output directory and filename. The file with the 
extension “TXT” is containing the rainfall intensities and the “GEO” file is providing the corresponding GEO 
location information. In general two TRMM overpasses over a specific area per day exist! Note that these files have 
already been created for you and are contained in the exercise data zip file. The extracted rainfall and geolocation 
files are called “surfaceRain.txt” and “surfaceRain.geo” respectively. 

Figure 10.4 Export to ascii tables using Orbit Viewer 

10.4.3. Extracting thermal channel from MSG for central Africa   

To relate the cloud top temperature with the rain rates, you have to import for the corresponding period the 

Meteosat-9 thermal image, so select 23 February 2008, 19:30 UTC, for band WV_062 and IR_108, convert the image 
to temperature (in Kelvin), select the appropriate area and export it as an ILWIS file.  
Open ILWIS, select “Geonetcast” > “Toolbox” > “MSG-HRIT” > “MSG Data Retriever”. Start the Data Retriever by 
pressing the button “Start MSG Data Retriever”. First check the “Data Sources” (from the Menu select the “File” 
option). If there is an existing data source specified, select it and use the option “Delete” and confirm the deletion. 
Select the option “New” and press “Browse”, navigate to the sub-directory “23febr2008”. Select the option “Data resides 
directly under the source folder specified”, press the “auto-detect” button, the first and last day of data should now indicate 
“2/23/2008”, press “OK” and “Close”. 
To get the settings as of the figure 10.5 below also use can be made of the ‘msg-project settings’. In the Meteosat 
Second Generation Data Retriever, select from the Menu “File” > “Open” and select from the exercise working 
directory the file: “msg_cal1930.msg1project” and press “Open”. With these project settings the MSG Data Retriever 
should look identical to figure 10.5 below and now execute the import (note the output file folder, if needed change 
this to your appropriate working directory). The file prefix is assigned with cal (for calibration) as the IR_108 will be 
used to determine the relation between cloud top temperature and the rainfall intensity from TRMM. Make sure that 
the imported TRMM geo and txt files are located in the same working directory as the MSG files which have been 
imported. 



APPLICATION MANUAL 

127 

Figure 10.5 MSG Data Retriever settings 

10.5. Data analysis 

10.5.1. Retrieving the potential rainfall fields 
Activate ILWIS and navigate to the appropriate directory where you stored the tables and the MSG image files. 
Display the individual images and check the values and the differences between the Water Vapour and the Thermal 
Infrared channels, also have a look at the coordinates (MSG projection!). You can use an “Inverse” Representation for 
display of the images, use from the Map Window, “File” > “Open Pixel Information”, in the Pixel Information Window, 
select “File” > “Add Map”. Now select the other image and per pixel an idea can be obtained of the brightness 
temperature in these two channels. Select pixels that have cloud conditions and select also pixels that are not cloudy. 
Note that the colder areas (clouds) will have a white tone and the warmer areas are darker toned when using an 
inversed grey scale lookup table Representation. From the main exercise directory you can add to the image the 
country boundaries (“Add layer”, select the file “country_02”, uncheck the option “Info” and check the option 
“Boundaries only” and press “OK”). 
Note that you have imported 2 channels, the water vapour (6.2 micron) and the thermal IR (10.8 micron). Water 
Vapour has an absorption band around 6 microns and therefore it absorbs radiation from below but emits radiation 
according to the 2nd Kirchoff law.  Therefore the water vapour channels are indicative of the water vapour content in 
the upper part of the troposphere. The maximum signal from WV_062 is at 350 hPa, and for WV_073 at 500 hPa 
(assuming normal pressure at sea level approximate elevation is at 8980 m and 5965 m amsl respectively), see also 
figure 10.6. If there is no water vapour radiation from far below can reach the satellite (V. Zwatz-Meise, ZAMG). 

Figure 10.6 MSG channel normalised weighting functions 
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The thermal channel records the emitted energy from the Earth surface itself.  Based on a classification using MSG 
channel 108 and 062, applying a threshold on the temperature difference of less than 11 Kelvin an approximation of 
the clouds that have a high likelihood of precipitation can be obtained. This is an empirically determined threshold 

reported by Kidder, et al. (2005). 
To calculate the potential precipitating clouds, type the following algorithm on the command line in the main ILWIS 
window: 
 

pcloud:=iff(cal0000_band_2-cal0000_band_1<11,1,0) 
 
Use the default Raster map definition and press “Show”. Compare this map with the WV and IR image data. Display 
the map: “clm20080223_1930”. This is the Cloud Mask Product of the same time obtained from EUMETSAT. The 
Cloud Mask (CLM) product is an image-based product in full pixel resolution that displays information on the 
presence of cloud. When possible, each pixel is classified as one of the following three types: clear sky over water 
(value=0), clear sky over land (value=1) and cloud (value=2). Right click with the mouse the map 
“clm20080223_1930”, select “Spatial Reference Operations” and “Resample”. As resampling method use “Nearest 
Neighbour”, as georeference “Cal0000” (the georeference from the WV and TIR MSG bands) and specify an 
appropriate output map name, e.g. “clm1930”. Press “Show”.  Now you can integrate the Pcloud map with the CLM, 
type the following statement on the command line line in the main ILWIS menu and execute it using the default map 

definition: 
 

combine:=pcloud+clm1930 
 
Have a look at the location of the areas that have been classified as precipitating clouds in the pcloud map (note that 
precipitating clouds have a value of 3 and are all situated within the cloud masked areas).  

10.5.2. Import the two TRMM tables  

To import the file with the geo location information, here called “surfaceRain.geo” use the option from the main 
ILWIS menu: “File” > “Import” >”ILWIS” > “Table” > “Comma Delimited”, use the browse button to specify 
appropriate input and output file and press “OK” > “Next”. Check the table configuration and the meaning of each 
of the columns and modify the Column names according to figure 10.7 (left) presented below (Column2 to “X” and 
Column3 to “Y”), press “Finish” and “OK”. Repeat the same procedure (figure 10.7, right) for the Ascii table with the 
Rainfall intensities (here called: “surfaceRain.txt”). 
 
 
 
 
 
 
 
 
 
 

Figure 10.7 Import table windows for the TMI locations and rain rates 
 

After the tables have been imported, open both the tables and check the content. Activate the table with the geo 
location information. Select now from the table menu the option “Column” and “Join”. Specify the rainfall intensity 

table and select the column containing these values (here column2 called “Rain”). Specify an appropriate output 
column name, e.g. “rainfall” and execute the operation (using the default data type, range, precision, etc). The results 
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should be like those given in figure 10.8, note that here only a few records are displayed and that each set of XY 
coordinate pairs has a rainfall value assigned, in case of no rainfall the value is 0.  

Figure 10.8 Resulting table using the join operation 
 
Using Table calculation, from the table command line calculate a new column in which only those locations are used 
that have actual precipitation. Type the following command in the table command line: 
 

rain_more0:=iff(rainfall>0, rainfall,?) 
 
Execute this statement. For those records that have no rainfall a question mark is returned, in ILWIS this is assigned 
undefined (see the ILWIS help function for more details). Close the table. 
The next step is to transform this table into a point map, so it can be crossed with the Meteosat image at a later stage 
to calculate if there is a correlation with the cloud top temperature and if so, to find a suitable regression function to 
transform the cloud top temperature into rainfall intensity. 
With the mouse, right click the table (with the X,Y and rainfall columns), select “Table Operations” > “Table to 
PointMap”. Modify the options such that they represent those as given in figure 10.9 below. The X and Y columns 
are used for the location; the coordinate system assigned is an ILWIS system coordinate system (LatLonWGS84). 
Make sure that you use the column rainfall for assignment of the point values in your output map.  

Figure 10.9 Table to point map settings 
 

Execute the operation and display the resulting point map, here called “rain_more0”. Check the values and zoom in 
on some of the rainfall points. Use the measuring tool option from the map display window menu and measure the 

distance between the points to get an idea of the spatial distribution of the TRMM measurements. Use the option 
“Layer” > “Add Layer” and display the MSG 108 band (here “cal0000_band_2”) and the map “Combine” in the same 
window. Zoom in on the image and check the results obtained. The image view should represent the results as given 
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in figure 10.10, here a “pseudo” colour representation is used. Select from the display window, under “File” the option 
“Open Pixel Information”. Roam the mouse over the image and check the temperature and rainfall values that are 
presented in the pixel information viewer. You can check and uncheck in the legend the layers to furthermore 

visually inspect the relation between the precipitating clouds and the TRMM rainfall locations.  

Figure 10.10: TRMM point observations over the (precipitating) clouds and MSG TIR image 
 
This process completes the integration of TRMM data with MSG. Now the relations between the two sets of sensor 
data – products has to be further investigated. Do you have an idea of the type of rainfall; is it orographic, 
convective, etc? How about the matching of precipitating clouds and the TRMM rainfall locations? 

10.5.3. Correlation of TRMM rainfall point measurements with MSG 

To determine if there is a correlation with rainfall intensities and MSG cloud top temperature first the TRMM point 
rainfall map has to be transformed into a raster map. Next step is to cross both maps and the resulting cross table 
can be used to compute the correlation between the two. 
To transform the point map to a raster map right click the point map using the mouse button and select the option 
“Rasterize” > “Point to Raster”. Select as georeference the one given for the MSG image, here “cal0000”. Use the 
default output map name, point size, value range and precision. Display the results, zoom in and use the 
measurement tool to measure the distance between the raster elements that have obtained a value. Display the point 
map on top of this map, using “Layer” > “Add Layer” and note the effect of this resampling procedure. 
Next cross the two maps to obtain the cross table. To do so select from the main ILWIS menu “Operations” > “Raster 
Operations” > “Cross”, select the appropriate two input maps and specify an output table name. There is no need to 
generate an output map. Make sure that both input maps have the “Ignore Undef” option active. Display the resulting 
table, see also figure 10.11. Select from the table menu the option “Columns” > “Statistics”, as function select 
“Correlation” and select the rainfall and temperature columns, press “OK” to derive the correlation coefficient which 

is about -0.4.   
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Figure 10.11 Resulting table from the cross operation 
 

Note that the correlation coefficient has a negative tendency, meaning that with decreasing temperature there is an 
increase in rainfall intensity, but the overall correlation is weak. Figure 10.12 below shows some of the reasons for 
this low initial correlation and therefore the need for averaging (after Turk, et al., 2003). 
 

Figure 10.12 Collocating PMW and IR observations 
 

With respect to the current data there are also alignment errors, e.g. the time (MSG requires 12 minutes to complete 
a full disk scan (3712 scan lines recorded from South to North start scan at 19:30, takes 6 minutes to scan the 
southern hemisphere of the field of view, compared with TRMM, recorded for this window from 19:25 to 19:35 
UTC, from NW to SE respectively), looking angle (current MSG position is at 0 degree longitude over the equator, 
and original pixel size increases with increasing looking angles). TRMM has a relatively narrow swath. With respect to 
quickly changing phenomena like convective cloud system development and parallax offset it is not strange that there 
are low correlations. A method to average the data is presented below although there are more approaches possible 
to tackle this problem.  
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10.5.4. MSG averaging 

As stated above there are more methods to improve the correlation. In literature approaches are described using 
larger areas (resampling of the IR data to account for spatial offset) or averaging two IR data acquisitions to 
compensate for timing offset.  Here a slightly different procedure is proposed: the TRMM assigned rainfall pixels 
with corresponding rainfall intensities are averaged based on MSG–IR pixels having equal temperature (in classes of 
0.5 or 1 degree Kelvin). This results in a temperature range, e.g. from 180 to 260 Kelvin, having for each temperature 
class interval a certain averaged corresponding rainfall intensity. These two variables are then used to determine the 
correlation and when satisfied a suitable regression function can be used for regionalization using the IR image as 
well as a short term IR time series of  15 minutes interval images (in the case of MSG). 
To perform this operation in ILWIS first a new domain has to be created with the appropriate temperature intervals 
(in Kelvin). From the main ILWIS menu, select the option “Create” > “Domain” Specify an appropriate input domain 
name, select the “Class” option and the “Group” function (see figure 10.13). By pressing the “insert” key a new class 
interval can be added as well as the associated code. After having finished inserting all the class intervals the domain 
editor can be closed. For your convenience this domain is available in the main exercise directory, called “temp_cl1”! 
Open this domain. 

Figure 10.13 Creating a new class domain 
 
Close the domain and open the cross table which was created previously by crossing the temperature image with the 
point rainfall raster map. Now you first have to classify the temperature column into 1 degree intervals. In the table 
menu, use the option “Columns” > “Column slicing”. Use as column name the temperature column and as domain the 
1 degree temperature interval domain. Specify a name for the output column, e.g. “slicingT”. A new column is now 
created with these class intervals for each record.   

Figure 10.14 Column slicing operation 
 

This newly created slicing column is now going to be used to create a new output table in which the average rainfall 
per temperature class interval is calculated. Select from the table menu “Columns” > “Aggregation”. Select the “rainfall” 
column for Column input, use the function “Average”, “Group” it by the column “slicingT”. Specify a name for the 
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new table that is going to be created and an appropriate output column name. Execute the operation and open the 
newly created table. Check the results of this operation.  

Figure 10.15 Aggregation function 
In the newly created table (here called “temp_rain1”) there is only one column: the average rainfall, the temperature is 
given by the record ID. You can use the predefined variable, %K, to create a new column using these record 
numbers. Type in the table command line the following expression:  
 

temperature:=%K  
 
Use as domain the default domain and execute the expression. Using the right mouse button click on the name of 
the temperature column (the whole column is now blue) and select from the drop down list the option “Properties” 
and change the domain to a “Value” domain. You will note that the column content is now aligned at the right hand 
side of the column (as in figure 10.16). 

Figure 10.16 Final rainfall and temperature table 
 

From the table menu, select “Columns” > “Statistics”, from the drop down menu, the function “Correlation” and use as 
input the two columns of this table. As you can see the correlation by this type of averaging is already considerably 
improved (R is now nearly -0.8). To get a better idea of the characteristics of your data you can create a graph as well. 
Use the Graph button from the table menu, for the X-axis use the “temperature” column and for the Y-axis the “rain” 
column. Modify the X-axis range (from 150 to 300). The negative relation between temperature and rainfall intensity 
can be clearly depicted from this graph. To see if it is possible to obtain a least square fit through this data set, select 

from the Graph menu the option “Edit” > “Add Graph” > “Least Square Fit”. The example given below shows a 
“Polynomial” fit using “4” terms (3rd order). The associated properties of the line can be retrieved when double 
clicking the line representation in the left hand legend.  
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Figure 10.17 Graphical representation of relation temperature – rainfall and polynomial function 
 
Close the graph window and from the table menu, select “Columns” > “Least Squares”. As X-axis “temperature”, as Y-
axis “rain”, function is “Polynomial” and as number of terms “4”, now specify as output column “poly_3” and press 
“OK”. In the Column Properties window, press the option “Additional Info” and note the equation of the fitting 
function (Y =  801.825646+ - 9.357660* X  + 0.036419* X^2  + -0.000047 * X^3) and press “OK” twice. Check the 
values of the new column “poly_3” obtained and calculate the “correlation” between the “poly_3” and the “temperature” 
columns. 
If satisfied with these results the fitting equation obtained can be used to transform a single thermal image (10.8 
micron cloud top temperature) into a rainfall intensity map. You can enter the equation obtained into the command 
line of the main ILWIS window and conduct the transformation from temperature into rainfall:  
 

rain1930:=iff(pcloud=1, 801.825646 + -9.357660 *cal0000_band_2+0.036419 * cal0000_band_2^2+-
0.000047 *cal0000_band_2^3,?) 

 
Here we are going to follow a more generic approach as ILWIS is showing only a few decimals and for higher order 
polynomial functions the number of decimals is of critical importance. Copy and paste from the “temp_rain1” table 

the columns rain and temperature into an Excel worksheet. Only take for both columns the relevant data range as 
given by the temperature column from 190 to 296. Select from the Excel menu the “Chart Wizard”, as chart type 
select “XY (Scatter)” and as subtype “Scatter” (compares pairs of values), press “Next” and specify the appropriate 
data series (X=temperature and Y=rainfall) and press “Next” and “Finish”. The initial graph is shown in the active 
worksheet. Eventually change the X-axis data range (from 175 to 300). Right click with the mouse in the graph on 
the data points and from the context sensitive menu select the option “Add Trendline”, select “polynomial” and use as 
order “3”. From the “Options” tab, activate the options “Display equation on chart” and “Display R-Squared value on chart”, 
press “OK”. The equation of fit is given, activate the equation window, right click the mouse on this window again 
and from the context sensitive menu select the option “Format Data Labels”, from the “Number” tab, select “Number” 
and as “decimal places” specify “10”and press “OK”. Don’t activate the option ‘Use 1000 Separator (,)’. The chart, 
equation and correlation coefficient obtained should resemble the results of the graph presented below. 
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Figure 10.18 3rd order polynomial function and equation of fit 
 

The resulting equation that can be typed in the command line of the main ILWIS menu now becomes: 
 

rain1930_p3:=iff(pcloud=1, -0.0000584843*cal0000_band_2^3+ 0.0447655985* cal0000_band_2^2 - 
11.3942639435*cal0000_band_2 + 966.1798474926,?) 

 
Specify as value range “0” to “250”, precision of “0.01” and press “OK”. Note that “pcloud” is the precipitating 
cloud map calculated before and if there are no precipitating cloud pixels defined in this map an undefined is 
returned in the output map! Display the resulting map. Also calculate a 4th order polynomial function, a sample 
equation is provided below: 
 

rain1930_p4:=iff(pcloud=1, 0.0000009548*cal0000_band_2^4 -0.0009862060*cal0000_band_2^3 + 
0.3804618224*cal0000_band_2^2 - 65.0015824495*cal0000_band_2 + 4153.4825533355,?) 

 
The resulting 3rd order polynomial function rainfall map should look like the figure presented below. Add also a 
vector layer with the country boundaries for visualization purposes. Use as representation the colour assignment as 
provided by “mpe_single”. Open from the map window the option “File” > “Pixel Information” and roam the cursor 
over your map, inspect the values obtained. Eventually add the point map with the TRMM rainfall locations. Repeat 

this procedure for the 4th order polynomial function. 

Figure 10.19 Rainfall map obtained derived from MSG Cloud Top Temperatures 
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The near real time multi sensor precipitation estimate (MPE) can be directly retrieved from the EUMETSAT 
Website (available: http://oiswww.eumetsat.int/~idds/html/grib.html, a rolling archive with files given for the last 
24 hours). To derive the MPE use is made of the relationship between cloud temperature and rainfall intensity, as 

colder clouds are likely to produce more rainfall as seen in the relationship determined before. The MPE uses a 
statistical matching algorithm in temporal and geographical windows to correlate the SSM/I instrument derived rain 
rates with Meteosat IR brightness temperature images. The obtained relationship is later-on converted to the full 
Meteosat-9 temporal resolution and a MPE product is generated each 15 minutes. The algorithm performs well for 
the tropical and subtropical convection areas. The relationship is based upon SSM/I – Meteosat co-located pixels 
from 40 degree North to 40 degree South (Heinemann, et al, 2002). With the DMSP program (two satellites in polar-
orbit array), a given location on Earth is revisited every 6 hours, allowing 4 brightness temperature versus rain rate 
calibration events on a 24 hr basis. The data is provided in GRIB format and other functionality in the 
GEONETCast toolbox allows one to import these files. 
Open the map “mpe20080223_1930” to see the results of the MSG rainfall product (MPE) for the full field of view 
of the geostationary satellite. “Resample” this map, from the option “Spatial Reference Operations”, using the thermal 
image georeference “cal0000”.  
Visually check the differences between the two maps and also calculate the difference between the two rainfall maps 
(keep the undefined pixels in mind!). You can also determine the correlation between the two maps (R of 0.8 or 
higher) using the “Cross” operation. What can be concluded when comparing your own calculated results with those 

from the multi sensor precipitation estimate (MPE)?  

10.5.5. Compute rainfall intensities for a time series of thermal images  

Once more retrieve the data for channels WV_062 and IR_108 of Meteosat-9. Use the MSG data retriever with the 
settings as indicated in the figure below (File, open and load the “msg_tday.msg1project” file). Note that for 23 February 
2008 all data is retrieved on a 15 minutes basis, transformed into two ILWIS map lists (multiple times in one file), 
and converted to temperature for an identical window as was used previously. Note the folder settings for the output 
files! Use your active working directory. 

Figure 10.20 MSG import setting for time series retrieval 
 

To visualize the time series created, move to your working directory and right click the maplist icon, select “Open” 
from the drop down menu and select the option “As Slide Show”. Also study the naming convention of the different 
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times used (instead of ‘Band_n’ it should be interpreted as ‘Time_n’). Use an “Inverse” representation, use the default 
stretch and click “OK”, in the display options set the refresh rate to a higher value, e.g. “150” and press “OK”. 
Have a look at the animation and close the animation window afterwards. Now calculate for each time step in the 

time series the precipitating clouds in a similar way as has been done previously for the 19:30 hr image. In order to 
do so select from the Main ILWIS menu “Operations” > “Raster Operations” > “Maplist Calculation”. Select the 
appropriate map lists and enter the expression as indicated in figure 10.21 below (note that t0000 is representing the 
WV channel and t0001 is representing the TIR channel).  

Figure 10.21 Map list calculation for time series computation 
 

Now you can use the 3rd order polynomial formula as used for the 19:30 hr UTC image to transform the whole time 
series of the 23rd of February to rainfall intensities. Once more select “Maplist Calculation”. Select the appropriate map 
lists and enter the expression using the coefficients for the previous obtained 3rd order polynomial fit, see also figure 
22. Now each image in the maplist is transformed into a new maplist with rainfall intensities. Display this maplist as a 
slide show using as representation “mpe_single”, add the country boundary vector layer as well.  

Figure 10.22 Transforming a maplist of thermal images into rainfall intensities 
 

Double click the rain maplist and select image band_79 (which is actually the 19:30 hr UTC image) and display this 
image. Keep the map display window open. Close the maplist. Now select the maplist icon again using the right 
mouse button and select from the drop down list “Statistics” > “Map List Graph”. Activate the fix stretch option and 

assign “0” to the minimum and “20” to the maximum, activate the “continuous” button as well. Now roam the mouse 
over the map display window and check the temporal activity of the rainfall over certain pixels during the 23rd of 
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February, note that the X-axis is the time (1=00:00 – 96=23:45 hr UTC) and the Y-axis is the rainfall intensity in 
mm/hr.  
Now you have obtained a continuous rainfall record consisting of 96 observations over the day, transformed in a 

similar way as the 19:30 hr UTC image which was calibrated using a TRMM single overpass observation.  

10.5.6. Compute total daily rainfall  

To compute the total rainfall the Maplist statistics Sum function can be used. Right click with the mouse the maplist 
“p_time”, select “Statistics” > “Maplist Statistics” and specify the appropriate settings, as statistical function use “Sum”.  
Execute the operation and display the resulting map.  

Figure 10.23 Summation of the 96 precipitation events 
 

As the initial unit per timestamp is in mm/hr and we have 4 events on an hourly basis a final correction needs to be 
applied to obtain the total precipitation per day in mm. Type the following expression in the command line of the 
main ILWIS menu: 
 
 Rain_day20080223:=sum_p/4 
 
Use the default map definition settings, display the resulting map and check the values. For better visualization you 
can use the representation “mpe_sum”. Your results should resemble those of figure 10.24. 

Figure 10.24 Precipitation calculated over central Africa for 23-02-2008 
 

Leave the map “Rain_day20080223” open. To check the temporal distribution of the rainfall, right click with the 

mouse on the map list icon “p_time”. From the context sensitive menu, select the options “Statistics” > “Maplist 
Graph”, use a fixed stretch from “0” to “20”, activate the options “Continuous” and “Always on Top”. Now browse 
with the mouse over the map “Rain_day20080223” and check the rainfall details in the Maplist Graph window (note 
that the unit is mm/hr!). 
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10.6. Concluding remarks 

The purpose of the exercise is to show how information obtained from other sensors can be used in conjunction 
with the cloud top temperature from geostationary satellites. Here the evening TRMM TMI overpass is used to 
calibrate a whole day of MSG 15 minutes interval images; you could use other overpasses from different satellites as 
well.  
Here a statistical curve fitting procedure is adopted for the sake of simplicity to demonstrate the procedures. This 

adopted methodology is not able to cope with all miss-alignment issues. Furthermore the function applied to 
perform the averaging is resulting in the fact that the high precipitation events are not well taken into consideration 
and therefore under-estimation occurs, which could clearly be observed when comparing the rain rates derived with 
the ‘mpe’ precipitation product. It should furthermore be noted that for this product another sensor, the Special 
Sensor Microwave Imager (SSM/I) onboard the polar orbiting DMSP satellites, is used as well as another overpass 
time.  
More complex procedures are currently in place to obtain satellite derived rain rates, also incorporating gauge based 
ground observations. The timing for the total daily rainfall most likely deviates from the one that is presented by the 
meteorological organization of your country. To compare the obtained results with real rain gauge measurements one 
needs to know the time when the reading is done and use the same temporal settings for the MSG derived images!  



APPLICATION MANUAL 

140 

REFERENCES 

Eumetsat. Multi sensor precipitation estimate (MPE) [Available online at: http://oiswww.eumetsat.int/ 
~idds/html/grib.html]. 
 
Heinemann, T., Latanzio, A., Roveda, F. (2002): The Eumetsat multi-sensor precipitation estimate (MPE). 
Proceedings 2nd International Precipitation Working Group (IPWG), Madrid, Spain. 
 
Kidder, S., Kankiewicz, J.A., Eis, K. (2005): Meteosat Second Generation cloud algorithms for use in AFWA. In 
BACIMO 2005, Monterey, CA. 

 
Levizzani, V., R. Amorati, and F. Meneguzzo (2002): A review of satellite-based rainfall estimation methods. 
European Commission Project MUSIC Report (EVK1-CT-2000-00058), 66 pp. [Available online at 
http://www.isac.cnr.it/~meteosat/pub.html] 
 
Levizzani, V., Bauer ,P., Turk, F.J. (2007): Measuring precipitation from space : EURAINSAT and the future. 
Advances in global change research; Vol. 28. Springer, ISBN 978-1-4020-5835-6 
 
Turk, F.J., E. E. Ebert, H.-J. Oh, B.-J. Sohn, V. Levizzani, E. A. Smith and R. R. Ferraro (2003): Validation of an 
operational global precipitation analysis at short time scales. 12th Conf. on SatelliteMeteorology andOceanography, 
Long Beach, CA, Amer. Meteor. Soc., JP1.2. [Available online at http://ams.confex.com/ams/ 
pdfpapers/56865.pdf]. 
 
V. Zwatz-Meise: Introduction into the absorption channels. ZAMG. [Available online at: 
http://oiswww.eumetsat.org/WEBOPS/msg_interpretation/PowerPoints/Channels/WVguide.ppt#283,1, Introduc 
tion into the  Absorption Channels]. 



APPLICATION MANUAL 

141 

11. APPLICATION OF A COMBINED DAILY RAIN GAUGES 
AND RAINFALL SATELLITE ESTIMATES SCHEME 
FOR BASIN MANAGEMENT 

 
By: Daniel Vila1  and Cesar Luis Garcia2  

11.1. Relevance of the application 

The spatial and temporal distribution of precipitation at regional scale is needed for a variety of scientific uses, such 
as climate diagnostic studies and societal applications such as water management for agriculture and power, drought 
relief, flood control, and forecasting floods and crops health. A very common aspect of hydrological monitoring in 
developing countries is the low density of rain gauge networks. Constrains of data in critical situations like drought 
and flood periods add an extra challenge to the people trying to mitigate and control the damages, also reducing the 
effectiveness of the measures. Also under normal situations, the availability of hydrological information can help to 
improve land productivity by allowing better farm and market managements. Having hydrological information is a 
valuable asset, but the task of quantifying the rainfall distribution is complicated by the fact that no single, currently 
available estimate of precipitation has the necessary coverage and accuracy. 
Estimating daily rainfall over land, using a satellite-based algorithm and rain gauge networks involves two major 

issues: firstly to define the algorithm to derive the satellite based precipitation and secondly define and design a  
merging technique. In the first case, the “Hydroestimator” algorithm is used as the base algorithm for retrieving 
precipitation and it is available under the acronym “Rainfall Satellite” “RFS” in the GEONETCast feed. The second 
issue has been largely discussed in several papers over the last years, but the general assumption is that rain gauge 
observations have lower bias. Therefore they will prevail over any satellite retrievals in those regions with dense 
networks, while over the ocean (not analyzed in this application) and non-well gauged areas, the multi-satellite 
estimates have a larger weight in the final analysis.  

11.2. Objectives of the application  

The objectives of this application are to: 
1. Develop a blended product based on the Hydroestimator algorithm (Vicente et al., 1998) and daily rain 

gauge values using the Combined Scheme (CoSch) technique (Vila et al., 2009); 
2. Calculate rainfall statistics for any region of interest (ROI) that is provided by the user. This involves: daily 

mean areal rainfall, maximum rainfall of the day, area where rainfall is > 1mm, and daily mean areal rainfall 
considering only values > 1mm.; 

3. Provide to GEONETCast users an automatic function for data processing in order to obtain daily products 
from the near real-time information. The resulting products will be: Daily precipitation estimates from the 
15min Hydroestimator algorithm and Daily Combined Scheme corrected precipitation. 

This application can be used in manual, batch or automated mode. The manual step by step procedure is the best 
way to really understand the methods adopted and see how the application works. For exercising purposes, the 
manual mode for a given day will be explained in this chapter. But you can integrate this application into your work 
using batch or automated mode operations. Batch mode allows to process entire months or time series of any length, 
while automated mode is to obtain daily results directly from the satellite feed. 
                                                      
1 INPE-CPTEC, Brazil, email: Daniel.vila@cptec.inpe.br 
2 CREAN-UNC and Catholic University of Cordoba, Argentina, email: cesarnon@gmail.com 



APPLICATION MANUAL 

142 

11.3. Data used 

11.3.1. Geo-temporal boundaries  

The development of this application will be carried out inside the geographical limits of the INPE RFS product, and 
for exercising purposes a ROI containing the major catchments of South America will be provided. However, the 
application can be replicated and adapted to any other ROI. For this application we used a daily gauge dataset that is 
freely available for the entire world, and which determines the temporal resolution of the exercise as daily. The 
Combined Scheme (CoSch) technique (Vila et al., 2009), can be applied to other regions of the world and in different 

geo-temporal resolutions, depending upon data availability. 

11.3.2. Local / regional (in-situ) data  

The local data needed for this application is the ground information on rainfall. The Combined Scheme (CoSch) 
technique offers a better accuracy due to the integration of data from different sources (satellite and ground). In this 
case, the rainfall information will be obtained from NOAA’s Climate Prediction Centre Unified Gauge-Based 
Analysis of Global Daily Precipitation. The advantage of this data source is that it is freely available for download 
from: ftp://ftp.cpc.ncep.noaa.gov/precip/CPC_UNI_PRCP/GAUGE_GLB/. 
With a daily global coverage and a spatial resolution of 0.5 degrees, it contains information from 1st January, 1979 to 
the present. The number of gauges varies, the Retrospective Version, from 1979 – 2005, uses 30K+ gauges. From 
2006 – till the present day, the so called Real-time version uses approximately 17K gauges. For any given day, 2 
images are available: 1 layer containing the number of rain gauges with observations per pixel, and another image 
with the mean precipitation value of the gauges. 

Other local data required are the Regions of Interest (ROI), over which the aggregated rainfall statistics will be 
computed. Here some of the biggest catchments of South America are used.  

11.3.3. Data from GEONETCast – DevCoCast 

The data used in this application is part of the stream of DevCoCast America. The product is provided by CPTEC - 
INPE and it is released under the acronym “Rainfall Satellite - RFS”. The data is in GEOTIFF format, about 200KB 
in size, with a temporal resolution of 15 minutes and a spatial resolution of 4km. Basically, the RFS is the result of 
applying an adapted version of the Hydroestimator algorithm to transform the GOES East thermal images into 
precipitation.  

11.4. Methodology  

The proposed scheme, hereafter called Combined Scheme (CoSch), combines two approaches in a single method to 
remove the bias of satellite estimates. In this way, it overcomes some limitations of both schemes used separately and 
it produces spatially continuous rainfall fields. Figure 11.1 represents the flowchart of this procedure. 
Those pixels with no gauges (this information is also provided in the CPC product) will be removed from this part of 
the analysis, since no ground truth can be used to correct them. The change of resolution to 0.25 degree and a buffer 
zone will produce a group of pixels for the same station. 
 



APPLICATION MANUAL 

143 

 Figure 11.1 Methodology followed in this application 
 
The additive bias correction (ADD) is defined as follows: 
 
    
 
Where rr_sat is the satellite based retrieval and the second term represents the gridding average of the (additive) bias 
between the observed rainfall (rr_obs, CPC analysis) and the satellite retrieval (Hydroestimator, in this case) for each 
pixel group. 
 
The ratio bias correction (RAT) is defined as follows: 
 
 
    
 
Where the same conventions as those described for the additive bias correction are used.  
In the next step, the difference between additive/multiplicative bias correction and values obtained from CPC 
analysis is performed. One particular scheme (additive or ratio) is selected for each pixel based on the minimum 
difference between that particular bias correction and the observation. For each non-masked pixel one particular 
method is assigned and for the rest of the pixels the original hydroestimator value is set. 

After deriving the daily precipitation using the Combined Scheme the next step is to obtain the statistical values for 
every ROI and export them into a table.  
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11.5. Data analysis  

11.5.1. Data collection and pre-processing 

Before starting with the analysis, there are some pre-processing steps required to obtain the final 3 maps that will 
enter into the process (RFS, CPC and ROIs). All maps have different boundaries and a different resolution, we are 
going to use the full extent of the RFS product, but we are going to aim for a 0.25 degree product. 
An example area of interest map is provided for this exercise, it is basically a class map containing ROIs with the 
same coordinate system as the RFS data and having a 0.25 degree resolution.  

The RFS images are downloaded at a rate of one every 15 minutes, and need to be integrated into a daily image. A 
very important point to consider is with respect to the start/end time of the daily integration, these should be the 
same for the ground and satellite datasets. In this case, for South America, the daily integration period of today will 
start from yesterday at 12:15 hrs UTC time to today at 12:00 hrs UTC time. The units of the RFS product are 
mm/hr and the daily integration procedure adopted here is: average of all images during the full day and multiply the 
result by 24. This is the best way of distributing the errors produced by missing images, something very common in 
this kind of data. In order to perform the daily integration, an automated processing routine can be adopted on a 
daily basis using the online data stream; also batch routines can be applied on archived data.  
For this exercise the daily RFS image containing the rainfall estimation of the hydroestimator algorithm for the 3rd of 
January of 2011 is provided, called “hydro_20110103”.  
Unzip and copy the exercise data to your active working directory. Start ILWIS and use the navigator to move to this 
working directory. Now close ILWIS and open it again. In the catalogue of the main ILWIS window you should see 
the map “hydro_20110103”. Double click on the map name to open it, use as Representation “mpe_sum” and press 
“OK”. Note the map values and inspect the coordinate system used. Double click on the “Properties” item, available in 
the left legend window of the map. Add the country boundaries “country_02” as well, using as display option “Info” 
off and “Boundaries Only”. Note that the southern parts of Chile and Argentina are not covered as the product only 
provides rainfall data up to 45 degree south latitude. 
The next step is to resample this data to get a 0.25 degree resolution. This is done using the Resample option 
available from the ILWIS main menu “Operations” > “Spatial Reference Operations” > “Raster”. Resample details are 
given in figure 11.2 (left) as well as the output results (figure 11.2, right). Display the output map created and check 
the results. 

 

Figure 11.2 Map resampling settings and resulting RFS map 
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The CPC data can be downloaded via ftp (see address above) and the gauge map should be processed to match the 
resolution and geographic boundaries of the daily RFS. The CPC images have a spatial resolution of  0.5 degree and 
have global coverage, but here only a part is required covering the South American region with a resolution of 0.25 

degrees. If you have an internet connection you can go to CPC ftp site and check the data available for the day we 
are working in. In the folder RT (stands for Real-Time) you will be able to find the file: 
“PRCP_CU_GAUGE_V1.0GLB_0.50deg.lnx. 20110103.RT”. This file is also available in your working directory. 
The procedure to import this image requires a closer look at the meta data provided:  

 The file format is binary, real (float) values in a little Endian byte order (no ‘swap’ required) where 
undefined  / no data = -999.0;  

 header size = 0, data is stored in a band sequential (BSQ) file structure 
 Number of Rows / Columns = 360 / 720; 
 Minimum / maximum Latitude of corner coordinates -90 / 90; Minimum / maximum Longitude of corner 

coordinates 0 / 360; 
 Number of bands is 2: Rain = the grid analysis (0.1mm/day) and Gnum = the number of gauges. 

 
Although in the current version of ILWIS the scrip command allows to include more options for the import of a 
generic raster map(s), enter the following command line in the main ILWIS window to import the two CPC gauge 
map layers: 

 
cpc_temp:=maplist(prcp_cu_gauge_v1.0glb_0.50deg.lnx.20110103.rt,genras,Convert,720,2,0,BSQ,Real,4, 
NoSwap,CreateMpr) 

 
When import is completed, a maplist is created, open the maplist called “cpc_temp” consisting of 2 bands. Open from 
the maplist the map “cpc_temp1”, choose Representation “Pseudo” and your map should resemble the one given in 
figure 11.3.  

Figure 11.3 Resulting map layer 1after import of the CPC gauge data  
 

The CPC maps are written and read from West to East and then from South to North, while other software 
packages use a North to South procedure. Right click using the mouse button the map layer “cpc_temp1”, select from 
the context sensitive menu the option “Spatial Reference Operations” > “Raster” >  “Mirror Rotate”, choose the option: 

“Mirror Horizontal”  and specify as output raster map “cpc_temp1_mirror”. Your output should resemble figure 11.4. 
Note that there are no coordinates assigned to the map. 



APPLICATION MANUAL 

146 

Figure 11.4 Resulting map using the Mirror Rotate - Mirror Horizontal option 
 

Repeat the procedure for the other band: “cpc_temp2” and note the gauge distribution around the globe. Instead of 
using the menu you can also type the following expression into the command line of the main ILWIS window and 
press “enter” and “OK”: 
 

cpc_temp2_mirror.mpr:=MapMirrorRotate(cpc_temp2,MirrHor) 
 
Display the map using and “Inverse” Representation; stretch the map from “0” to “1”. 
 

Figure 11.5 Resulting map using the Mirror Rotate - Mirror Horizontal option of layer 2 
 

The next step is to geo-reference the maps and this presents a challenge as the world coordinate system is commonly 
having America on the left (west) and Africa-Asia situated in the east. In this case only South America is needed, but 

here the whole world extent is taken so if you are interested in some other area you can repeat the procedure. The 
method to adopt is: cut the world in an eastern and western hemisphere and then switch the order. 
Select the option “Sub Map”, from “Operations” > “Spatial Reference Operations” > “Raster”.  Specify the settings as 
indicated in the figure below and create the two ‘hemispheres’. 
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Figure 11.6 Creating eastern and western hemisphere sub maps 
 

Check if your sub maps are OK. Note that you will see something very strange in Australia, if you haven’t noticed 
before, a portion of the country is having no data. Always check the results of your operations carefully; a visual 
inspection can save lots of time, prevent problems and wrong conclusions! In this case it will not have an impact 
because it is not in our study area. 
To combine the maps in the proper order it is necessary to geo-reference the 2 pieces and then glue the maps to 

obtain a global coverage having the Greenwich meridian in the map centre. From the ILWIS main menu select 
“Create” > “GeoReference” and create two geoereferences called “east” and “west”, see details in figure 11.7. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 11.7 Georeference details for the eastern and western hemisphere  

 

Right click the mouse over the map “cpc_temp1_east”, from the context sensitive menu select “Properties”. From the 
properties dialog box select the tab “Dependency” and press the button “Break Dependency Link” and confirm with 
“Yes”. Once more right click with the mouse the map “cpc_temp1_east”, and now as georeference specify “east” and 
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press “OK”. Display the map and add the layer “country_02”, using as display options “Info” off and “Boundaries Only”. 
Check your results, especially the coordinate information provided in the lower right hand corner of the map display. 
Repeat this procedure for the western hemisphere; use the map “cpc_temp1_west”. After the georeference for the 

western part is assigned, select from the main ILWIS menu the option “Operations” > “Raster Operations” > “Glue 
Maps”. As 1st and 2nd map use “cpc_temp1_east” and “cpc_temp1_west” respectively, as Georeference specify 
“full_WtoE” and call the Output Raster Map “prcp_20110103”. Your results should resemble those of figure 11.8. 
Repeat the procedure as indicated above to the second band (gauges) of the CPC imported map, here called 
“cpc_temp2_mirror”. As output name from the Glue Maps operation, use “gauges_20110103”.  Note that to visualize 
this map an “Inverse” Representation can be used and stretch the map from “0” to “1”. 

Figure 11.8 Final map showing the CPC interpolated gauge rainfall fields  
 

Last step is to resample the “prcp_20110103” and “gauges_20110103” CPC maps so that these can be used in 
conjunction with the Hydroestimator map at 0.25 degrees resolution. Check the resampling settings as of figure 11.2 
(left) and call the output maps “prcp_20110103_025” and “gauges_20110103_025” respectively. See also figure 11.9, 
showing the results of this operation. Note that for the visualization of the precipitation map the ocean area has been 
assigned ‘no-data’.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.9 Resampling of the CPC precipitation and gauge data for South America 
 
The necessary pre-processing has now been completed. Check the flowchart of figure 1 once more, note that now 
you are at the beginning of the flowchart, with everything ready to start the process. With respect to the values of the 
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gauge based precipitation map “prcp_20110103_025”, you may have noticed that these are too high; this is because 
the precipitation amounts are multiplied by a factor of 10. This is often done to keep the decimals in an integer 
image: a value of 12.6 is represented as 126. This correction will be applied later. 

Before you start the next series of calculations, first carefully look at the explanation and figure 11.10 below. The 
computations required will be conducted using an ILWIS script to calculate the additive bias and ratio bias 
corrections as given by equation 1 and 2 respectively.  
 

Figure 11.10 Method adopted to select the smallest bias 
  

To start, only use those pixels from the cpc_gauge map that contain at least 1 gauging station (a). This map is 
resampled from 0.5 degrees to 0.25 degrees (b). The hydroestimator map is resampled to 0.25 degrees (c) by 
aggregation. Subsequently the 2 bias images (additive and ratio) are calculated (d) and a filter is applied to obtain the 
mean additive and ratio bias (which can also be assigned to neighbouring pixels) (e). These mean bias maps are used 
to correct the hydroestimator. One particular scheme (additive or ratio) is selected for each pixel based on the 
minimum difference between that particular bias correction and the observation (cpc_precipitation) and the best 
estimate is selected (f). Pixels in ungauged areas will remain untouched and the original estimated value will be 
retained. 

11.5.2. Calculation of bias 

In order to perform the computations given in the flowchart as steps 1 to 4 an ILWIS script is at your disposal, 
called “bias”. Select the script “bias” from the catalogue and open it. Inspect the content carefully as additional 
explanation is provided there as well. To run the script, press the “Run Script” icon  and in the next popup script 
parameter window specify the appropriate input maps. See also figure 11.11 below and press “OK” to execute the 
script. 

Figure 11.11 Input maps to compute the bias 
 

After the computation has finished open the map “hydro_add”, use as Representation “mpe_sum”. From the map 
window, select the option “File” > “Open Pixel Information” and from the Pixel Information Window select the 
options “File” > “Add Map” and add all maps that have been computed for the additive bias calculation: 

 Input maps: hydroestimator_025, gauges_20110103_025, prcp_20110103_025; 
 Input gauge rainfall: prcp_temp, gauge_boolean, prcp_masked; 
 Rainfall difference: bias_add_temp, bias_add_for_sum, bias_add_for_count; 
 Filter results: add_sum and add_count; 
 Average bias: average_add and bias_add. 

Move the mouse over the map “hydro_add” and check the values of the intermediate maps. Eventually use a 
calculator to check the results. The output should resemble those given in figure 11.12. 



APPLICATION MANUAL 

150 

Figure 11.12 Average additive and ratio bias and resulting hydro_add and hydro_rat maps  
 
In the process the size of the bias correction window was increased; the gauge location areas have been expanded by 
one pixel! Note that what looks like single 0.5 degrees pixels are in fact 4 pixels of 0.25 degrees. You can use 
transparency to display “bias_add” and “bias_add_temp” in the same map window, and you should see the effect of the 

filter. See also figure 11.13. At this resolution this is the smallest area increase that you can make. A bigger area 
means more continuity but this also depends on your study area and rainfall systems. Consider that having a gauge 
measurement, taken from a sampling area of about 30 cm in diameter, then distributing this value over an area of 50 
km radius ‘is already a big leap of faith’. 
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Figure 11.13 Expansion of gauge location window 

11.5.3. The decision process and calculation of the CoSch 

Now we can determine which method presents the smallest difference between the corrected estimate and the 
original ground measurement. This difference can be either positive or negative. Either way we want the smallest and 
so we have to take this into consideration. For this, we use the abs function which will give us the absolute value. 

The precipitation file we need to use to make the comparison is “prcp_masked”, because those were the only areas 
that have the real observations. But, if you remember well, the sum3x3 filter that was used increased our area of bias 
correction by a pixel. Here you can choose to neglect the bias correction by one pixel and continue to use 
prcp_masked. Type the following expressions in the command line of the main ILWIS menu and press “OK” to 
execute the operation: 
 

diff_abs_add:=abs(prcp_masked-hydro_add) 
diff_abs_rat:=abs(prcp_masked-hydro_rat) 

 
You may also want to keep the 3x3 increased filter in order to gain a bit more of continuity in your final map: 
 

gauge_temp_mask:=MapFilter(gauge_boolean,RankOrder(3,3,9),value) 
prcp_masked_big:=gauge_temp_mask * (prcp_temp/10) 

 
diff_abs_add_big:=abs(prcp_masked_big-hydro_add) 

diff_abs_rat_big:=abs(prcp_masked_big-hydro_rat) 
 
Display the maps calculated and use pixel information to check your results. Now that the absolute differences are 
known, the map with the lowest bias can be selected. The expression provided here uses the first set of equations as 
input: 
 

cosch_temp:=iff(diff_abs_add ge diff_abs_rat,abs(hydro_rat),abs(hydro_add)) 
 
Repeat the procedure using the increased area of bias correction by one pixel as input and call the output map 
“cosch_temp_big”. Display the maps, using as Representation “mpe_sum” and check your results. 
The next step is to retain the best corrected values for the areas close to the gauging stations and supplement them 
with the satellite based rainfall product where no ground observations are in the neighbourhood. To do so, type the 
following expression in the main ILWIS command line: 
 
  cosch:=ifundef(cosch_temp,hydroestimator_025) 

cosch_big:=ifundef(cosch_temp_big,hydroestimator_025) 
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Your results should resemble those of figure 11.14, depending on the use of a filter. Explore the values of your 
image, you can overlay some of them and explore the difference between the measures and the estimated and 
corrected values for the same pixel. You can also make some maps to see which correction (ADD or RAT) scheme 

was selected for every pixel, or where the estimate was over or under estimating. 

Figure 11.14 Combined Scheme results, without (left) and with filter (right) applied 
 
Consider figure 11.15 showing a pluviometric interpolation and 2 different satellite estimates. Rain fields are not 
homogeneous like the interpolated. The bigger the area you are using to calculate the mean BIAS, the more errors 
will be incorporated into the correction. Hence, some places will end up with negative precipitation, which is of 
course impossible. This is a methodological trade-off, and should be carefully considered.  

Figure 11.15 Comparison of pluviometric interpolation and satellite rainfall estimates 

11.5.4. Retrieving rainfall statistics for basin management  

Now it is a good time to check one of the maps we had provided with some sample Regions of Interest (ROIs). It is 
called “Cuencas”, open the map and explore the content. See also figure 11.16. 
You will notice that when you explore the map with the left mouse button pressed, you will get a tag with the 
catchment name. This class map will be crossed with our CoSch precipitation map. This operation will yield a table 
containing all possible combinations of pixels, also some information about how many pixels have the same 
combination and the area of this combination. 
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Figure 11.16 Class map showing main basin areas in Latin America 
 

From the main ILWIS menu, select “Operations” > “Raster Operations” >”Cross”, provide the details as indicated in 
figure 11.17 and press “Show”. You can also type the following expression in the command line of the main ILWIS 
menu: 
 

Rain_basin_cross.tbt:=TableCross(Cuencas, cosch,IgnoreUndefs) 

Figure 11.17 Cross operation details 
Open the table “rain_basin_cross” and inspect the content. 
 
Now you will create a new column retaining only the values of pixels where the precipitation is >= 1mm (Greater or 
Equal). We can use the ‘iff’ function in table calculation as well; the new column will be named “cosch_GE_1mm”. 
Type the following expression in the table command line: 
 

cosch_GE_1mm:=iff(cosch ge 1,cosch,?) 
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Now that we can obtain the mean rainfall for every basin, we will create a new table for our results; let’s call it 
“statistics”. From the table menu select “Columns” > “Aggregation”, provide the details as indicated in figure 11.18 and 
press “OK”. 

Figure 11.18 Calculation of aggregated basin rainfall statistics  
 

Explore the resulting table “statistics” and the mean values. When working with these estimates it is sometimes very 
useful to obtain the mean rainfall for every basin, but only when rainfall is GE than 1mm. Close the tables. Now you 
will calculate the remaining statistics from the main ILWIS menu. Enter the following expressions directly in the 
command line from the main ILWIS menu. 
To get the mean rainfall per basin greater or equals 1 mm: 
 

tabcalc statistics cosch_ge_1mm:=ColumnJoinAvg(Rain_basin_cross.tbt,cosch_GE_1 mm, Cuencas,NPix) 
 
To obtain the maximum rainfall per basin: 
 

tabcalc statistics maximum:=ColumnJoinMax(Rain_basin_cross.tbt,cosch, Cuencas,1) 
 
To obtain the area with rainfall GE 1mm per Basin normalized: 
 

tabcalc rain_basin_cross.tbt NPix_GE_1mm:=iff(cosch ge 1,NPix,0) 

 
crtbl Tabla_temp cuencas 

 
tabcalc Tabla_temp sum_NPix:=ColumnJoinSum(Rain_basin_cross.tbt,NPix,Cuencas, 1) 

 
tabcalc Tabla_temp sum_NPix_GE_1mm:=ColumnJoinSum(Rain_basin_cross.tbt, 
NPix_GE_1mm,Cuencas,1) 

 
tabcalc statistics area_GE_1mm:=Tabla_temp.tbt.sum_NPix_GE_1mm *100 / Tabla_temp.tbt.sum_NPix 

 
Your final table should resemble the results as provided in table 11.1. Check also the temporary table created, called 
“Tabla_temp”! 
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Table 11.1 Final statistical results over the main basins of Latin America 
 
As a final task have a look at the ILWIS script called “script_auto_media”. This script allows performing the whole 
exercise conducted here in an automated manner.  

11.6. Conclusion 

The methodology provided here is being successfully applied to La Plata river Basin using other datasets as inputs. 
This is an adaptation to the DevCoCast data stream product and free CPC gauge data. Further work is needed at this 
time to test its precisions and limitations. The accuracy and impact of the correction will depend on the density of 
the gauge network, but also on the precipitation regime and size of the ROI’s. Further research is required to study 
these relationships and establish safe boundaries. 

Application of the Combined Scheme for other satellite rainfall estimates in conjunction with ground datasets is very 
easy following this methodological approach.  
Here the proper areas could not be derived from an image that is not projected, but it is considered here a valid 
exercise. You can also get the area of your basins and then obtain a proportion of rain cover. Ultimately if you know 
your ROIs area (in Ha or km2) you can use the proportion to obtain the rainfall area. 
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12. DEVELOPMENT OF TOOLS FOR DYNAMIC 
MONITORING OF INSECT POPULATIONS 

 
By: Mariano P. Grilli and Raquel M. Gleiser  
 
 
Objective: To develop tools to assess adequate environmental conditions for insect development based on satellite 
imagery products:  
Mariano P. Grilli focuses on the development of a tool for dynamic monitoring of an agricultural insect vector (plant 
hoppers affecting maize) in Córdoba – Argentina  
Raquel M. Gleiser focuses on the development of a tool for dynamic monitoring of mosquito larval habitat 
availability in Córdoba – Argentina  
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13. ECO-CLIMATIC CONDITION AND TRENDS ON 
PROTECTED AREAS OF THE IGAD REGION 

 
By: Eugene Kayijamahe and M. Njoki Kahiu  
 
 
Objective: To determine whether there have been changes in vegetation growth in the IGAD region (Eastern Africa) 
using rainfall pattern and vegetation indices and to assess the intra/inter annual trends for vegetation conditions 
using low resolution vegetation indices.   
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14. REMOTE SENSING APPLICATIONS FOR ADVANCED 
DROUGHT SERVICES: LINKING MODELS WITH IN-
SITU CROP CONDITIONS 

 
 
By: F. Kuri and I. Gwitira  
 
 
Objective: The aim is to develop (a) method(s) for relating remotely sensed drought indices from GEONETCast 
data with in-situ measurements/indicators, especially the relationships between the number of dry decades and 
vegetation condition index (VCI) and in-situ drought related crop condition and crop yield as a way to quantify and 

forecast the effect of drought on crop - and rangelands.   
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15. AN AUTOMATED PROCEDURE USING A MULTI-
TEMPORAL THRESHOLD ALGORITHM FOR FOREST 
FIRE DETECTION USING MSG SATELLITE 

 
By: Tawanda Manyangadze and John Molefe   
 
 
 
Objective: To develop a near real time automated procedure using a multi-temporal threshold algorithm for forest 
fire detection using the MSG satellite. 
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16. APPLICATION OF REMOTE SENSING TO MONITOR 
AGRICULTURAL PERFORMANCE 

 
By: Farai M. Marumbwa and Masego R. Nkepu  
 
Objective: To develop a method that allows agricultural managers to conduct an up-to-date assessment of the 
current growing conditions using remote sensing data.   
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17. OCEAN COLOUR MEASUREMENTS OF THE 
PRODUCTIVITY IN THE BENGUELA CURRENT 
LARGE MARINE ECOSYSTEM 

By: Deon Louw1 and Valborg Byfield2 

17.1. Introduction and relevance of application 

The Namibian coastline is about 1500km long with five coastal towns of which Walvis Bay and Lüderitz are the only 
two harbour towns. The entire coastline is relatively straight and unprotected, and strongly influenced by the cold 
Benguela Current flowing northwards. A major influence on the ecology of the region is the coastal upwelling of 
water from the shelf slope, caused by the long-shore wind regime.  Strong southerly winds drive an offshore flow of 
coastal water, which is replaced by cold, nutrient-rich water from the continental slope.  The high nutrient content 
gives rise to high primary productivity and supports rich commercial fisheries. The cold, productive upwelling water 
displays strong seasonal, interannual and decadal variability, which can easily be observed in satellite measurements 
of sea surface temperature (SST) and ocean colour.   
Variation in fish recruitment growth and distribution is largely dependent on environmental conditions.  
Understanding the relationship between environmental variability, primary productivity, recruitment and abundance 
of commercially important fish species is necessary for ecosystem-based fisheries management.  There is a lack of 
direct measurements of upwelling strength and phytoplankton production.  However, marine ecologists in Namibia 

have over the past years developed a number of indirect indices; these include sea surface temperature (SST) and 
chlorophyll concentrations, wind speed and direction, and estimates of offshore transport of cold upwelling water.  
Much of the data used to develop these indices may be sourced from the Internet; this includes scatterometry wind 
data, low resolution chlorophyll-a concentrations from NASA MODIS and SeaWiFS, global SST from NCEP and 
Pathfinder. Higher resolution (1km) chlorophyll-a and SST are available through the DevCoCast channel on 
GEONETCast.   
Namibia runs an intensive oceanographic monitoring programme, which relies on shipboard measurements of 
temperature, salinity and chlorophyll concentrations. Selected transects are monitored on a monthly/bi-monthly 
basis and the in situ measurements from these cruises can be used in conjunction with satellite data. The synoptic 
view of satellites makes it possible to detect fronts, upwelling filaments, plankton blooms, monitor the strength and 
extent of the coastal upwelling and detect intrusions of warm water from the boundaries of the system.  The in-situ 
data taken at the surface provides a control on the satellite measurements and furthermore gives 3-dimensional 
information of the system.  

17.2. Objective of the application 

This application compares in situ measurements from one of the Namibian monitoring transects with 1 km spatial 
resolution satellite data of chlorophyll and sea surface temperature (SST) to assess the strengths and limitations of 
using satellite measurements of chlorophyll and SST to monitor primary productivity in the Benguela upwelling 

system. 
 

                                                      
1 Ministry of Fisheries and Marine Resources (MFMR) and National Marine Institute and Research Centre (NatMIRC), Swakopmund, Namibia, 

email: dclouw@mfmr.gov.na 
2 National Oceanography Centre (NOC), Southampthon, United Kingdom, email: val.byfield@noc.ac.uk 



APPLICATION MANUAL 

164 

17.3. Study Area 

The Benguela system is one of the four major eastern boundary upwelling systems of the world. It spans three 
countries on the west coast of Africa from about 14°S in Angola, through the entire coast of Namibia to about 37°S 
off the southern tip of Africa. Figure 17.1 (after Hardman-Mountford et al., 2003) shows a schematic of the 
oceanography in the region.  The Benguela system is the only eastern boundary upwelling system that is bounded by 
warm water at both ends: the warm Angola Current and Angola Dome to the north and the warm Agulhas Current 

in the south and east.   

Figure 17.1 Currents and upwelling cells in the Benguela system 
 
The cold waters of the Benguela Current itself originate in the Southern Ocean.  The Benguela system has several 
‘upwelling cells’ – regions where a change in the orientation of the coastline creates cyclonic wind-stress curl.  The 
strongest of these is the strong Lüderitz cell in central Namibia, which divides the system into two.  The northern 
Benguela shelf is a typical coastal upwelling system with equator ward winds, cool water, high plankton biomass and 
moderate to high fish biomass, which is currently in a depleted state. Widespread oxygen-depleted waters and 
sulphur eruptions restrict the habitat available for fish. The focus of this study is the upwelling cell near Walvis Bay, 
from the coast to a distance of 200-250 km – the maximum seaward extent of most upwelling filaments.  
A typical feature of the central Namibian coastal ocean are the banks of fog that form when warm air from the 
Namib Desert flows seaward and cools as it crosses the cold Benguela Current.  The location of these fog banks may 
vary, but it is often found in association with the coldest water of the central upwelling cells.  The fog may prevent 
satellite measurements at visible and near infrared wavelengths.  When less dense, it may not fully prevent 
measurements, but can still create problems for accurate atmospheric correction of ocean colour data.   
Three other upwelling-related phenomena may also prevent accurate atmospheric correction and subsequent 
calculations of chlorophyll concentration: 
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 The intensity and high particle scattering of some upwelling blooms can produce high signal returns in the 
near infrared channels used to calculate the various parameters used for atmospheric correction. When 
this occurs, there may be an over-correction in the visible channels, or a failure to establish the spectral 

characteristics of the aerosol contribution.  Since chlorophyll concentrations are typically calculated from 
spectral ratios in blue and green channels, this will produce over-or under-estimates of chlorophyll, 
depending on the exact nature of the problem.   

 ‘Sulphur eruptions’ from low oxygen regions of the sea floor have a similar effect to that of very high 
concentrations of plankton cells, by producing highly scattering ‘white’ water. 

 Finally dust plumes from the Namib Desert produce absorbing aerosols that also create difficulties with 
establishing the spectral characteristics of the aerosol contribution and therefore reduce the accuracy of 
the atmospheric correction. 

17.4. Data used for the study 

17.4.1. Local in-situ data 

In-situ measurements of upwelling diffuse attention, Ku440, chlorophyll-a, and temperature from two dates in 2009 
were selected for use in the exercise.  The first data set, from 1 April represents upwelling and bloom conditions 
during late summer; the second, from 20 August, were obtained during a winter period when the water was 
homogenously mixed. The in-situ data for this exercise from the 20th of August is shown in table 17.1. These samples 
were taken on stations from inshore to offshore along the 23.00 ºS line in Namibian waters off Walvis Bay.  
 

Date Satellite 
Time 

In-situ 
Time 

Time 
Difference

Latitude Longitude Station 
(nm)

In-situ 
SST 

In-situ  
Chl-a

20/08/2009 12:55 12:07 -00:48 -23.00 14.37 2 12.08 4.00 
20/08/2009 12:55 13:10 +00:15 -23.00 14.32 5 12.23 4.00
20/08/2009 12:55 14:23 +01:28 -23.00 14.23 10 12.56 4.41 
20/08/2009 12:55 16:20 +03:25 -23.00 14.05 20 13.08 2.35
20/08/2009 12:55 17:59 +05:04 -23.00 13.86 30 13.30 2.47 
20/08/2009 12:55 19:37 +06:42 -23.00 13.69 40 13.12 3.70 
20/08/2009 12:55 21:25 +08:30 -23.00 13.51 50 13.35 1.88
20/08/2009 12:55 23:05 +10:10 -23.00 13.33 60 13.55 2.70 
21/08/2009 12:55 01:45 +12:50 -23.00 13.15 70 13.72 2.35

Table 17.1 In-situ sampling satellite overpass times for the match-ups used in the exercise 

17.4.2. Satellite data 

The study uses 1 km spatial resolution MODIS-Aqua ocean colour and sea surface temperature (SST) data of the 
Namibia region, processed by the Plymouth Marine Laboratory (PML), which is available through the DevCoCast 
channel on GEONETCast.  The data sets include level 2 processing flags, which are important for selection of valid 
chlorophyll concentrations.  Two different days were chosen: the first shows an upwelling event centred on 29 
March 2009 (late summer) and clearly illustrates some of the atmospheric correction issues associated with fog and 
very high plankton concentrations; the second, from 20 August, 2009 (southern winter) represents less problematic 
conditions and a reasonable match-up with in-situ chlorophyll and SST measurements from the Namibian monthly 
monitoring programme.  

17.5. Methodology and data pre-processing 

A flowchart of the overall methodology is provided in the figure below. Yellow squares indicate steps carried out in 
BILKO (http://www.noc.soton.ac.uk/bilko/index.php), green steps carried out in ILWIS, and blue steps carried out 
in Excel. 
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Figure 17.2 Flowchart showing the key data selection and processing steps  

17.5.1. Selection of satellite and in-situ match-ups 

Figure 17.2 also gives an overview of the data selection and pre-processing steps.  Satellite data are selected for dates 
corresponding to the Namibian in-situ monitoring programme along 23°S.  Initial cloud free scenes from these dates 
are identified based on web-archives of browse-images.  A further sub-selection was based on the time difference 
between satellite overpass time and the closest set of in situ measurements.  

17.5.2. In-situ data pre-processing 

Chlorophyll-a and temperature data is collected on the 23º00S line off Walvis Bay in Namibian waters in 2009 at 
different stations from inshore to offshore (2nm, 5nm, 10nm, 20nm, 30nm, 40nm, 50nm, 60nm and 70nm). Not all 
station measurements were done during the daytime (see table 17.1). 

17.5.2.1. Chlorophyll-a measurements 

Sea water samples for chlorophyll-a are taken at different depth, close to the surface and approximately at 10m, 20m 
and 30m depth and filtered on a GF/F filter. In the laboratory, chlorophyll-a was determined fluorometrically, after 
extracting it for 24 hours in the dark at -20ºC in 90% acetone. The Welschmeyer method was used to determine the 
fluorescence and chlorophyll-a concentrations was calculated as µg/l using the calibration factor obtained through 
preparing a set of dilutions and calculating the slope of the fluorometer readings versus chlorophyll-a concentrations. 

17.5.2.2. Temperature measurements 

A Sea-Bird CTD (Conductivity-Temperature-Depth) mounted on a SBE32 12-position rosette was deployed at the 
stations at a descent rate of 1m/s to within 10m of the seabed. Through the SBE 11 deck unit and the Sea-Bird 
software four files are produces, namely a data file (DAT), a header file (HDR), a configuration file (CON) and a 
mark file (MRK), which are saved for further processing. 
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17.6. Satellite image processing 

Visual screening of the 29 March chlorophyll data, using BILKO1 (figure 17.3) shows clearly that some of the pixels 
contain invalid data, which must be masked. Anomalously low chlorophyll values in (A) are likely to be the result of 
fog; in (B) the atmospheric correction has most likely failed due to scattered cloud or the intensity of the plankton 
bloom or a combination of both. 

Figure 17.3 Chlorophyll data for Namibia displayed in BILKO.   

17.6.1. Creating a mask using BILKO software 

Algorithms used to calculate chlorophyll-a from MODIS measurements are based on assumptions that do not always 
hold in highly productive regions such as the Benguela.  During processing from level 1 to level 2 confidence flags 
are raised when these assumptions are violated.  When a flag is raised, data in the corresponding pixel location must 
be considered less accurate or even invalid, depending on the seriousness of the problem.  In some cases flagged 
pixels may still be useful, particularly when used with in-situ data that can provide independent verification, but care 
must be taken to check that spatial patterns are compatible with what would be expected from marine dynamics 
(currents, eddies, upwelling filaments, fronts, river plumes) in the region of interest.  For the 1st April image a mask 
was created from selected flags, using the BILKO software and a bit-mask formula based on the flag values (figure 
17.4)2.  The mask was saved in GeoTiff format for import into ILWIS (see also figure 17.5). 

                                                      
1 Bilko can be downloaded by registered users from the Bilko web site at www.bilko.org.  A detailed lesson explaining the level 2 processing 

flags, the thinking behind the Bilko formula document used for the masking process, and hints on how to recognize the spatial patterns 

characteristic of invalid data may be found at http://www.noc.soton.ac.uk/bilko/eamnet/ 
2 A detailed lesson describing the process of selecting suitable flags has been developed for the DevCoCast sister-programme EAMNet, and may 

be found on the Bilko web site at www.bilko.org/eamnet/ 
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Figure 17.4 BILKO 'formula' to create a mask from selected MODIS flags 

Figure 17.5 Original chlorophyll data (left) and after application of the mask with coastline and borders 
superimposed (right) imported in ILWIS 

17.7. Comparing satellite and in situ data 

Unzip the exercise data into your working directory. Here “C:\Data\Benguela” is used. Open ILWIS and navigate to 
this directory. Close ILWIS and open it again. The ILWIS catalogue should now show the content of the active 
working directory. Note that for this exercise all data needed still has to be imported. 

17.7.1. Obtaining satellite-equivalent chlorophyll values from the in-situ measurements 

In situ measurements of chlorophyll-a are made at different depths.  From this it is necessary to calculate ‘satellite 
equivalent chlorophyll’ – the signal ‘seen’ by the satellite. According to bio-optical theory, 90% of the water leaving 
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signal in Case 1 waters1 comes from first optical depth i.e. 1/Kd490.  This means the Kd490 data provided by 
MODIS may be used to decide on how to calculate satellite equivalent chlorophyll.  In clear open ocean waters, with 
very low concentrations of plankton cells in surface layers, the one optical depth can be several 10s of metres; in 

productive systems such as the Benguela it may be 5-10 m and sometimes less. 
On 1 April satellite Kd490 values in the region of interest ranged from 0.2 to over 2.5 m-1. One optical depth 
(1/Kd490) was thus between 0.4 m and 5 m.  In-situ measurements of upwelling diffuse attenuation at 440nm 
(Ku440) were comparable, (0.5 - 1.3 m-1, optical depths 0.7 - 1.9m).  Chlorophyll data from the deeper samples (10m, 
20m and 30m) therefore contributed only 0.5 - 5% to water-leaving radiance, and could thus be considered 
irrelevant2.  Unfortunately no chlorophyll samples were taken near the surface.  For this reason, and due to the 
problem with satellite data quality discussed in section 1.6, satellite - in situ comparison will only be carried out for 20 
August, when in situ Ku440 ranged from 0.18 to 0.31 m-1, (optical depths: 3.1 - 5.6 m) and vertical profiles of 
temperature and chlorophyll revealed a well-mixed water column.  Average in situ chlorophyll concentrations used 
for the comparison are given in Table 17.1 above. 

17.7.2. Importing the 20 August chlorophyll-a map in ILWIS 

The PML MODIS data comes in NetCDF format, which contains normalised water-leaving radiances at different 
wavelengths, nLw_*, chlorophyll concentrations, chlor_a, and diffuse attenuation at 490 nm, Kd_490.  These sub-
datasets can be extracted using the GEONETCast Toolbox before you can display them in ILWIS.  Another way to 
do this is using the DOS Command Prompt, which can be opened from the Accessories folder of the Program 
menu.   
In the Command window, navigate to your working directory which contains the exercise data.  In the figure 17.6 
example, the data is kept in “C:\data\benguela”; note that you may have the data in a different directory. 

Figure 17.6 Command Prompt window showing navigation to the file containing the Benguela images 
 
To check the content of the NETCDF files, type this command:  
  

“C:\ilwis372_SEBS\Extensions\Geonetcast-Toolbox\GDAL\bin\gdalinfo.exe” 

PML_Namibia_MODIS_oc_refined_20090820135500.nc 
 
Note that in this example “C:\ilwis372_SEBS\” is used because the ILWIS software in installed directly on the C:\ 
drive in the folder “ilwis372_SEBS”.  If you have ILWIS installed in a different location you must use that. Press 
return to run the “gdalinfo.exe” application and take note of the listing of the content of the file 
“PML_Namibia_MODIS_oc_refined_20090820135500.nc”. Note the names of the different sub-dataset; you will need 
these in the next step.  Also see appendix 1 for the file content listing. 
To import a sub-dataset into ILWIS you use “gdal_translate.exe” from the Geonetcast Toolbox.  For example, to 
import  SUBDATASET_8  “chlor_a” you type the following command:  
 

“C:\ilwis372_SEBS\Extensions\Geonetcast-Toolbox\GDAL\bin\gdal_translate.exe” -of ILWIS 
NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":chlor_a 20090820_chlor_a.mpr 

                                                      
1 In Case 1 waters the optical characteristics are determined only by the optical properties of water, phytoplankton and associated plankton 

breakdown products, which are correlated with plankton concentrations.  This contrasts with Case 2 waters, where optical properties also depend 
on concentrations of suspended sediment and coloured dissolved organic matter that enters the ocean from land, for example via rivers.   
2 On one station, no surface sample was taken, but the in situ measurements of temperature revealed a well mixed water column, so it was 

reasonable to assume that using an average in situ chlorophyll could be used for comparison with the satellite data. 
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This will run “gdal_translate.exe” (found in the GDAL\bin directory of the Geonetcast Toolbox) to extract the sub-
dataset named “NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":chlor_a”.  The output file is 

“20090820_chlor_a.mpr”.  The expression “-of ILWIS” between the program and the image to be extracted specifies 
the output file format, here an ILWIS format is used. Execute the expression to import the chlorophyll-a map, an 
example is provided in figure 17.7 as well.   
 

Figure 17.7 Import of SUBDATASET_8 (chlor_a) into ILWIS 
 
After import, return to ILWIS, refresh the catalogue (select from the main ILWIS menu the option “Window” > 
“Refresh”) and select the GeoReference created, called “20090820_chlor_a” having the following icon: . Right click 
the icon with the mouse, from the context sensitive menu select the option “Properties” and change the coordinate 
system from “Unknown” to “LatlonWGS84” and press “OK” (see figure 17.8). 

Figure 17.8 Changing the GeoReference information. 
 

Double click with the mouse the map “20090820_chlor_a” to open it. You can change the colour of the map using a 
Representation; here you can use the Representation “Pseudo”. For the chlorophyll-a map select a “logarithmic” stretch 
with the maximum set to “100”, and click “OK”.  To add the boundaries for Namibia, select from the active map 
display window the option “Layers” > “Add Layer” and navigate to your ILWIS directory and select from there the 
sub-directory “\Extensions\Geonetcast-Toolbox\util\maps”, then select the vector map “Africa_country”.  In the 
subsequent Display Options dialog window check the box for “Boundaries Only” and uncheck the box “Info”. You can 
change the boundary colour to “Black”. The result should look similar to that of figure 17.9. 
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Figure 17.9 Chlorophyll-a map of the Benguela region with coastline and borders superimposed 

17.7.3. Import of In Situ sampling points and creating a Point Map 

17.7.3.1. Import of the In Situ observations 

Open from your working directory the file “in_situ.txt” by double clicking on it. There are 9 relevant records for the 
following attributes: latitude, longitude, distance in nautical miles, sea surface temperature, chlorophyll-a and the 
station name (see also table 17.1). To import this text file and create an ILWIS table conduct the following operation. 
Open from the main ILWIS menu the option “File” > “Import” > “ILWIS” > “Table” > “Space Delimited”, as input 
file select “in_situ.txt” and as output file specify “station_data” and press “OK” and “Next”. In the Edit Column 
Details window specify the settings as given in the figure below and press “Finish” and “OK”. Note that the Domain 
Type should be correctly specified, using a “value” domain, except for the column ‘st_name’, which is having a 
“string” domain. 

 Figure 17.10 Table column import settings 
After import open the table “station_data” and inspect the content. Note that there are two records, having as name 
‘Base’ and ‘Return’, these are marking the start and end of the section. Close the table. 

17.7.3.2. Creating a Point Map 

From the main ILWIS menu, select “Operations” > “Table Operations” > “Table to PointMap”. In the dialog window that 
opens choose as input the “Station_data” table.  The XY column (Coords) are automatically assigned, coordinate 

system is “LatlonWGS84”; as output point map use the name “station_data”, keep the other settings default and press 
“Show” and “OK”.  
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Return to the chlorophyll map you opened earlier.  To overlay the point map on this raster image, select “Layers” > 
“Add Layers” from the map display menu, and choose the newly created point map.  The Display Options dialog 
allows you to select how the points are displayed.  Check the Single Symbol box, and click on the tab to open the 

Symbol dialog. Choose from the option Symbol and select “Square”, using a symbol size of “3”, set the Fill Color to 
“Black” and press “OK” twice.  You should now see the points on the chlorophyll map (figure 17.11).  Use the zoom 
tool to get a better view of the sampling region. From the active map window select the option “File” > “Open Pixel 
Information” and move the mouse cursor over the sampling locations, check the map and table values! 

Figure 17.11 The chlorophyll-a image with the point map overlaid 

17.7.4. Extracting satellite data for statistical analysis 

Before you can extract the information of the chlorophyll map you first have to rasterize the point map. From the 
main ILWIS menu, select “Operations” > “Rasterize” > “Point to Raster”, as point map select “station_data” and as 
output map leave the default name “station_data”, as georeference select “20090820_chlor_a” and press “Show”. In the 
new map display window, select from the menu “Layers” > “Add Layer” and select the “station_data” point map. 
Zoom in on the observation locations to see the result of the operation. 
Now select from the main ILWIS menu the option “Operations” > “Raster Operations” > “Cross”. As 1st map select 
“station_data” and as 2nd map the “20090820_chlor_a” map. Specify as output table name “st_chlora” and press “Show”. 
Check the results given in the new table. For the sampling locations (except the ‘Base’) the chlorophyll-a values are 
extracted. 
Open the table “station_data”, from the main table menu, select the option “Columns” > “Join”, in the next ‘Join 
Wizard – Select input table and column’, select as input table “st_chlora” and as input column “20090820_chlor_a”, 

press “Next” three times, using the default settings, also the default output column name can be accepted and press 
“Finish” and “OK”. Inspect the content of the table and check the new column added. 
To check the correlation between the in situ and satellite derived chrolophyll-a values, select from the table menu the 
option “Columns” > “Statistics”, as function select “Correlation” and as columns use “chlor_a” and “20090820_chlor_a” 
and press “OK”. What can be concluded? 
Select from the Table menu the graphics icon , and from the “Create Graph” menu, select as X-axis “chlora” and as 
Y-axis “20090820_chlor_a”. Press “OK” to display the graph. You can modify the Graph properties by selecting the 
items in the left hand graph legend. E.g. unselect “Legend” and for the item ”chlora*20090820_chlor_a”, by double 
clicking with the mouse on the item name, use as “Color” “Red”. Also change the Min-Max settings of the graph axis 
(X: from 0 to 5, interval of 0.5 and Y: from 0 to 5, interval 0.5). Proceed from the active Graph window, select from 
the menu “Edit”, “Add Graph” and select “Least Square Fit”. Select as X-column “chlora” and as Y-column 
“20090820_chlor_a”, use as Function “polynomial” with “2” terms (1st order polynomial function) and press “OK”. 
From the Graph legend, select the item: “chlora*20090820_chlor_a - polynomial”, change the Color to “Black” and set 
the Line Width to “0.2”. Also note the regression formula, which is given on the lower left hand of this menu. Press 
“OK”. Your results should resemble those of figure 17.12. 
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Figure 17.12 Scatter plot showing relationship 
 
Close the graph window, eventually save the graph (select from the graph menu the option “File” > “Save”). Activate 
the table “station_data” again and from the table menu select “Column”, “Least Squares” and for the X-column select 
“chlora” and the Y-column “20090820_chlor_a”, specify as output column “Calculated”. Use as function “Polynomial” as 
number of terms “2” and press “OK” to execute the operation. In the column properties window select the option 
“Additional Info”, here the function is given, leave the other options as default and press “OK”. A new column, called 
“Calculated” is now added to the table. Check the results obtained in the table and compare the differences between 
the observed, satellite derived and values obtained using the regression function.  

17.7.5. Characterising chlorophyll variability in spatial windows around the sampling points 

The ocean environment is highly dynamic and phytoplankton distributions are ‘patchy’ – that is highly variable over 
fairly short spatial and temporal scales.  These patches drift, with currents and eddies, and may move by distances 
greater than a single pixel over a period of a few hours.  For this reason it is not sufficient to compare the in-situ 
measurements to satellite data at a single point.  You also need to characterise the spatial variability around each 
location.  This may be done by selecting spatial windows of increasing size, centred on the pixel containing the 
sampling location. The mean or median chlorophyll concentrations, along with the standard deviation (or variance) 
needs to be calculated for several windows of increasing size (e.g. 3x3, 5x5, 7x7, even 9x9) around each sampling 

point. This process requires three steps before you can export the data for statistical analysis. Here only the average 
and median spatial variability are considered to serve as an example of the procedures to be followed. 

17.7.5.1. Step I. Filtering  

From the main ILWIS menu select the option “Operations” > “Image Processing” > “Filter”. In the Filter dialog set the 
filter type to “Average”.  The rows and columns should change to 3x3; accept this.  Specify as input map 
“20090820_chlor_a” and enter an appropriate name for the Output Raster Map. Note: it is important to choose a 
name which you will recognise immediately, because you need to make several maps, e.g. ‘chlor_a_3_avg’ and 

‘chlor_a_3_med’, etc. Change the Precision to three digits, and click “Show”. To create the other filtered maps you 
can simply repeat the procedure and change the dimension of the filter kernel size (e.g. to 5 by 5). Repeat the 
procedure also for the 5x5, 7x7 and 9x9 average filter sizes. For median filtering, select as filter type “Median” and 
also create these maps using different filter sizes. Note that various other filters are at your disposal and if required 
you can create them yourselves, consult also the ILWIS Help if more assistance is needed. 

17.7.5.2. Step 2. Create a Map List 

From the main ILWIS menu select the option “File” > “Create” > “Map List”. In the Create MapList window enter a 
name for the new Map List, e.g. “avg”.  Select the different filtered raster images maps created by the average filtering 
in sequential order and move them to the right pane by clicking the “>” tab between the panes. Click “OK”.  Repeat 
this procedure to create the Median filtered maps and call this map list “med”. 
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17.7.5.3. Step 3. Creating a Table from a Map List 

From the main ILWIS menu, select the option “Operations” > “Point Operations” > “Point Map Cross”. In the Point 
Map Cross dialog select again the point map that contains the in situ stations, here called “station_data”. Choose the 
Map List “avg” you have just created in step 2 above, specify as output point map “avg” and press “Show” to execute 
the operation. You can close the newly created point map, open the newly created table “avg”. Repeat the procedure 
for the median filtered map list and call the output point map “med”. Open both tables you have just created and 
inspect the values of the different windows around your sampling point. For further analysis you can copy the values 
with station data into an Excel spreadsheet.  

17.8. Statistical Analysis of the match-up data 

The data extracted is summarised in the table below, which also includes the average in-situ chlorophyll.  Statistical 
analysis may now be done in Excel, R or another suitable statistical package and will typically include plotting in situ 
chlorophyll-a against the satellite-derived concentrations as demonstrated above (see figure 17.12).  More detailed 
analysis is outside the scope of this exercise.  
 

Station in situ 
chlor_a 

Modis 
avg 3x3 avg 5x5 avg 7x7 avg 9x9 med 3x3 med 5x5 med 7x7 med 9x9 

ww23002 4.0 4.769 4.769 3.062 3.235 3.343 2.933 2.958 2.991 2.933 

ww23005 4.0 2.862 2.862 2.817 2.824 2.826 2.715 2.715 2.819 2.715 

ww23010 4.41 2.715 2.715 1.302 1.321 1.351 1.265 1.299 1.316 1.265 

ww23020 2.35 1.216 1.216 1.177 1.2 1.237 1.186 1.188 1.194 1.186 

ww23030 2.47 1.267 1.267 1.661 1.62 1.617 1.647 1.63 1.609 1.647 

ww23040 3.7 1.795 1.795 1.664 1.573 1.541 1.686 1.588 1.562 1.686 

ww23050 1.88 1.761 1.761 2.388 2.264 2.11 2.448 2.168 2.004 2.448 

ww23060 2.7 2.456 2.456 1.904 1.827 1.837 1.878 1.799 1.835 1.878 

ww23070 2.35 2.103 2.103 2.015 2.001 1.928 1.956 1.956 1.937 1.956 

Table 17.2 In situ average and satellite derived chlorophyll for various match-up windows 
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17.9. Processing the SST data 

In your directory also a NETCDF file is available providing the satellite derived sea surface temperature (SST). 
Repeat the steps described before and analyse the in situ and satellite derived sea surface temperatures. First inspect 
the file using ‘gdalinfo’ and then import the file using ‘gdal_translate’. A sample import syntax string is provided 
below.  

 
“C:\ilwis372_SEBS\Extensions\Geonetcast-Toolbox\GDAL\bin\gdal_translate.exe” -of ILWIS 
NETCDF:"PML_Namibia_MODIS_sst_refined_20090820135500.nc":sst 20090820_sst.mpr 

 
Upon completion of the import right click with the mouse the newly imported map, here called “20090820_sst”, 
from the context sensitive menu select the option “Properties” and now select as georeference the one used for the 
chlorophyll-a map “20090820_chlor_a”. All other processing and analysis routines are identical to the procedures 
described above. If successful the results should resemble those provided in figure 17.13.  The satellite SST is 
consistently higher than the corresponding in situ temperature.  This is due to solar heating of the surface 'skin' of the 
ocean during the day.  Satellites measure the 'skin temperature' - the top mm of the water.  During the day this layer 

is heated by the sun, and becomes warmer than the underlying water.  In-situ measurements are made at depths of 1 
to 5 m. This 'bulk' temperature varies less between day and night than the 'skin' temperature seen by the satellite. The 
plot also shows that the location 2nm from the shore has a much greater difference between 'skin' and 'bulk' than 
indicated for the other 8 sampling points.  The reason for this may be 'land contamination' (radiation from much 
warmer land contributes to the signal) or, perhaps more likely, calmer near-shore conditions (calmer waters have a 
greater difference between 'skin' and 'bulk' temperatures). Removing this outlier makes the SST – in situ relationship 
linear. 

Figure 17.13 Results of the in situ and satellite derived SST comparison 

17.10. Concluding remarks 

Satellite measurements of ocean colour and sea surface temperature can provide valuable information about the 
dynamics of the Benguela coastal upwelling system.   However, care must be taken to identify artefacts in the satellite 
data and exclude these from the analysis.  The strength of satellite images lie in their synoptic view of the region and 
their regular repeated measurements, which make them a good tools for spatial and temporal variability and change 
in the region.  However, absolute values of chlorophyll and SST are less reliable. The examples shown here indicate 
that in-situ measurements are still needed to 'calibrate' the satellite measurements - particularly close to the coast, or at 
times of strong upwelling when the satellite measurements are more problematic. 
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APPENDIX 1 

File content listing of t he file PML_Namibia_MODIS_oc_refined_20090820135500.nc 
 

Driver: netCDF/Network Common Data Format 

Files: PML_Namibia_MODIS_oc_refined_20090820135500.nc 

Size is 512, 512 

Coordinate System is `' 

Metadata: 

  NC_GLOBAL#site_name=EAMNet: Namibia 

  NC_GLOBAL#citation=If you use this data towards any publication, please acknowledge this using: 'The authors thank 

the NERC Earth Observation Data Acquisition and Analysis Service (NEODAAS) for supplying data for this study' and 

then email NEODAAS (info@neodaas.ac.uk) with the details. The service relies on users' publications as one measure of 

success. 

  NC_GLOBAL#creation_date=Wed Aug 24 19:08:15 2011 

  NC_GLOBAL#easternmost_longitude=15.9969 

  NC_GLOBAL#creator_url=http://rsg.pml.ac.uk 

  NC_GLOBAL#references=See NEODAAS webpages at http://www.neodaas.ac.uk/ or RSG pages at 

http://rsg.pml.ac.uk/ 

  NC_GLOBAL#Metadata_Conventions=Unidata Dataset Discovery v1.0 

  NC_GLOBAL#keywords=satellite,observation,ocean 

  NC_GLOBAL#summary=This data is Level-3 satellite observation data (Level 3 meaning raw observations processedto 

geophysical quantities, and placed onto a regular grid). 

  NC_GLOBAL#id=M2009232.1255.y6.oc_products.MYO.20aug091255.v4.20112361807.data.nc 

  NC_GLOBAL#naming_authority=uk.ac.pml 

  NC_GLOBAL#geospatial_lat_max=-13.9976 

  NC_GLOBAL#title=Level-3 satellite data from Moderate Resolution Imaging Spectroradiometer sensor 

  NC_GLOBAL#source=Moderate Resolution Imaging Spectroradiometer 

  NC_GLOBAL#northernmost_latitude=-13.9976 

  NC_GLOBAL#creator_name=Plymouth Marine Laboratory Remote Sensing Group 

  NC_GLOBAL#processing_level=Level-3 (NASA EOS Conventions) 

  NC_GLOBAL#creator_email=rsghelp@pml.ac.uk 

  NC_GLOBAL#netcdf_library_version=4.1.1 of Dec  6 2010 08:20:12 $ 

  NC_GLOBAL#date_issued=Wed Aug 24 19:08:15 2011 

  NC_GLOBAL#geospatial_lat_min=-28 

  NC_GLOBAL#date_created=Wed Aug 24 19:08:15 2011 

  NC_GLOBAL#institution=Plymouth Marine Laboratory Remote Sensing Group 

  NC_GLOBAL#geospatial_lon_max=15.9969 

  NC_GLOBAL#geospatial_lon_min=4 

  NC_GLOBAL#contact1=email: rsghelp@pml.ac.uk 

  NC_GLOBAL#license=If you use this data towards any publication, please acknowledge this using: 'The authors thank 

the NERC Earth Observation Data Acquisition and Analysis Service (NEODAAS) for supplying data for this study' and 

then email NEODAAS (info@neodaas.ac.uk) with the details. The service relies on users' publications as one measure of 

success. 

  NC_GLOBAL#Conventions=CF-1.4 

  NC_GLOBAL#project=NEODAAS (NERC Earth Observation Data Acquisition and Analysis Service) 
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  NC_GLOBAL#cdm_data_type=Grid 

  NC_GLOBAL#RSG_sensor=MODIS 

  NC_GLOBAL#westernmost_longitude=4 

  NC_GLOBAL#RSG_areacode=y6 

  NC_GLOBAL#southernmost_latitude=-28 

  NC_GLOBAL#netcdf_file_type=NETCDF3_CLASSIC 

  NC_GLOBAL#history=Created during RSG Standard Mapping (MODIS-AQUA-NASA-refined-OC-mapper-

config.xml) 

1314211588 Subsetted from 

A2009232125500/products/devcocast/2009/08/20/M2009232.1255.y6.oc_products.MYO.20aug091255.v4.20112361807.

data.nc to only include variables 

nLw_547,nLw_412,nLw_488,nLw_667,Kd_490,nLw_531,l2_flags,chlor_a,latitude_longitude,longitude,time,latitude,nLw_4

43 

  NC_GLOBAL#RSG_hash_descriptor=openssl_sha1:1:52990df6ec7fb2ac2e13f515c4a4ffee1cbd83fb 

Subdatasets: 

  SUBDATASET_1_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_547 

  SUBDATASET_1_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_2_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_412 

  SUBDATASET_2_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_3_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_488 

  SUBDATASET_3_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_4_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_667 

  SUBDATASET_4_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_5_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":Kd_490 

  SUBDATASET_5_DESC=[1x1557x1334] volume_attenuation_coefficient_of_downwelling_radiative_flux_in_sea_water 

(32-bit floating-point) 

  SUBDATASET_6_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_531 

  SUBDATASET_6_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

  SUBDATASET_7_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":l2_flags 

  SUBDATASET_7_DESC=[1x1557x1334] l2_flags (16-bit integer) 

  SUBDATASET_8_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":chlor_a 

  SUBDATASET_8_DESC=[1x1557x1334] mass_concentration_of_chlorophyll_a_in_sea_water (32-bit floating-point) 

  SUBDATASET_9_NAME=NETCDF:"PML_Namibia_MODIS_oc_refined_20090820135500.nc":nLw_443 

  SUBDATASET_9_DESC=[1x1557x1334] surface_upwelling_spectral_radiance_in_air_emerging_from_sea_water (32-bit 

floating-point) 

Corner Coordinates: 

Upper Left  (    0.0,    0.0) 

Lower Left  (    0.0,  512.0) 

Upper Right (  512.0,    0.0) 

Lower Right (  512.0,  512.0) 

Center      (  256.0,  256.0) 
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18. USING SEA SURFACE TEMPERATURE TO 
ASSESS CORAL BLEACHING RISK 

By: Yohanna W. Shaghude1 and Valborg Byfield2 

18.1. Introduction and relevance of application 

Coral reefs are considered the oceanic equivalent of the tropical rainforest, in terms of their biodiversity, 
complexity and net primary production.  A coral reef is an ecosystem with multiple functions: ecological, 
environmental and socio-economic.  Ecologically, coral reefs serve as nursery for many invertebrates and fish, 
and as source for beach sand. Socio-economically, coral reefs support a large variety of subsistence and 
commercial fisheries, thereby supporting the livelihood of many coastal communities.   
The reefs and the associated sand beach habitats plays a major role in the marine tourism industry in the region, 
which generate foreign currency and offers employment to local people, thereby providing a livelihood to 
coastal communities.  Furthermore, coral reefs serve as physical buffers for oceanic currents and waves, 
thereby protecting the coast from erosion, and creating, over geologic time, a suitable environment for sea 
grass beds and mangroves.  
Despite their many benefits to coastal communities, most of the tropical reefs are currently exposed to a variety 
of natural and anthropogenic threats and have been degrading at an alarming rate over recent years. A major 
'natural' threat to coral health comes from high water temperatures, which, if persisting for a long period can 
lead to a phenomenon known as coral bleaching.  This threat is likely to increase with global warming. 
Coral bleaching is the whitening of corals due to stress-induced expulsion or death of their symbiotic protozoa, 
zooxanthellae, or due to the loss of pigmentation within the protozoa. The corals that form the structure of the 
great reef ecosystems of tropical seas depend upon a symbiotic relationship with unicellular flagellate protozoa, 
called zooxanthellae - photosynthetic organisms living within their tissues. Zooxanthellae are responsible for 
the colour of the reefs, with the specific color depending on the particular clade.  When stressed, corals may 
expel their zooxanthellae and change their colour to a lighter or completely white appearance, hence the term 
"bleached". 
Although many environmental factors may trigger coral bleaching, high sea water temperature is by far the 
most common cause of wide-spread bleaching events. Analysis of satellite sea surface temperature (SST) data 
therefore offers an opportunity for predicting location and extent of coral bleaching. For Tanzania, with its rich 
coral reef resources distributed widely along a coastline that is more than 1000 km long, being able to assess the 
location and extent of coral bleaching risk is vital for the management of the reefs.  Instead of visiting all the 
reef sites to identify the threatened reefs, satellite SST data may provide information on the hotspots of major 
threats, thereby saving time and money. 

                                                      
1 Institute of Marine Sciences, University of Dar es Salaam, P.O. Box 668, Zanzibar, Tanzania.  Email: shaghude@ims.udsm.ac.tz 
2 National Oceanography Centre (NOC), Southampton, UK. Email: val.byfield@noc.ac.uk 
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Figure 18.1 Bleached (left) and healthy (right) coral reefs 

18.2. Objective of the application 

The main objective of this application is to investigate the trends in satellite derived sea surface temperature 
(SST) for detection of “hot spots” and assessment of the potential coral reef heat stress which could eventually 
cause coral bleaching along the coast of Tanzania.  

18.3. Data used for the study 

18.3.1. Local in-situ data 

Seawater temperature logger deployed at Chumbe reefs Zanzibar (at 2 m depth during low tide), spanning from 
January 1997 – September 2010 was provided by Dr. Christopher Muhando of the Institute of Marine Sciences, 
University of Dar es Salaam. 

18.3.2. Satellite data 

The study uses 1km resolution MODIS-Aqua sea surface temperature (SST) from the DevCoCast Tanzania 
region, provided by Plymouth Marine Laboratory (PML) for the period January to March 2010, during the 
warm season when corals are known to be most at risk from heat stress. 
To assess what are 'normal' temperatures to which corals are likely to be well adapted, a global monthly SST 
climatology was downloaded from ftp://data.nodc.noaa.gov/pub/data.nodc/pathfinder/Version5.0_ 
Climatologies. 
The Pathfinder data is based on a different sensor, so to allow a comparison between the climatological mean 
and the MODIS SST data, two further data sets were downloaded: global monthly MODIS SST from Jan-
March 2006 from http://oceancolor.gsfc.nasa.gov/cgi/l3, and monthly Pathfinder v5.0 SST for the same 
period, available at ftp://data.nodc.noaa.gov/pub/data.nodc/pathfinder/Version5.0/Monthly/2006/. 

18.4. Methodology and data pre-processing 

18.4.1. Methodology 

The flowchart given below shows the main processing steps for this exercise. Due to reasons of data volume 
the import of the various data sets has already been done and a subset has been created for the coastal region 
of Tanzania. Some of the data import routines are described in chapter 17 of this manual. 
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Figure 18.2 Flowchart showing the key data selection and processing steps  

18.4.2. Pre-processing of the global SST data used for comparison with the 1km DevCoCast product 

The global data sets containing the climatology data, and the monthly data from 2006 used to control for any 
difference between MODIS and Pathfinder SST products, have been pre-processed and imported into ILWIS. 
Only the Area of Interest (AoI) has been retained to limit the data volume. The MODIS-Aqua sea surface 
temperature (SST) from the DevCoCast Tanzania region, provided by Plymouth Marine Laboratory (PML) for 
the period January to March 2010, has also been pre-processed and time series of the two years for the AoI 
have been made available. The pre-processing is consisting mainly of importing the NETCDF or HDF files by 
selecting the relevant layers and application of the calibration coefficients. All data was re-projected to the same 
coordinate system and subsequently the AoI has been extracted. 
For the Pathfinder mean SST-night time data, both for the 2006 and the monthly climatology datasets, the 
following transformation has been applied to convert the data to degree Celsius: 
       

PF_SSTn_Celsius_outmap = -3.0 +clim_sst_filled_data * 0.075 
 
For the 2006 MODIS monthly mean night-time SST data the transformation equation used was: 
 
 MODIS_SSTn_Celsius_outmap = (0.000717185*l3m_data) – 2 
 
The Pathfinder monthly climatology data has also been used to derive a map containing the values of the night- 
time maximum mean monthly (MMM) sea surface temperature. 
 
The MODIS-Aqua daily sea surface temperature (SST) from the DevCoCast Tanzania region only required the 
extraction of the AoI. Two map lists have been created containing the daily SST-night data for 2007 and 2010. 
There is no night SST image for 12-01-2007, the rest is complete, 89 map layers for 2007 and 90 layers for 
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2010, covering the period from 1st of January to the 31st of March for the two years. As will be seen later the 
data needs further processing to eliminate or exclude (partly) cloud contaminated and pixels with poor quality 
or invalid data. For import of a time series of data use is made of a batch looping procedure. All NETCDF 
night-time SST files are situated in a given directory and for import use is made of GDAL. Figure 18.3 is 
showing the batch file that is ‘starting’ the import procedure. The single line statement executes another batch 
file, here called ‘sst_nc_import1.bat’ that is actually conducting the import, the import continues until all files 
have been processed. The content of the second batch file ‘sst_nc_import1.bat’ is given in figure 18.4. 

Figure 18.3 Starting the batch looping routine procedure 

Figure 18.4 Batch file listing showing the import syntax 
 
The starting batch file is passing the filename, with the extension “nc” to the second batch file. Here portions 
of the filename are extracted, containing the timing information (year, month, day, etc) from the file name 
string. Subsequently 4 lines are conducting the import and pre-processing. Line 1 is calling “gdal_translate”, 
which imports the data and writes an ILWIS output formatted image. In line 2 a georeference is appended to 
the newly imported image. Line 3 creates the sub-map, retaining only the AoI and in line 4 a georeference is 
appended to this new map for the AoI.  In this manner, import of time series of data can be efficiently done. 

18.5. Satellite image processing 

The main processing steps remaining for assessing potential coral reef heat stress are: 
 Creating weekly composites of night-time SST data for the period of interest; 
 Comparing the weekly data to the climatology to determine if current water temperatures are higher 

than normal, and calculating the anomalies:  anomaly SST = current STT - climatology SST; 
 Correct for any bias arising from comparing data from one sensor (MODIS) to climatology data from 

another (Pathfinder AVHRR);  
 Calculate cumulative heat stress - degree heating weeks.   
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18.5.1. Creating weekly composites of night-time SST 

The Coral Reef Watch (CRW) operational SST produces only night-time satellite SST observations and 
excludes the daytime observations to eliminate variations caused by solar heating of the sea surface during the 
day and also to avoid contamination from solar glare. Compared with daytime SST and day-night blended SST, 
night-times SST provides more conservative and stable estimate of thermal stress conducive of coral bleaching. 
We therefore need to extract the night-time SST observations and keep these separately from the daytime 
observations.  Here only night-time SST images are used. 
Unzip the exercise data into your working directory. Here “C:\Data\Tanzania” is used. Open ILWIS and 
navigate to this directory. Close ILWIS and open it again. The ILWIS catalogue should now show the content 
of the active working directory.  
Double click on the map list icon “sstn_tanzania_2007”, in the next window, select from the menu the option 
“Open as Slide Show” and press “OK”. In the next display options window set the minimum stretch value to “0”, 
select a “Pseudo” Representation and press “OK” again. You now see an animated sequence of the imported 
night-time SST’s of 2007. You will observe that there is a need for further processing in order to eliminate 
clouds, invalid pixels and land areas. Also check the content of the 2010 night-time SST map list. 
From the menu bar select “File” > “Create” > “Maplist”. In the Create MapList dialog window (figure 18.5) give 
your maplist a suitable name, for example “sst_2007_wk1”.  There is no need for a description. Use the up and 
down arrows to scroll down or up to select the files containing the dates for week 1 (e.g. 0101 to 0107 for 
January 1 to 7), after selecting the topmost of these files, use the shift key while scrolling down to select the 
other files and click the arrow pointing to the right box to tell ILWIS to take the contents of your selection to 
the right box. Click “OK” to accept the selection of the files. 

Figure 18.5 Creating a map list for week 1 
 
Create in a similar manner the 11 other weekly map lists for the whole observation period, for details see also 
table 18.1. Here the name convention for the map lists created used is “sst_2007_wk1” up to “sst_2007_wk12”. 
Note that during the last week of the month a deviating number of maps are available as January and March 
have 31 days and February only 28. For the second week of January no SST image is available for the 12th of 
January.  
Prepare yourself an identical table to create the 12 map lists needed for 2010. Use a similar map list filename 
convention: “sst_2010_wk1” up to “sst_2010_wk12”. Note that the number of layers contained in a map list is 
required for further processing later on. The only change in this respect is the number of layers for week 2 in 
2010, during this week in 2010 there are 7 map layers. Upon completion of creating the map lists you should 
have obtained 24 weekly map lists, 12 for 2007 and 12 for 2010. 
Display your results when you have created a map list. Double click on the map list icon “sst_2007_wk1”, in the 
next window, select from the menu the option “Open as Slide Show” and press “OK”. In the next display options 
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window set the minimum stretch value to “0”, select as Representation “Pseudo” and press “OK” again. You 
now see an animated sequence of the SST maps of the 1st week of January 2007. 
 

January 

Month  
01 

Week1 Week2 Week3 Week4 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

01-07 7 08-14 6 15-21 7 >21 10 

February 

Month  
02 

Week5 Week6 Week7 Week8 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

01-07 7 08-14 7 15-21 7 >21 7 

March 

Month  
03 

Week9 Week10 Week11 Week12 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

Day 

number 

No of 

maps 

01-07 7 08-14 7 15-21 7 >21 10 

Table 18.1 Details of map lists to be created for 2007 

18.5.2. Masking of invalid pixels 

Before calculating the mean of the valid pixels to derive the weekly composites, you need to take into 
consideration of the following: 

 Application of a mask to exclude clouds and pixels with poor quality or invalid data; 
 Application of a flag to exclude the land pixels; 
 The calculation of the mean of the weekly composites only includes those pixels with acceptable data. 

Cloud top temperatures are much lower than sea surface temperatures, so any pixel containing scattered cloud 
will have an apparent temperature that is lower than the real temperature.  A quick look at the map lists show 
that most of the images suffer from such cloud contamination.  In the absence of other methods for 
identifying valid data, you can use your knowledge of the study area (Tanzania) and available in situ data to 
determine a threshold temperature for excluding abnormally low temperatures.  For Tanzania at this time of 
year, you are very unlikely to find water temperatures below 25 degrees Celsius, so this may be used as a 
suitable threshold.   Land pixels are given the value of -163 in this data, and the fill value (no data) is -999.  
Hence a threshold of 25 will also exclude any land pixels and pixels with missing data. 
 
1.  To mask pixels with temperatures below 25 degrees for the entire map list type the following expression 
into the command line in the main ILWIS menu, and press enter to execute the operation: 
 

sst_2007_wk1_flag.mpl:=maplistcalculate("iff(@1>=25,@1,0)",0,6,sst_2007_wk1.mpl) 
 
Note that for this week there are 7 layers contained in this map list, which are sequentially numbered from 0 to 
6! Note that the internal ILWIS map list counter starts from 0. 
2.  Next re-classify undefined (no data value) into a value of 0: 

 
sst_2007_wk1_temp.mpl:=maplistcalculate("ifnotundef(@1,@1,0)",0,6,sst_2007_wk1_flag.mpl) 

 
3.  Use map list calculate to create a temporary image to hold the sum of all the valid temperatures, when the 
raster map definition dialog window opens just accept the defaults: 
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sst_2007_wk1_sum.mpr:=MapMaplistStatistics(sst_2007_wk1_temp.mpl,sum) 
 
4. Assign ‘no data’ value to maps with temperature less equal 25 degrees (to avoid them being counted): 

 
sst_2007_wk1_temp1.mpl:=maplistcalculate("iff(@1>=25,@1,?)",0,6, sst_2007_wk1_temp.mpl) 

 
5. Count the number of valid observations: 
 

sst_2007_wk1_count.mpr:=MapMaplistStatistics(sst_2007_wk1_temp1.mpl,Cnt) 
 
6. Calculate the mean weekly temperature by dividing the sum by the count: 
 

mean_sst_2007_wk1:=sst_2007_wk1_sum/ sst_2007_wk1_count 
 
Your result should resemble the map presented in figure 18.6. For visualization of this map use is made of the 
“Pseudo” representation. 

Figure 18.6 Mean weekly SST along the coast of Tanzania 
 
Note that all the above commands were typed directly into the command line of the main ILWIS menu. These 
lines can also be copied from the command line history and pasted into an ILWIS script, which can be used to 
compute the means of other weekly composites in a more automated manner. From the catalogue double click 
with the mouse the script “SST_flagging” and note the content. You will see that there are 3 replaceable 
parameters, indicated by %1, %2 and %3 that need to be defined to run the script. The parameters are: 
%1=number of layers contained in a map list, %2=week number and %3=year.  Close the script and type the 
following syntax into the command line of the main ILWIS menu: 
 
 run SST_flagging  5 2 2007 
 
Note that “run” is used to initiate an ILWIS script, the script to be executed is “SST_Flagging”, %1=”5” 
(counting of layers starts from 0, so number of layers are given from 0 to 5, total of 6 layers (see also table 
18.1), %2=”2” , indicating the week (number) and %3=”2007” is referring to the year. We do not need to 
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modify the script to process the other weeks or the year, one only need to change the parameter settings to 
calculate a weekly mean of another period. Repeat this procedure to calculate the remaining weekly means of 
2007 and all weekly means of 2010. Note that upon completion of the calculations you are asked to delete the 
obsolete files, confirm with “Yes”, else a large number of files will appear in your catalogue. You can also delete 
the obsolete files created during step 1 to 5 presented above when calculating the mean SST of the 1st week. 

18.5.3. Visual assessment of the weekly composites 

Visual assessment of the weekly composite reveals that the threshold-method has not succeeded in masking all 
the cloud-contaminated pixels.  The speckled appearance of the image is typical of cloud-contamination that 
has not been adequately masked.  Despite this, it is possible to see oceanic features such as the warm eddy near 
the Tanzanian coast in the top left quarter of the image. In the middle of this eddy temperatures of 30 degrees 
or more occur. 

18.5.4. Examining the image histogram 

Right click with the mouse on the map “mean_sst_2007_wk1” and from the context sensitive menu select the 
option “Statistics” > “Histogram” and press “Show”. The histogram for the mean week1 SST (figure 18.7) shows 
the temperature distribution, and gives useful information about the image, such as the mean and median 
temperatures, and the ‘Pred’ - the number that occurs most often (the histogram peak), also known as the 
mode.  The histogram clearly shows the cut-off threshold of 25 degrees used to mask cloud-contaminated 
pixels.  An indication that the cut-off has been reasonably successful can be found in the fact that the median, 
mean and mode give very similar values.  If cloudy pixels had been left in the image, the histogram would have 
been skewed and the mean would have been much lower than the mode.  Thus the mean temperature of 27.85 
degrees Celsius obtained for the weekly composite of the first week of January 2007 may therefore be 
considered reasonably correct. 

Figure 18.7 Histogram of the image for week 1   

18.5.5. Changes from January to March  

Compare the weekly images for the 12 weeks in each year. Now select for each weekly mean SST map the 
option “Statistics” > “Histogram” and press “Show” and note the following statistics: mean, standard deviation, 
median and predominant or mode, see also figure 18.8 for the histogram of week 12. Are there any obvious 
changes in mean temperatures from the start of January to the end of March for both years? You will note that 
the mean temperature in March is higher than in early January.  Also consult Appendix 1, which provides the 
statistics for the respective weeks for the year 2007 and 2010. 
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Figure 18.8 Histogram for week 12  

18.5.6. Differences between 2007 and 2010 

Plotting the histogram means for each week as two weekly time series is an easy first step in comparing 2007 
and 2010.  Are there any observable temperature differences between the two years? Check also the graphical 
representation of the mean weekly SST as given in appendix 1. To check where in your image these difference 
are occurring you can calculate the weekly SST difference. Type the following expression in the command line 
from the main ILWIS menu and leave all other options default and press “OK”: 
 
 Dif_week1:= mean_sst_2007_wk1- mean_sst_2010_wk1 
 
Display the map. Most of the regions along the coast of Tanzania and around Zanzibar and Temba have 
negative values, indicating that the temperatures in 2010 are higher. Repeat the difference calculation for week 
12 and check the results. Also compare the histogram statistics of both difference maps. 

18.6. Comparison of monthly MODIS temperatures to the Pathfinder SST climatology 

To determine if the warm temperatures represents a risk to coral health, it is necessary to assess the 
temperature over several weeks, and compare the data for 2007 to climatological data (the temperature 
behaviour using a larger number of years) in order to determine if the warm water is substantially warmer than 
normal.  However, incomplete clearing of sub-pixel cloud makes such a comparison highly suspect, as the 
affected areas are likely to have a lowered apparent temperature. For a valid assessment, it is necessary to find a 
better method of masking cloud-contaminated pixels.   
For this reason, the rest of the exercise describes what should be done to carry out a coral heat stress 
assessment, once the weekly data is of sufficient quality to give an acceptable comparison with climatology and 
a reliable comparison between year 2007 and year 2010. 

18.6.1. Checking for MODIS v Pathfinder bias 

The Pathfinder data, derived from the AVHRR sensor on the NOAA series of satellites, from January 2006 
and the corresponding MODIS 4km night-time SST data are imported into ILWIS. The data is converted to 
degree Celsius and are re-projected to a common projection. An independent data set, covering a region over 
the Atlantic Ocean, over 600 lines by 600 columns (approximately 387000 pixels) has been selected for both 
data sets to conduct this comparison. Display, using the same stretch values (e.g. from “5” to “20”), in separate 
map windows the Pathfinder and the MODIS January 2006 sub-sets, “pf_sstn_subf” and “modis_sstn_subf” 
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respectively. Visually check the maps. It seems that the MODIS data has a slightly more irregular appearance 
and shows some ‘pockets’ of lower SST regions. 
Close both maps and select from the main ILWIS menu the option “Operations” > “Raster Operations” > “Cross”. 
As 1st map select “modis_sstn_subf” and as second one the map “pf_sstn_subf”, specify as output table 
“cross_modis_pf” and press “Show”. Inspect the cross table created. From the main table menu select the option 
“Columns” > “Statistics” and as Function use “Correlation”, select the two relevant columns and check the results. 
You will note a high degree of correspondence (R=0.978) 
Select from the Table menu the graphics icon , and from the “Create Graph” menu, select as X-axis 
“modis_sstn_subf” and as Y-axis “pf_sstn_subf”. Press “OK” to display the graph. You can modify the Graph 
properties by selecting the items in the left hand graph legend; unselect “Legend”. Proceed from the active 
Graph window, select from the menu “Edit”, “Add Graph” and select “Least Square Fit”. Select as X-column 
“modis_sstn_subf” and as Y-column “pf_sstn_subf”, use as Function “polynomial” with “2” terms (1st order 
polynomial function) and press “OK”. From the Graph legend, select the item: “modis_sstn_subf * pf_sstn_subf - 
polynomial”, change the Color to “Black” and set the Line Width to “0.2”. Also note the regression formula, 
which is given on the lower left hand of this menu (Y=0.133344 + 0.990103 * X). Press “OK”. Check the 
resulting graph and unselect the data display option for the item “modis_sstn_subf * pf_sstn_subf” to get a better 
impression of the trend line. Your results should resemble those of figure 18.9. 

Figure 18.9 Comparing the MODIS and Pathfinder SST-night data for January 2006 
 
The temperature range for this subset is from 5 to 20 degrees, when applying the polynomial function for e.g. 
30 degree, for MODIS SST, the resulting value would be 29.85 degree for the Pathfinder SST. These deviations 
are relatively small and therefore given this assessment the monthly mean data from MODIS does not need to 
be corrected any further, even for area with higher sea surface temperatures. 
One additional check is to calculate the difference between the two maps. Enter the following expression on 
the command line of the main ILWIS menu and accept the defaults and press “OK” to execute the operation: 
 

dif_mod_pf:=modis_sstn_subf-pf_sstn_subf 
 

Calculate the histogram of this difference map and check the mean, standard deviation and median values. Also 
here a slight positive bias can be observed but can be neglected. Note that here only January is considered, for a 
proper assessment also the other months have to be taken into consideration. 
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18.6.2. Calculation of monthly means and comparison with climatology 

18.6.2.1. Calculation of monthly mean SST 

You can calculate the monthly means either from the daily data, using the method described for weekly 
composites above, or you can do this directly using the weekly composites (4 weeks in January, 4 in February 
and 4 in March), using the command below (for January), using the default Raster Map definition options:  
 

sst_jan_2007_mean:=(mean_sst_2007_wk1+mean_sst_2007_wk2+mean_sst_2007_wk3+mean_sst_
2007_wk4)/4 

 
The second option is quicker, but a little less accurate.  However for a quick comparison to identify whether a 
particular month is warmer or colder than normal, it should be sufficiently accurate. Repeat this for the other 2 
months in 2007 and for the 3 months in 2010. Check the statistics and determine for which month you have 
the maximum mean monthly sea surface temperature. The statistical results are also presented in appendix 1, 
and show that the mean SST values increase from January to March and the mean SST values are higher for 
2010 compared to 2007 for all months. 

18.6.2.2. Calculating monthly anomalies for March 

Coral Reef Watch (CRW) hotspots are used by NOAA to predict hotspots of coral reef bleaching locations 
around the world where one has to investigate hotspots where the SST are higher than normal. According to 
Glynn and D’Croz (1990) corals start to experience threat when SST is 1°C higher than the highest maximum 
mean monthly (MMM) temperature.  
In the previous activity, you might have noted that for the case of coastal Tanzania, the maximum mean 
monthly temperature occurred during the month of March. Thus to find CRW hotspots along the coast of 
Tanzania one would need to compare the image of the Maximum Monthly Mean for March with the global 
SST monthly climatological data for March. The climatology was obtained from the Pathfinder data set and the 
map provided is “sstn_pf_mar_Tanzania”. Display this map and check the values. Type the following expression 
in the command line of the main ILWIS menu, accept the default Raster Map definition options:  
 

CRW_hotspot_March_2007:= iff(sst_mar_2007_mean -sstn_pf_mar_Tanzania>=1,1,0) 
 
This calculates an anomaly map for March 2007 and the areas where the temperature difference is greater or 
equal to 1 is classified as 1, the other areas not meeting this threshold are assigned 0.  Note that some regions 
may be cooler than normal but these are not of concern here.  Any region with an anomaly of +1 degree C or 
more would be cause for concern. Display the resulting map and check your results. You will note that there 
are only a few pixels that have been assigned 1, check the histogram of the map if you are not convinced and 
eventually zoom in to inspect the map in more detail. Repeat the procedure to calculate the 
“CRW_hotspot_March_2010”.  For 2010 a larger region is affected. 
Use the map showing the coral reefs distribution along the coast of Tanzania with your calculated 
CRW_hotspot maps in order to identify any hotspot locations where high temperatures may represent a threat 
to coral reefs during the warmest period in each of the two years. This map is situated in the working directory 
and is called “TZreefs.tif”. You can open this map using the preview option of Windows Explorer. Visually try 
to identify the relevant areas. 
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18.7. Degree Heating Weeks (DHWs)  

The prediction of coral reef bleaching is done using the concept of Degree Heating Weeks (DHW). This shows 
us not only where the temperatures have been higher than average for the warmest month, but also how long 
the high temperatures have persisted.  One DHW is equivalent to 1 week of sea surface temperature at 1 
degree C above the expected summertime maximum. Two DHWs can indicate either 1-week of 2 degree C OR 
2 weeks of 1 degree C above the expected summertime maximum. Research carried out by Coral Reef Watch 
shows that significant coral bleaching may be expected when the thermal stress reaches 4 DHWs. When the 
thermal stress is about 8 DHWs, widespread mortality of corals may occur. 
Open the map “sst_month_max”. This map is giving the maximum mean SST night time temperatures from the 
Pathfinder climatology which occurred over the warm season (January to April). This map is used as a proxy 
for the summertime maximum and the analysis will be done for 2010 as 2007 was hardly showing any 
‘hotspots’. To derive the DHW the weekly mean night-time SST maps calculated earlier are used. First 
construct a new map list using the maps “mean_sst_2010_wk1” to “mean_sst_2010_wk12” and call the output 
map list “mean_sst_2010” Type the following expression in the command line of the main ILWIS menu, press 
“enter” to execute the operation and accept the default Raster Map definition options: 
 

DHW.mpl:=maplistcalculate("iff(@1-sst_month_max>1,@1-sst_month_max,0)",0,11,mean_sst_ 
2010.mpl) 

 
Check the result displaying the map list as an animated sequence.  You will note that for some weeks there are 
“blank” areas with ‘no data’ values. These regions are set to “0” using the following expression: 
 

DHW_cor.mpl:=maplistcalculate("ifundef(@1,0)",0,11,DHW.mpl) 
 
Now you can aggregate the values of the 12 layers using the following expression: 
 

dhw_sum.mpr:=MapMaplistStatistics(DHW_cor.mpl,Sum) 
 
Finally, all areas that have remained 0, are being removed for better visualization: 
 
 dhw_sum_fin:=iff(dhw_sum>0,dhw_sum,?) 
 
Display this map and add the country boundaries, these can be added using the “Layers” > “Add Layer” option 
from the active map window, browse to your ILWIS directory and select the map “Africa_country” from the 
sub-directory “\Extensions\Geonetcast-Toolbox\util\maps”. Compare your results with the locations of the coral 
reefs given by the image “TZreefs”, which can be opened using the Windows Explorer. Visually compare your 
results, looking particularly for locations where the DHW values are 4 or above. They should resemble those 
presented in figure 18.10, which shows the situation around Zanzibar. 
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Figure 18.10 The calculated DHW for 2010 and the reef location map for the Tanzanian coastal region 
 
To get an idea of the temporal distribution of your DHW over the 3 months of investigation, right click using 
the mouse the map list “DHW_cor” and select from the context sensitive menu the options “Statistics” > “Map 
List Graph”, use a fixed stretch, from “0” to “10”, activate the option “Continuous” and “Always on Top”, select 
the map “dhw_sum_fin” again and browse with the mouse over this map. Note the temporal variations of the 
DHW in the graphical window.  

18.8. Conclusion 

From this study, it is clear that the temperatures along the coast of Tanzania were rising gradually from Week 1 
(January) to Week 12 (March) with highest SST towards the end of March (week 12), in both years. These 
results are consistent with in situ measurements from the temperature logger at Chumbe reefs located on the 
western coast of Zanzibar and the global climatological dataset. Temperatures were higher in 2010 than in 
2007, and the DHW calculations revealed a few locations on the east side of Zanzibar and Pemba islands where 
reefs may have been at risk, whereas most locations were below the 4 DHW threshold.  However, we have to 
be careful about drawing firm conclusions from this study alone.  One reason for this is that the threshold 
method used for the cloud masking failed to identify all the cloud-contaminated pixels.  As a result SST may 
have been underestimated.   
Despite the shortcomings of this study, the methodology has potential capability to investigate the seasonal 
patterns of sea surface temperatures and identifying locations with higher than normal thermal stress to coral 
reefs.  Once a more reliable method for masking of bad data has been found, the MODIS SST product can be 
used to calculate DHW and bleaching risk at 1km resolution. Such a method is explored in a follow-on lesson 
using the Bilko software which is being developed in EAMNet, which continues the marine component of 
DevCoCast (see www.bilko.org/eamnet/modis_sst_cloudclear.php). This compares the MODIS data to a 
lower resolution climate-quality product consistent with the Group of High Resolution Sea Surface 
Temperature (GRHSST) standards, and uses the results to set the cloud-masking threshold. 
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APPENDIX 1 

1. Histogram statistics for the weekly mean composites for the year 2007 and 2010 
 

YEAR 2007 2010 

Parameter mean std median pred mean std median pred 

Week1 27.85 1.13 27.82 28.14 28.43 0.90 28.52 29.14 

Week2 27.51 0.66 27.57 27.77 27.62 1.09 27.73 28.13 

Week3 28.04 0.84 28.07 28.27 28.38 0.67 28.47 28.68 

Week4 28.21 0.80 28.30 28.52 27.61 0.67 27.65 27.69 

Week5 27.95 0.77 28.01 28.85 28.19 0.75 28.25 28.64 
Week6 27.56 1.07 27.58 27.60 28.77 0.86 28.90 29.35 
Week7 28.69 0.85 28.72 28.72 28.59 1.20 28.75 29.27 
Week8 27.76 1.11 27.83 28.56 28.86 0.98 28.95 29.31 
Week9 28.56 0.65 28.64 28.69 29.38 0.73 29.45 29.97 
Week10 28.48 0.75 28.55 28.85 29.23 0.83 29.26 29.10 
Week11 28.50 0.79 28.52 29.02 29.71 0.87 29.80 30.27 
Week12 29.03 0.52 29.07 29.22 29.16 0.77 29.21 29.30 

 
2. Graphical representation of the mean sea surface temperatures (SST) for 2007 and 2010 

 
3. Mean monthly SST statistics for 2007 and 2010 
 

Month \ Year 2007 2010 

January 27.89 28.00 

February 28.02 28.60 

March 28.65 29.37 

 
 

Mean Weekly SST for 2007 and 2010

For 2007:
y = 0.0954x + 27.558

R2 = 0.5181

For 2010:
y = 0.152x + 27.673

R2 = 0.6898
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